# Table of Contents

## PeerSync Help

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Information</td>
<td>3</td>
</tr>
<tr>
<td>Pricing &amp; Licensing Structure</td>
<td>3</td>
</tr>
<tr>
<td>License</td>
<td>3</td>
</tr>
<tr>
<td>PeerSync Installation</td>
<td>6</td>
</tr>
<tr>
<td>Additional Configuration Entries</td>
<td>6</td>
</tr>
<tr>
<td>Registration and Passwords</td>
<td>8</td>
</tr>
<tr>
<td>Upgrade Information</td>
<td>10</td>
</tr>
<tr>
<td>Online Resources</td>
<td>0</td>
</tr>
<tr>
<td>White Papers</td>
<td>0</td>
</tr>
<tr>
<td>Server Backup</td>
<td>0</td>
</tr>
<tr>
<td>Database Backup</td>
<td>0</td>
</tr>
<tr>
<td>Laptop &amp; PC Backup</td>
<td>0</td>
</tr>
<tr>
<td>DFS File Locking</td>
<td>0</td>
</tr>
<tr>
<td>PeerCollaboration Standard</td>
<td>0</td>
</tr>
<tr>
<td>File Migration</td>
<td>0</td>
</tr>
<tr>
<td>File Distribution</td>
<td>0</td>
</tr>
<tr>
<td>Tutorials</td>
<td>0</td>
</tr>
<tr>
<td>Real-Time Bi-Directional Replication/Synchronization</td>
<td>0</td>
</tr>
<tr>
<td>Real-Time One Way Replication/Synchronization</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled Bi-Directional Replication/Synchronization</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled One Way Replication/Synchronization</td>
<td>0</td>
</tr>
<tr>
<td>TCP Configuration</td>
<td>0</td>
</tr>
<tr>
<td>How to configure Managed Files</td>
<td>0</td>
</tr>
<tr>
<td>Interface Features</td>
<td>12</td>
</tr>
<tr>
<td>Getting Started</td>
<td>12</td>
</tr>
<tr>
<td>Tool Buttons</td>
<td>14</td>
</tr>
<tr>
<td>Profile Description</td>
<td>16</td>
</tr>
<tr>
<td>Menus</td>
<td>16</td>
</tr>
<tr>
<td>File Menu</td>
<td>16</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>17</td>
</tr>
<tr>
<td>View Menu</td>
<td>17</td>
</tr>
<tr>
<td>Options Menu</td>
<td>18</td>
</tr>
<tr>
<td>Run Menu</td>
<td>19</td>
</tr>
<tr>
<td>Job Menu</td>
<td>20</td>
</tr>
<tr>
<td>Help Menu</td>
<td>21</td>
</tr>
<tr>
<td>Evaluation Menu</td>
<td>24</td>
</tr>
<tr>
<td>Popup View Menu</td>
<td>25</td>
</tr>
<tr>
<td>Popup Tray Icon Menu</td>
<td>25</td>
</tr>
<tr>
<td>Profile Job List</td>
<td>26</td>
</tr>
<tr>
<td>Selection Tree</td>
<td>29</td>
</tr>
<tr>
<td>PeerSync Job Settings</td>
<td>31</td>
</tr>
<tr>
<td>PeerSync Job Settings</td>
<td>31</td>
</tr>
<tr>
<td>Folder Selection</td>
<td>32</td>
</tr>
<tr>
<td>Folder Selection Overview</td>
<td>32</td>
</tr>
</tbody>
</table>

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
Exclude Files ................................................................. 85
Exclude Folders ............................................................ 86
Exclude Files by Size ..................................................... 87
Include Files by Date ...................................................... 87
Include Files by Attributes .......................................... 87
Exclude Files by Attributes .......................................... 87
Reporting ..................................................................... 88
Reporting Overview .................................................. 88
Report File Content ..................................................... 88
Log File Size/Content ................................................... 89
SNMP Options ............................................................ 89
Admin Reporting ........................................................ 90
Admin Reporting Overview ........................................ 90
Report File Content ..................................................... 90
Report File Name ........................................................ 91
Report File Path .......................................................... 91
Admin Report Cycle Options ...................................... 91
Advanced Settings ....................................................... 92
E-mail Reporting ........................................................ 92
E-mail Reporting Overview ........................................ 93
Report File Content ..................................................... 93
Report File Name ........................................................ 93
E-mail Configuration ................................................... 93
E-mail Report Cycle Options ...................................... 94
Advanced Settings ....................................................... 95
Compression ............................................................... 96
Compression Overview .............................................. 96
Compression Options ................................................ 97
Compress/Expand ....................................................... 97
Compression File Extension ....................................... 97
Compression Speed ................................................... 98
Password Encryption .................................................. 98
Pre/Post Process ......................................................... 99
Pre/Post Process Overview ........................................ 99
Advanced Options ...................................................... 100
Migrate Shares .......................................................... 100
Global Migrate Shares Options ................................ 101
Global Advanced File Xfer Options ......................... 101
PeerSync Global Settings .......................................... 101
Global Recovery/Offline Options ............................. 102
Global Performance Options ................................... 103
Global ACL Options .................................................. 104
Global Bi-directional Options .................................... 104
Global Managed Files Options ................................. 105
Current Command Line Arguments ......................... 106
Options/Commands .................................................... 107
Global Display Options ............................................. 107
PeerLock ................................................................. 109
PeerLock Job Settings ............................................... 109
PeerLock Job Settings Overview ............................... 109
PeerLock Global Settings .......................................... 110
PeerLock Global Settings Overview ........................ 110
Startup/Service ........................................................ 112
PeerSync Startup/Service .......................................... 112
PeerSync Help

Welcome to Peer Software’s powerful file mirroring, backup and distribution solution, PeerSync v9.0. With this product you will be able to conveniently synchronize folders for back-up purposes or portability requirements. Never again will you overwrite newer data by attempting to manually update an individual file or the contents of a folder.

History

PeerSync has been available for download/purchase since early 1995. Since then hundreds of downloads have been logged from various international forums where PeerSync was made available and thousands of copies have been sold. PeerSync is an MS Windows-based product. Originally written in Visual Basic, the current product is written in Delphi Object Pascal. PeerSync originated as a solution to a problem frequently encountered by our own developers, that of keeping files in sync between multiple hard drives. Developers working on-site at customers' locations or at home during crunch schedules would then have to synchronize their data back to the office server. This was most often done manually, with each individual file being dragged to the appropriate server folder. Invariably, data would be lost when one or several of the server files contained new information which was subsequently overwritten. In addition to loss of work and resulting frustration, the process was also time consuming. Anywhere from 20 minutes to 2 hours would be spent during each synchronization. After reviewing several commercially available products, it became apparent that an effective and user-friendly solution to this common problem did not exist, hence the development of PeerSync.

Description

Configured through the Profiler, an intuitive and easy-to-use application, PeerSync automatically synchronizes multiple directories and sub-directories from user-defined Source to Target Folders. While removing the frustration and loss of time associated with manual synchronization, PeerSync prevents loss of data by checking file dates and times to ensure that newer information is not overwritten. Synchronization can occur between any mapped or UNC connected drives located on local computers or computer networks. While processing and performing any number of simultaneous tasks, PeerSync retains and expands upon the selectivity and precision of manual synchronization by offering a suite of automated file inclusion and exclusion features. Files can be included within synchronization according to standard DOS-type wild cards and excluded using sub-string comparisons or file attribute settings. Files can be also be excluded according to their date and size. In addition, PeerSync can be configured to update or add files which are out-dated or non-existent in the current Target Folder. Precision and scope are further enhanced through PeerSync Jobs and Command Line Modes. A virtually unlimited number of folder combinations (Jobs) can be created and stored in Profiles which can be run manually or automatically using command line arguments. While synchronizing large numbers of folder combinations at once, each combination can have a unique set of exceptions. In this way PeerSync combines the benefits of precise folder matching with that of an automated environment. Real-Time Source Folder monitoring and repetitive operations on the host PC are also available with PeerSync's options. PeerSync can also be used for network file management purposes. Reports run during synchronization can display added, updated, and opened files as well as directories created, and can display unmatched files found in Target directories.

Embedded Open File Manager (EOFM)
PeerSync's Embedded Open File Manager (EOFM) option was created and bundled into PeerSync through a third party partner named EVault. EVault has announced that EOFM is now "End-of-Life" and no further development or support will be provided. Thus, Peer Software will no longer be including EOFM as part of PeerSync beginning in PeerSync version 9.0. In addition, we are no longer able to provide technical support on EOFM effective immediately.

For Peer Software customers currently using EOFM and who are on a valid maintenance support contract, we offer a FREE upgrade from EOFM to the Volume Shadow Copy Service (VSS) option. We urge all customers to take advantage of this FREE upgrade offer. Peer Software is continuing development and support for VSS.

PeerLock Configuration Support

Starting with PeerSync v7.4, customers who are running PeerLock 2.0.1 or higher on the same machine as PeerSync are able to configure PeerLock directly from the PeerSync Profiler. Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock, ability to access/view/edit the PeerLock Global Settings from the PeerSync Profiler, ability to install/uninstall the PeerLock Service, as well as launch and view PeerLock directly from the PeerSync Profiler.

Version 7.4 and higher of PeerSync also supports real-time or scheduled bi-directional replication using our TCP replication mode. In this version, PeerSync now supports bi-directional replication with target directories that reside outside the LAN, WAN, or VPN.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all responsibility for any data loss or damage.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Wednesday, August 08, 2012
Product Information

License

License

YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE. INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE INDICATES ACCEPTANCE OF THESE TERMS AND CONDITIONS. IN THIS AGREEMENT, "YOU" MEANS YOU AS AN INDIVIDUAL IF YOU ARE USING THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE USING THE SOFTWARE ON EQUIPMENT OWNED OR OPERATED BY A COMPANY OR ORGANIZATION (COLLECTIVELY "COMPANY"), BY ACCEPTING THIS AGREEMENT, YOU REPRESENT THAT YOU ARE DULY AUTHORIZED TO ACCEPT THIS AGREEMENT ON BEHALF OF YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the "Documentation") is copyrighted and remains the property of Peer Software, Inc. All rights are reserved.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, non-transferable license to install and use the Software and accompanying Documentation contained in the trialware distribution package (hereafter called the "Trialware Package") you received (THE "Original Distribution") for your internal business purposes only. The Trialware Package consists of copies of the Software and Documentation received via an electronic transfer mechanism or an electronic storage medium including, but not limited to, diskette, hard disk, removable disk, tape or optical devices such as CD-ROM or WORM. This license to install and use the Software and Documentation is conditioned upon User's compliance with the terms of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is no chance that it will be used simultaneously on more than one computer. If you need to use the Software on more than one computer simultaneously or on a network, please contact Peer Software, Inc. for information about network licenses.

The Software is protected by trade secret and copyright laws and international treaty provisions. You are not obtaining title to the Software or Documentation or any copyright or other intellectual property rights. You further acknowledge that title and full ownership rights to the Software and Documentation will remain the exclusive property of Peer Software, Inc. or its suppliers, and You will not acquire any ownership rights to the Software. You may not sublicense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another product, convert to another programming language, reverse engineer or disassemble the Software or Documentation for any purpose. You may not modify, or create derivative works based in whole or in part upon, the Software. You agree to not remove, obscure, or alter Peer Software, Inc.'s or any third party's copyright notice, trademarks, or other proprietary rights notices affixed to or contained within or accessed in conjunction with or through the Software and Documentation. Peer Software, Inc. reserves the right to periodically conduct audits upon advance written notice to verify compliance with the terms of this Agreement.
Once a license is purchased from Peer Software, Inc., the Trialware Package will be authorized to function as the full working version of the Software with access to all licensed features.

NETWORK LICENSE

Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation must purchase a Network License. Two forms of Network Licenses are offered, a Site License and Enterprise or Concurrent User License. With a Site License, any user who accesses the Software or Documentation requires a user license, regardless of the frequency of use. Once a Site License is purchased Software and Documentation may be copied to all users who have been licensed. Site Licenses are customized for each purchase. The license is based on a quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access the Software and Documentation. The User agrees to operate metering software, which restricts the simultaneous number of users to the quantity purchased. The Software and Documentation must be installed on network servers under the control of metering software.

Both Site and Concurrent User Licenses allow installation of the Software and Documentation to any number of servers on any number of geographic sites, limited only by the quantity of licenses purchased.

TERM AND TRIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial Period") of thirty (30) days or 30 uses (whichever comes first) after receipt of the Trialware Package. After such time, if you continue to use the Trialware Package, you must register your copy with Peer Software, Inc. Failure to register after the Trial Period constitutes termination of this license. Upon registration, a password (hereafter called the "Password") will be provided to eliminate the registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software, Documentation, and all copies thereof. This license will also terminate if you fail to comply with any of the terms or conditions herein. You agree, upon such termination, to destroy all Software, Documentation, and copies thereof. Upon request, You agree to certify in writing that all copies of the Software and Documentation have been destroyed.

LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.

EXCLUSIVE REMEDY

YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR THIS LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).

LIMITATIONS OF LIABILITY

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT, OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC. SHALL HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR LOSSES OF ANY NATURE. IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES FOR A LICENSE TO THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may not apply to you.

BACK-UP

You may make one copy of the Trialware Package for backup purposes only.

DISTRIBUTION

You may distribute the Trialware Package to others via an electronic transfer mechanism or electronic storage media provided that no files are deleted from the Original Distribution Trialware Package or are modified in any way. Files may be added to the Trialware Package expressly for the purpose of identifying the party distributing the Trialware Package. You may also place the Trialware Package into any archive or compressed format for ease of distribution.

You may not distribute the product Registration Key to others under any circumstances.

GENERAL

Export of the Software may be subject to compliance with the rules and regulations promulgated from time to time by the Bureau of Export Administration, United States Department of Commerce, which restrict the export and re-export of certain products and technical data. If the export of the Software is controlled under such rules and regulations, then the Software shall not be exported or re-exported, directly or indirectly, (a) without all export or re-export licenses and United States or other governmental approvals required by any applicable laws, or (b) in violation of any applicable prohibition against the export or re-export of any part of the Software. Some countries have restrictions on the use of encryption within their borders, or the import or export of encryption even if for only temporary personal or business use. You acknowledge that the implementation and enforcement of these laws is not always consistent as to specific countries. Although the following countries are not an exhaustive list there may exist restrictions on the exportation to, or importation of, encryption by: Belgium, China (including Hong Kong), France, India, Indonesia, Israel, Russia, Saudi Arabia, Singapore, and South Korea. You acknowledge it is your ultimate responsibility to comply with any and all government export and other applicable laws and that Peer
Software, Inc. has no further responsibility after the initial license to you within the original country of sale.

In addition, neither the Software nor the Documentation and underlying information or technology may be downloaded or otherwise exported or re-exported (i) into (or to a national or resident of) any country to which the United States has embargoed goods; or (ii) to anyone on the United States Treasury Department's list of Specially Designated Nations or the United States Commerce Department's Table of Denial Orders. By using the Software you are agreeing to the foregoing and you are certifying that you are not located in, under the control of, or a national or resident of any such country or on any such list.

This agreement shall be governed by the laws of the state of New York and shall inure to the benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any action arising under this Agreement shall be filed in any state or federal court located in Suffolk county in the State of New York, and You hereby agree, acknowledge and submit to the exclusive jurisdiction and venue of such courts for the purposes of such action, waive any right You may have to object to such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement between You and Peer Software, Inc. and supersedes any other prior or contemporaneous agreements or communications with respect to the Software and Documentation. This Agreement may not be modified except by a written addendum issued by a duly authorized representative of Peer Software, Inc. No provision hereof shall be deemed waived unless such waiver shall be in writing and signed by Peer Software, Inc. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect. The parties confirm that it is their wish that this Agreement has been written in the English language only.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click on the executable in the Explorer window, or choose "Run" from the Start Menu and then select the application. For networked installations, PeerSync supports silent installation by adding "/S" to the installation application's command line.

Example: %PATH%/ps90.exe/S

See Additional Configuration Entries for more Information on silent installation configuration.

Additionally, PeerSync can use the PeerSync90.lic file for larger networked sales and site licensing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at startup then it will use this data and bypass all other registration security checks. If the PeerSync90.lic file is located in the same folder as the PeerSync installation application, this file will then be automatically placed in the PeerSync installation folder during installation. To obtain a PeerSync90.lic file, please specify your requirements during purchase/registration.

Note: Adding /S /A INSTALL_LOG to the Uninstall.exe command line will perform an automatic silent uninstall of PeerSync.

Additional Configuration Entries

PeerSync and the PeerSync installation (ps90.exe) use a configuration file (PSDef.cfg) to read and set options during and after installation. If a PSDef.cfg file is located in the same
folder as ps90.exe before installation, this file will be automatically copied to the PeerSync installation folder during installation.

Pre-Installation Configuration Options

The following options are available before installation and are used during manual and silent installs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Folder</td>
<td>This option can be set to any directory path and designates what directory to install PeerSync into.</td>
</tr>
<tr>
<td>Disable Install Reboot</td>
<td>This option can be set to 'Yes' or 'No' and allows you to suppress the rebooting (if needed) of your computer after installation.</td>
</tr>
<tr>
<td>Install PSPProfiler</td>
<td>This option can be set to 'Yes' or 'No' and allows you to decide if the PSPProfiler interface is to be installed.</td>
</tr>
<tr>
<td>Install PSWizard</td>
<td>This option can be set to 'Yes' or 'No' and allows you to decide if the PSWizard interface is to be installed.</td>
</tr>
<tr>
<td>Install SNMP</td>
<td>This option can be set to 'Yes' or 'No' and allows you to decide if files needed for SNMP are to be installed (SNMP is only available in the Enhanced Package).</td>
</tr>
<tr>
<td>Create Start Menu Shortcuts</td>
<td>This option can be set to 'Yes' or 'No' and allows you to decide if shortcuts related to the PeerSync installation will be added to the Start menu.</td>
</tr>
</tbody>
</table>

Post Installation Configuration Options

The following options are used by PeerSync and other installed applications after install:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>This is used to set the Registration or Evaluation information to be read in by PeerSync.</td>
</tr>
<tr>
<td>Company Name</td>
<td>This is used to set the Registration or Evaluation information to be read in by PeerSync.</td>
</tr>
<tr>
<td>Options</td>
<td>This is used to set the Registration or Evaluation information to be read in by PeerSync.</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password</td>
<td>This is used to set the Registration or Evaluation information to be read in by PeerSync.</td>
</tr>
<tr>
<td>TempFolder</td>
<td>This option can be set to any directory path and will be used for a temporary folder PeerSync to use. If the path does not exist, an attempt will be made to create it. If it cannot be created, the default will be used which is the logon users system Temp path.</td>
</tr>
</tbody>
</table>

**Registration and Passwords**

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer Software, Inc. as a fully licensed copy by providing credit card information via phone or secure Internet registration, or by sending a check or money order to the address below (see included "readme.txt" file for pricing information). As an integral component of PeerSync 9.0 and all subsequent versions, the Profiler application is included as part of registration.

Register online via secure Internet credit card registration at:
http://www.peersoftware.com

Register by phone via credit card by calling:
703.763.7700 between the hours of 9:00 AM to 5:00 PM EST

Register by FAX via Purchase Order:
Send Purchase orders to 703.763.7705

Register by mail, send check or money order to:
Peer Software, Inc.
5900 Fort Drive, Suite 415
Centrevile, VA 20121

Information Required:
Full name (as it appears on the credit card)
End User Name (user to be licensed for the product)
Company Name (if applicable)
Address (City, State / Province, Country, and Postal Code)
Phone Number
Entire Card Number
Card Expiration Date
Card Security Code
Email Address
(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync’s Evaluation Counter to this).

Quantity Discounts
Visit http://www.peersoftware.com or contact us for more information.

Upon registering PeerSync, user information will be generated according to the name and company name (if any) you specified during registration, as well as a password specific to the product version you have licensed. This information will be emailed to you and will be used to activate your current copy. Additional license fees must be paid for multi-user use.
PeerSync may not be commercially distributed or distributed by government agencies including their contractors UNLESS registration fees are paid for by the distributing party.

See License agreement for product redistribution.

Please visit http://www.peersoftware.com for different versions of PeerSync and types of licensing we offer.

Note Regarding Updates: As new updates/changes become available, updated versions of the software will be posted at http://www.peersoftware.com. Check this page periodically to download the latest executables. Your Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is installed in a different folder than the previously installed/authorized version.

**Entering Your User Information and Password**

**Through an Evaluation Copy of PeerSync:**

After registration with Peer Software, Inc., you will receive Registration Information generated which is from the information you provided during registration. The password you receive will be specific to the PeerSync product you have licensed and registered with Peer Software. Upon entering valid password and user information into your Evaluation Copy, that copy will be immediately converted to a fully licensed version of the appropriate PeerSync product. The instructions below apply to a "Registered Evaluation Copy" of PeerSync, that being one whose evaluation period is still active.

To activate your registered and licensed PeerSync product, first run your Evaluation Copy of PeerSync. Then choose "About" from the Help Menu located on the far right of the Profiler Menu Bar. To activate your registered and licensed PeerSync product, first run your Evaluation Copy of PeerSync. Then choose "About" from the Help Menu.

Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen, which contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company name is omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly from the E-mail registration information. If passwords are typed using lower case letters where upper cases have been indicated, or if other information is typed incorrectly, the message shown below will be displayed. This message indicates that registration was unsuccessful; shows the number of attempts made to register, and contains' a link to Peer Software’s website. You will only be allowed a limited number of attempts before the application closes entirely and will need to be opened again in order to retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will have been immediately activated as a registered version of the PeerSync product you have licensed, with this change indicated on the interface title bar. Click "OK" on the success dialog to begin usage of your newly activated PeerSync product. You will not have to exit and restart the application to do so.

**Through an Unregistered Copy of PeerSync:**

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has
expired, or copies into which a valid password and user information has not yet been entered. These copies can still be activated as fully licensed versions of whichever PeerSync product whose usage you have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is generated from the information you provided during registration. The password you receive will be specific to the PeerSync product you have licensed.

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because your copy is unregistered, the application will not open in its entirety, instead an About PeerSync screen will open. This screen contains "User Name," "Company," "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company name is omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly from the Email registration information. If passwords are typed using lower case letters where upper cases have been indicated, or if other information is typed incorrectly, the message shown below will be displayed. This message indicates that registration was unsuccessful; shows the number of attempts made to register, and contains a link to Peer Software’s website. You will only be allowed a limited number of attempts before the application closes entirely and will need to be opened again in order to retry.

If registration is successful, you will receive a success dialog. Your copy will now have been immediately activated as a registered version of the PeerSync product you have licensed. Click "OK" on the success dialog to begin using your registered copy: the About PeerSync screen will close and the full application interface will be displayed. You will not have to exit and restart the application to begin usage.

TERMS AND CONDITIONS

READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM.

Please send any suggestions, comments or requests for support to the proprietor of PeerSync:

Peer Software, Inc.
5900 Fort Drive, Suite 415
Centrevile, VA 20121

Phone: 703.763.7700
Fax: 703.763.7705
Web: http://www.peersoftware.com

Upgrade Information


Check this page periodically to download the latest executables. Your Authorization Key will continue to work with updated versions unless a major release is

To Upgrade PeerSync
Major product upgrades such as v8.6 to v9.0 will require a new product key. Users currently on annual maintenance must fill out the request for upgrade form to receive the upgrade license key before downloading v9.0.x. Users not on annual maintenance must contact sales for upgrade pricing.

1. Stop the PeerSync service or application if it is running
2. Terminate any instances of PeerSync.exe or PSProfiler.exe running in the Task Manager
3. Download the latest PeerSync executable from the following link: http://www.peersoftware.com/downloads/product_updates.aspx
4. Launch the installation by selecting "Run" from the download dialog or by double-clicking on the installation file (ps90.exe)
5. If you are upgrading the current version of PeerSync (9.0.x to 9.0.y) simply install the application over your existing PeerSync and the previous version will be backed up in a sub-folder called 'BACKUP' (if the option to keep a backup is selected during the installation). If you are evaluating a new version of PeerSync 9.0 and you already have an existing copy of PeerSync 8.6 or older, please select a new directory during the installation.
6. If you wish to remove previous versions of PeerSync you must go to the 'Start Menu-Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the PeerSync versions you no longer need.

To Upgrade PSLlistener

1. Stop the PSLlistener service if it is running
2. Terminate any instances of PSLlistener.exe running in the Task Manager
3. Download the latest PSLlistener executable from the following link: http://www.peersoftware.com/downloads/product_updates.aspx
4. Go into the C:\WINDOWS\system32 directory and rename the PSLlistener.exe file to PSLlistener-OLD.exe
5. Launch the installation by selecting "Run" from the download dialog or by double-clicking on the installation file (pslist21.exe)
6. If you are upgrading the current version of PSLlistener simply install the application over your existing location and the previous version will be backed up in a sub-folder called 'BACKUP' (if the option to keep a backup is selected during the installation). If you are evaluating a new version of PSLlistener and you already have an existing copy of PSLlistener v2.0 or older, please select a new directory during the installation.
7. If you wish to remove previous versions of PSLlistener you must go to the 'Start Menu-Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the PSLlistener versions you no longer need.
Interface Features

Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255 individual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a Target Folder (to which the contents of the Source will be synchronized), and then choosing from more than 80 easily specified Job Settings. These settings determine which contents
will be synchronized, in what manner, and when they will be synchronized – according to your choice of Real-Time, Scheduled, or manually initiated operations.

The process of building a Profile is made quick and simple by allowing you to easily create Jobs and then follow the sequentially arranged list of Settings screens accessed through the Selection Tree, which is located on the left side of the application interface. The user begins by first selecting a single Job or Multiple Jobs from the Profile Job List. Then specific synchronization criteria is applied to the selected items using Job Settings. Once synchronization criteria has been configured for each Job, Run/View Current Profile window is used to launch the entire Profile. By offering a Tool button Toolbar as well as separate Selection Tree and Profile Job List windows, Profiler’s browser-based interface allows you to easily view, create, copy, rename, move, or delete Jobs regardless of which Settings screen is currently being displayed.

<table>
<thead>
<tr>
<th>Product Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronization</strong></td>
</tr>
<tr>
<td><strong>Replication</strong></td>
</tr>
<tr>
<td><strong>Profiles</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Jobs</strong></td>
</tr>
<tr>
<td><strong>Real-time Mode</strong></td>
</tr>
</tbody>
</table>
may have completed the operation before Windows actually displays the change in the Target Folder Explorer window.

<table>
<thead>
<tr>
<th>Scheduled Mode</th>
<th>In this mode of operation, PeerSync will execute the designated Job at the selected time. Each Job in the Profile can have the same or different time interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Support</td>
<td>All support of PeerSync will be handled on our web site support page located at <a href="http://www.peersoftware.com/support/support.aspx">http://www.peersoftware.com/support/support.aspx</a>. PeerSync is fully supported under all NT based platforms of Windows but should first be evaluated on each machine in which you wish to register the product on. PeerSync is no longer fully supported under Windows 9x platforms.</td>
</tr>
</tbody>
</table>

Notes:

1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to create/modify Profiles and to view the status of running Jobs.

2. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx.

**Tool Buttons**

Profiler offers a simple set of browser-style Tool Buttons allowing you to easily modify the current Profile and its Jobs, regardless of which screen has been chosen from the Selection Tree. These buttons can be hidden by unchecking the "Tool Buttons" option, accessed through the "Toolbars" item on the View Menu. Even if this Toolbar has been hidden you will still be able to access its options by using the File, Edit, and Job Menus. You can also change the placement of these buttons by clicking on the left side of the Toolbar and dragging it to rest above or below the Profile Description Toolbar.

```
<table>
<thead>
<tr>
<th>Toolbar</th>
<th>The following descriptions are listed in the order in which they appear left to right on the Tool Buttons Toolbar and are all accessible via the application Menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Profile</td>
<td>Located on the far left of the Toolbar, this button creates a new Profile. If another Profile containing unsaved changes is currently open when this button is pressed, a dialog box will open asking you if you want to save changes to the current Profile before opening a new one (See Save Profile Button Below). If you choose &quot;No,&quot; the new Profile will replace the current one and no changes will be saved. Note: If the current Profile has not been previously saved and &quot;No&quot; is chosen, the entire Profile will be lost.</td>
</tr>
<tr>
<td>Open Profile</td>
<td>This button displays a &quot;Select Profile File&quot; dialog box allowing you to open an existing Profile. By default, it will open in the path in which PeerSync has been installed (i.e. C:\Program</td>
</tr>
</tbody>
</table>
Files\PeerSync). Links to previously opened Profiles can be accessible through a drop-down list opened by clicking on the arrow key attached to this button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save Profile</strong></td>
<td>This button allows you to save new Profiles, or save changes made to existing Profiles. If you are saving a new Profile, a &quot;Save As&quot; dialog box will open allowing you to name and store it as an .SNC file in your choice of folders, with &quot;NewProfile&quot; as the default name and the path in which PeerSync has been installed as the default directory. Profiles and Profile modifications must be saved in order to be subsequently accessible.</td>
</tr>
<tr>
<td><strong>Launch Current Profile</strong></td>
<td>This feature will launch the current Profile (Job/Global settings). During this process, an instance of PeerSync will be started with the current Profile as the first parameter and the arguments selected from the Options/Commands screen as the subsequent parameters. You can automate this process via a shortcut, through the startup folder, in the registry or as a service by selecting one of these features from the StartUp Services screen.</td>
</tr>
<tr>
<td><strong>Terminate/Stop Active Profile</strong></td>
<td>This option, when available, will allow a user to terminate an instance of PeerSync that contains an active Profile that is connected to the Profiler.</td>
</tr>
<tr>
<td><strong>Restart Active Profile</strong></td>
<td>This option, when available, provides intelligent restart functionality that eliminates/improves scanning upon PeerSync service/application restart. This greatly improves performance during a restart (most commonly due to profile changes, but also for any other reason).</td>
</tr>
<tr>
<td><strong>Add Job</strong></td>
<td>This button adds a Job to the bottom of the current list (See Profile Job List). Jobs are named &quot;New Job Item&quot; and assigned a number by default. If you have selected &quot;Use Wizard to Add New Jobs&quot; from the Options Menu, the Wizard application will open when this button is pressed. The Wizard provides a guided, step-by-step method for creating and configuring new Jobs. A drop-down list attached to this button also allows you to choose between &quot;Add Job With Wizard&quot; or &quot;Add Job With Defaults&quot; options. If the former is chosen, Wizard will open every time this button is pressed. If the latter is chosen, new Jobs added to the list through this button will be configured manually using Selection Tree screens. These Jobs will use whichever default settings are currently applied (See Job Menu, &quot;Save Defaults&quot;). Note: The first time &quot;Add Job With Wizard&quot; is chosen from the drop-down list, the Wizard application will open. After that point Wizard will be launched by pressing the Add Job button.</td>
</tr>
<tr>
<td><strong>Copy Job</strong></td>
<td>Creates a copy of the currently selected Job and places it at the bottom of the Profile Job List. Copies will be numbered by default and named after the original (i.e. &quot;Copy 1 of My Syncs&quot;).</td>
</tr>
<tr>
<td><strong>Rename Job</strong></td>
<td>Allows you to rename the currently selected Job. Jobs can also be renamed manually by clicking on them after they have been highlighted.</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Delete Job</strong></td>
<td>Deletes the currently selected Job(s). When this button is pressed, a dialog box will open asking you to confirm deletion. Jobs can also be deleted by selecting them and then pressing the DELETE key on your keyboard.</td>
</tr>
<tr>
<td><strong>Move Job Up</strong></td>
<td>Moves the currently selected Job up one place within the Profile Job List.</td>
</tr>
<tr>
<td><strong>Move Job Down</strong></td>
<td>Moves the currently selected Job down one place within the Profile Job List.</td>
</tr>
<tr>
<td><strong>Show Selection Tree</strong></td>
<td>Shows or hides the Selection Tree. If the Tree has been hidden, its space will be filled within the interface by the currently selected Settings screen. When the tree is hidden, screens can still be selected using the drop-down list attached to the Back button.</td>
</tr>
<tr>
<td><strong>Back</strong></td>
<td>Opens the screen located immediately above that, which is currently being displayed. Settings screens can also be accessed using the drop-down list located on the right side of the Back button; list items follow the same order as that shown on the Selection Tree.</td>
</tr>
<tr>
<td><strong>Next</strong></td>
<td>Opens the Profile Options screen located immediately below the screen currently being displayed.</td>
</tr>
<tr>
<td><strong>Help Manual</strong></td>
<td>Opens the application help file. You may also access specific parts of the help file for features you are currently observing by pressing 'F1' on your keyboard.</td>
</tr>
</tbody>
</table>

**Profile Description**

This field is located below the Tool Buttons Toolbar by default and displays a textual description of the current Profile. By default the description for an unsaved Profile will read "Profile Job List." Unless you enter a unique description into this field, a default description will be assigned upon saving the Profile; this default description will match the new Profile name.

Descriptions can be changed at any time; like all Profiler configurations, they must be saved prior to closing the Profile or application in order to be stored. You can change the placement of the Profile Description Toolbar by clicking on its left side and dragging it to rest above or below the Tool Buttons Toolbar. The Profile Description can also be hidden by unchecking the "Profile Description" option, accessed through the "Toolbars" item on the View Menu.

**Menus**

1. **File Menu**

   **File**

   This menu includes items allowing you to create and save new Profiles, open existing Profiles, create Profile desktop shortcuts, and exit the application.
<table>
<thead>
<tr>
<th>New</th>
<th>Create a new Profile. This feature is accessible from the Tool Buttons Toolbar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open an existing Profile. This feature is also accessible from the Tool Buttons Toolbar.</td>
</tr>
<tr>
<td>Reopen</td>
<td>Reopen a recently used Profile.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the current Profile. This feature is also accessible from the Tool Buttons Toolbar.</td>
</tr>
<tr>
<td>Save as</td>
<td>Rename and Save the current Profile.</td>
</tr>
<tr>
<td>Profile - Revert to Saved</td>
<td>Revert to the last saved settings of the current Profile.</td>
</tr>
<tr>
<td>Profile - Merge Existing</td>
<td>Merge an existing Profile into the current Profile.</td>
</tr>
<tr>
<td>Profile - Create Shortcut on Desktop</td>
<td>Create and add a shortcut to PeerSync of the current Profile and settings/command line arguments to the desktop.</td>
</tr>
<tr>
<td>Profile - Save Defaults</td>
<td>Save the current settings of the Profile as the default settings.</td>
</tr>
<tr>
<td>Exit</td>
<td>Close/exit the application.</td>
</tr>
</tbody>
</table>

### 2. Edit Menu

<table>
<thead>
<tr>
<th>Edit</th>
<th>Allows you to move one step up or down between Selection Tree options screens while providing a shortcut to the Run/View Current Profile Activity screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Move back to the previous screen. This feature is accessible from the Tool Buttons Toolbar.</td>
</tr>
<tr>
<td>Next</td>
<td>Move on to the next screen. This feature is also accessible from the Tool Buttons Toolbar.</td>
</tr>
<tr>
<td>Run/View Current Profile</td>
<td>Go to the Run/View Current Profile Activity screen.</td>
</tr>
</tbody>
</table>

### 3. View Menu

<table>
<thead>
<tr>
<th>View</th>
<th>Allows you to change the appearance of the application interface. &quot;Hint&quot; items enable or disable pop-up hints activated by passing the mouse pointer over interface features, as well as those displayed in the Status Bar located at the bottom of the application interface. In addition to a description of Profiler features, hints will identify command line arguments associated with those features (if any).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars - Tool</td>
<td>Show/hide the Tool Buttons Toolbar.</td>
</tr>
</tbody>
</table>

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
### Buttons

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbars - Profile Description</td>
<td>Show/hide the Profile Description Toolbar.</td>
</tr>
<tr>
<td>Toolbars - with Hot Tracks</td>
<td>Show/hide the hot tracks features for the Toolbars.</td>
</tr>
<tr>
<td>Toolbars - with Text Labels</td>
<td>Show/hide description text labels for the Toolbars.</td>
</tr>
<tr>
<td>Selection Tree</td>
<td>Show/hide the Selection Tree left side panel. This feature is also accessible from the Tool Buttons Toolbar.</td>
</tr>
<tr>
<td>Refresh Current Profile Activity</td>
<td>Refresh Profile activity.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Show/hide the Status Bar at the bottom of the application.</td>
</tr>
<tr>
<td>Hints - on Application</td>
<td>Show/hide pop-up hints displayed on the application.</td>
</tr>
<tr>
<td>Hints - on Status Bar</td>
<td>Show/hide hints displayed on the Status Bar.</td>
</tr>
<tr>
<td>Folders</td>
<td>Allows for the ability to launch and display Source and Target Folder selections in organized Explorer windows in a set viewing area. This helps the user to view and/or validate the Source and Target Folder content before, after, and during synchronization. These features may be helpful during evaluation and when running and testing a newly modified Profile.</td>
</tr>
<tr>
<td>Job Groups * (Enhanced Package)</td>
<td>Similar to Microsoft's Multiple Document Interface (MDI), PeerSync now contains a multi-pane interface that allows the user to organize groups of Jobs (Source and Target pairs) by any convention necessary. User-specified tab controls allow quick transition from one group to another. The traditional Job list interface is still available for those who do not need the group panes.</td>
</tr>
<tr>
<td>Remote Control * (Enhanced Package)</td>
<td>Displays the Remote Control Dialog which allows for the ability to monitor PeerSync running as a service on the local machine and/or any instances of PeerSync running on machines that are connected to the local machine.</td>
</tr>
<tr>
<td>Profile Messages</td>
<td>Open the Profile Message Log file if it exists. The naming convention of the Message Log files is as follows: Profile.snc. log, where Profile represents the name of the current Profile.</td>
</tr>
</tbody>
</table>

* Note: Some features described on this page require the Enhanced Package.

### 4. Options Menu

**Options**

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard interact with each other and Windows Explorer.
Use Wizard to Add Jobs

Available only if the Wizard is installed during the PeerSync installation. If selected, directs Profiler to open the Wizard application as an easier and simpler way to add new Jobs to a Profile. If not selected, the Add Job option will use the saved Job defaults. This feature is toggled on or off depending on which option was used the last time that a Job was added (with Defaults or with Wizard).

Create SNC extension association

If selected, creates an association of any file that has an SNC extension with the Profiler to be used as the default application to open these files. If not selected, the association of SNC files with the Profiler will be removed. This feature is also accessible from the Startup Services screen.

Add Quick-Sync Folder option to Explorer menu

If selected, will add our Quick-Sync feature to Windows Explorer. To access this feature, simply right-click on any folder in Explorer, or on your Desktop, and you will be able to sync the folder to selected Target Folder(s), add the Job to a Quick-Sync Profile that is stored out in memory, and administer the ability to modify/add to the Jobs using the Profiler. This feature is also accessible from the Startup Services screen.

On Profile Exit

This option allows for the ability to do one of the following when exiting the Profiler while it is connected to an Active Profile: Display Terminate Active Profile Dialog, Leave Active Profile Running, or Terminate Active Profile.

Global Settings

Displays various settings including Recovery/Offline Options, Performance Options, Reporting Options, Display Options, ACL Options, Bi-directional Options, Managed Files Options, and Current Command Line Arguments.

5. Run Menu

Run

Allows you to Launch the Current Profile, Terminate the Active Profile and Update the Current Profile.

Launch Current Profile

This feature will launch the current Profile (Job/Global settings) in PeerSync. During this process, an instance of PeerSync will be started with the current Profile as the first parameter and the arguments selected from the Options/Commands screen as the subsequent parameters. You can automate this process via a shortcut, through the startup folder, in the registry or as a service by selecting one of these features from the Startup Services screen. This feature is also accessible from the Tool Buttons Toolbar.

Terminate Active Profile

This option, when available, will allow a user to terminate an instance of PeerSync that contains an active Profile which is connected to the Profiler. This feature is also accessible from the Tool Buttons Toolbar.

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
Update Current Profile  | This option, when available, will allow a user to update an instance of PeerSync with the current Profile opened in the Profiler.

Restart Active Profile  | This option, when available, provides intelligent restart functionality that eliminates/improves scanning upon PeerSync service/application restart. This greatly improves performance during a restart (most commonly due to profile changes, but also for any other reason).

Pre-Sync Report  | This executes a pre-sync report of the currently selected Jobs. During this process, files and folders will not be modified and persistent arguments set for the current Profile will be ignored. A report will be created and displayed with the work that would be performed if a synchronization was actually run. This feature may be quite helpful during evaluation and when running and testing a newly modified Profile. Pre-Sync Report options are as follows:

Run a Pre-Sync Report (do not sync files/folders)
Starts PeerSync to analyze the work that would be performed if synchronization was actually run. During this process files and folders will not be modified. The report file, PreSync.Log, will be displayed at the end of the run.

Overwrite existing Pre-Sync report files
Enabled by default, this setting overwrites the PreSync.Log file when the Pre-Sync process completes.

Show Pre-Sync report file at end of run
Enabled by default, this setting will open and display the PreSync.Log report file after the Pre-Sync process completes.

Reprocess Failed Events  | This option, when available, will allow for Failed Files to be processed. Failed Files are files that have failed to be replicated/synchronized possibly due to Retries being turned off or exceeded.

Reprocess Failed Scans  | This option, when available, will allow for Failed Scans to be processed. Failed Scans will only occur if a scan is interrupted or cannot run and the Retry failed connection every x minutes option is disabled.

Note: Because it is separate from the core software engine, the Profiler allows you to create and configure new Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler screens, "Current" refers to the Profile currently being configured but not yet launched, while "Active" most often refers to the Profile presently being run by the PeerSync engine.

6. Job Menu

Job

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has been checked on this menu, you will be able to select and apply settings to Multiple Jobs.
Add - Job with Defaults | Creates and adds a Job to the current Profile using the saved Job defaults. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Copy | Creates a duplicate copy of the currently selected Job and all of its settings. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Rename | Allows for the renaming of the selected Job. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Delete | Allows for the deletion of the currently selected Job(s). This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Clear All | This will close the current Profile allowing for the user to create a new Profile.

Move Up | Moves the currently selected Job up one in the list. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Move Down | Moves the currently selected Job down one in the list. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Select All | This will select all of the Jobs.

Invert Selection | This will change the selected state of all the Jobs.

Allow Multiple Selection | Gives the ability to select and apply settings to Multiple Jobs.

Create Auto Job Name | This feature allows a simple way to generate meaningful Job names. When selecting this item, Job names are automatically generated based on their Source and Target paths which make it a simple task to organize the Job list.

Log File - View | Display the log file for the selected Job.

Log File - Clear | Clear the log file for the selected Job.

Message Log File - View | Display the message log file for the selected Job or profile.

Message Log File - Clear | Clear the message log file for the selected Job or Profile.

Save Defaults | Stores the currently selected Job Settings as the default for all subsequent newly added Jobs.

7. Help Menu

Help

While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync’s Real-Time Monitoring and Scheduled Operation modes.

<table>
<thead>
<tr>
<th>Demos</th>
<th>This option allows the user to instantly run either a Real-Time or Scheduled test Profile to demonstrate PeerSync’s synchronization capabilities.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site</td>
<td>This menu item will have many links back to our web site for product information, downloads, updates and support.</td>
</tr>
<tr>
<td>Online Resources</td>
<td>Provides links to online demos/tutorials/documents and forums.</td>
</tr>
<tr>
<td>Check for Updates...</td>
<td>Checks whether you are using the latest version of PeerSync. This process requires an Internet connection in order to transmit your registration information to our web server for validation. This feature also has the ability to check updates for all PeerSync related products (if they are installed) directly from the Profiler. This includes the PSListener, PeerLock, and the PSObserver. A menu option to check for updates will be displayed for all products that have been installed.</td>
</tr>
<tr>
<td>PeerSync Help</td>
<td>Will open the application help file to the contents section. You may also access specific parts of the help file for features you are currently observing by pressing ‘F1’ on your keyboard.</td>
</tr>
<tr>
<td>Create Support Info File on the Desktop...</td>
<td>This option will compile all Profile related files into a zip folder on the Desktop. This information can be submitted to our support team for analysis. The following is a list of files that are included if they exist:</td>
</tr>
</tbody>
</table>

**PeerSync Files:**

- [ProfileName].snc
- PSDEF.CFG
- [ProfileName].tot.xml
- [ProfileName]_.np_tot.xml
- [ProfileName].cur.xml
- [ProfileName]_.np_cur.xml
- [ProfileName].las.xml
- [ProfileName]_.np_las.xml
- [ProfileName].snc[.bak\*].log
- PSError.Log
- [JobName][.bak\*].log
- [JobName]_.flt[.bak\*].log
- [JobName]_.del[.bak\*].log
- [ProfileName]_.tlr
- [%VariableNames%].txt
- ADDCache.cur.txt
- - Profile
- - Configuration File
- - Total Support File
- - Total Support File (Non Persistent)
- - Current Support File
- - Current Support File (Non Persistent)
- - Last Support File
- - Last Support File (Non Persistent)
- - Profile Error Log Files
- - Application Error Log File
- - Job Level Log Files
- - Job Level Error Log Files
- - Deletion Cleanup Log Files
- - Time Last Run Log File
- - Also included are Variable Data Import and Job Data Import files
- - Current cache file of Add events
<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDCache.las.txt</td>
<td>Last cache file of Add events</td>
</tr>
<tr>
<td>UPDCache.cur.txt</td>
<td>Current cache file of Update events</td>
</tr>
<tr>
<td>UPDCache.las.txt</td>
<td>Last cache file of Update events</td>
</tr>
<tr>
<td>DELCache.cur.txt</td>
<td>Current cache file of Deleted events</td>
</tr>
<tr>
<td>DELCache.las.txt</td>
<td>Last cache file of Deleted events</td>
</tr>
<tr>
<td>JSCCache.cur.txt</td>
<td>Current cache file of Job Scans</td>
</tr>
<tr>
<td>JSCCache.las.txt</td>
<td>Last cache file of Jobs Scans</td>
</tr>
<tr>
<td>EXCCache.cur.txt</td>
<td>Current cache file of Excluded items</td>
</tr>
<tr>
<td>EXCCache.las.txt</td>
<td>Last cache file of Excluded items</td>
</tr>
<tr>
<td>FFLCache.cur.txt</td>
<td>Current cache file of Failed Events</td>
</tr>
<tr>
<td>FFLCache.las.txt</td>
<td>Last cache file of Failed Events</td>
</tr>
<tr>
<td>JSHCache.cur.txt</td>
<td>Current cache file of Historical Data</td>
</tr>
<tr>
<td>JSHCache.las.txt</td>
<td>Last cache file of Historical Data</td>
</tr>
<tr>
<td>MSGCache.cur.txt</td>
<td>Current cache file of Messages</td>
</tr>
<tr>
<td>MSGCache.las.txt</td>
<td>Last cache file of Messages</td>
</tr>
<tr>
<td>CTPCache.cur.txt</td>
<td>Current cache file of Copy Thread Progress</td>
</tr>
<tr>
<td>CTPCache.las.txt</td>
<td>Last cache file of Copy Thread Progress</td>
</tr>
<tr>
<td>SNCCache.cur.txt</td>
<td>Current cache file for the Profile</td>
</tr>
<tr>
<td>SNCCache.las.txt</td>
<td>Last cache file for the Profile</td>
</tr>
<tr>
<td>MFLCache.cur.txt</td>
<td>Current cache file of Managed Files List items</td>
</tr>
<tr>
<td>MFLCache.las.txt</td>
<td>Last cache file of Managed Files List items</td>
</tr>
<tr>
<td>SupportInfo.txt</td>
<td>Contains the list of files that PeerSync will try to include in the support zip folder</td>
</tr>
</tbody>
</table>

**PeerLock Files:**
- PLDef.CFG - Configuration File
- PeerLock[.bak*].log - PeerLock Log Files

The files will be zipped and stored on the Desktop for easy attachment to e-mails. A copy of the zipped folder will also be stored in the PeerSync installation folder (i.e. C:\Program Files\PeerSync\InfoFiles\SupportInfo_{date/time}.zip).
Create System Info File on the Desktop... Creates a system info file (SysInfo.nfo) on the Desktop. A copy of the file will be kept in the InfoFiles folder located in the PeerSync installation folder (i.e. C:\Program Files\PeerSync\InfoFiles\SystemInfo_200810081953.zip - where 200810081953 represents yyyymmddhhss respectively). Creating the System Information File takes a few minutes. Keeping a copy of the System Information file in the InfoFiles folder eliminates the need to wait for the creation of a new file whenever one is needed and provides an archive of previous system states that can be used for troubleshooting.

Register PeerSync Will display the PeerSync Registration Screen to activate the PeerSync trial version or upgrade the current license.

License Information Will display the different Product Editions and Licensing available for PeerSync. Will also display what the current edition has available as well as other useful information about the current package you are running.

About PeerSync Will display an about screen, which contains information about the current PeerSync you are running.

8. Evaluation Menu

<table>
<thead>
<tr>
<th>Evaluation</th>
<th>Only displayed in evaluation copies of the software, this menu item will contain features that we believe are helpful to the user during evaluation such as demos, README files, and other evaluation oriented features.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read me first...</td>
<td>Opens the Evaluation.txt file that provides instruction on how to run the built-in Demo, add your first Job, run your first Profile and steps on how to use Quick-Sync and the Wizard.</td>
</tr>
<tr>
<td>Reviewer's Guide</td>
<td>Opens the Reviewer's Guide manual that provides a quick product overview and useful evaluation scenarios and demonstrations.</td>
</tr>
<tr>
<td>Real-Time Monitoring Demo</td>
<td>Launches a demo that will synchronize the designated source and target folders automatically upon change in real-time.</td>
</tr>
<tr>
<td>Scheduled Operation Demo</td>
<td>Launches a demo that will synchronize the designated source and target folders every 15 seconds.</td>
</tr>
<tr>
<td>End Demo</td>
<td>Available only if PeerSync is running either the &quot;Real-Time&quot; or &quot;Scheduled&quot; demo. Selecting this option will terminate the running demo.</td>
</tr>
<tr>
<td>License Information</td>
<td>Opens the Licensing dialog which lists all the options/features that are Active or Inactive in the product. The About screen can be accessed from this dialog by clicking on the Register button.</td>
</tr>
<tr>
<td>Buy Now ...</td>
<td>Opens the web browser to our online purchase page from where the product can be purchased directly.</td>
</tr>
</tbody>
</table>
9. Popup View Menu

**View Popup Menu**

Activated by right clicking on the **Tool Buttons** Toolbar, **Profile Description** Toolbar, or the Status Bar. Some of these options can be selected from the **View Menu**.

<table>
<thead>
<tr>
<th><strong>Tool Buttons</strong></th>
<th>Show/hide the <strong>Tool Buttons</strong> Toolbar.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile Description</strong></td>
<td>Show/hide the <strong>Profile Description</strong> Toolbar.</td>
</tr>
<tr>
<td>with <strong>Hot Tracks</strong></td>
<td>Show/hide the hot tracks features for the Toolbars.</td>
</tr>
<tr>
<td>with <strong>Text Labels</strong></td>
<td>Show/hide description text labels for the Toolbars.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Show/hide the Status Bar at the bottom of the application.</td>
</tr>
</tbody>
</table>

10. Popup Tray Icon Menu

**PeerSync Tray Icon Popup Menu**

Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when PeerSync is running as an application (not as a service) and has the “Show tray icon” option enabled in the **Options/Commands** window.

<table>
<thead>
<tr>
<th><strong>View Log File</strong></th>
<th>Allows you to access, launch and view Log files in the default text editor for the current Profile.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Message Log File</strong></td>
<td>Allows you to access, launch and view the Message log file for the current Profile.</td>
</tr>
<tr>
<td><strong>View Admin Folder</strong></td>
<td>Allows you to access, launch and view Admin log file Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td><strong>Open Source Folder</strong></td>
<td>Allows you to access, launch and view Source Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td><strong>Open Target Folder</strong></td>
<td>Allows you to access, launch and view Target Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td><strong>Show Status Display</strong></td>
<td>This item will show the PeerSync <strong>Status Display</strong> dialog box during synchronization so the user can see activity, status, and other information while PeerSync is running. This feature is only available if the <strong>Display Status</strong> in the PeerSync feature was enabled for the current Profile.</td>
</tr>
<tr>
<td><strong>Connect/Launch PeerSync Profiler</strong></td>
<td>This item will open the Profiler, if it is not already open, and send status messages to be displayed on the <strong>Run/View Current Profile Activity</strong> screen. This connection feature will only work if the <strong>Display Status</strong> in Profiler feature was enabled for the current Profile.</td>
</tr>
<tr>
<td><strong>About PeerSync</strong></td>
<td>Will display an about screen, that contains information about the current PeerSync you are running.</td>
</tr>
</tbody>
</table>
Exit PeerSync | Allows you to close/exit the current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This will provide key information about the current PeerSync application running including the Profile name and the status of VSS if it is running.

11. Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current Profile. Use of this list is central to the Profile-building process; all configurations made on the Job Settings screens (accessed through the Selection Tree) will only be applied to those Jobs currently selected from this list.

To select a Job, highlight it using the left mouse button. The “Allow Multiple Selection” item must be checked on the Job Menu in order to select and have settings applied to Multiple Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on your keyboard, and then highlight the last Job you wish to include. You can also hold down the SHIFT key and then use the up or down arrow keys on your keyboard. To select Multiple Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your keyboard and click on each additional Job you wish to include. Once you have selected a Job or Jobs, move through the screens found on the Selection Tree and apply settings as desired. Highlighting on the selected Job(s) will appear gray as you move through these screens, indicating that any configured settings will only be applied to those selected Jobs.

The box appearing to the left of each Job must be checked in order for that Job to be included in the active Profile when launched. Although unchecked Jobs will not be processed upon launch, they will be saved within the Profile for future use and/or selection.

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job Item 1" by default (this applies to manual Job creation only). The first New Job added within an existing Profile will also bear this name. Successive Jobs will be named "New Job Item 2," "New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool Button, through items found on both the Job Menu and Profile Job List Pop-Up Menu described below, or manually by selecting it a second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy, delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by using items found on the Profile Job List Pop-Up Menu described below. You can also navigate the list and delete items using the DELETE and up and down arrow keys on your keyboard.

Note: In order to navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job List window; this ensures that during configuration any options chosen from the Selection Tree screens are applied exclusively to the currently selected Job.

The height of the Profile Job List window can be changed by passing the mouse pointer over its bottom border until a double/Arrow cursor appears, then dragging the window to meet the desired size. At minimum size, only a single Job may be viewed. Adding a new Job while this view is in effect prompts display of up and down arrow buttons in the right side of the window. These buttons allow you to view different Jobs within the list.
**Job List Pop-Up Menu**

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used features found on the Job Menu while providing some additional items listed below.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronize Selected Jobs</strong></td>
<td>This executes an immediate, non-persistent synchronization of the currently selected Jobs (&quot;non-persistent&quot; refers to a one-time sync process; &quot;persistent&quot; refers to ongoing sync operations such as Real-Time Monitoring or Scheduled Operations). During this process, persistent arguments set for the current Profile will be ignored. When the button is released, a confirmation dialog will be displayed indicating which Jobs have been selected from the active Profile and asking you to confirm synchronization through a &quot;Yes&quot; or &quot;No&quot; button. If &quot;Yes&quot; is selected, the synchronization will proceed. A message will always be displayed upon completion of this operation. Other sync operations allow you to choose whether or not such a message will be displayed.</td>
</tr>
<tr>
<td><strong>Create Pre-Sync Report</strong></td>
<td>This executes a pre-sync report of the currently selected Jobs. During this process, files and folders will not be modified and persistent arguments set for the current Profile will be ignored. A report will be created and displayed with the work that would be performed if a synchronization was actually run. This feature may be quite helpful during evaluation and when running and testing a newly modified Profile.</td>
</tr>
<tr>
<td><strong>Log File - View</strong></td>
<td>This menu item allows you to view Log reports by opening the file in a text editor. This feature is also accessible from the Reporting screen.</td>
</tr>
<tr>
<td><strong>Log File - Clear</strong></td>
<td>This menu item allows you to clear Log reports. This feature is also accessible from the Reporting screen.</td>
</tr>
<tr>
<td><strong>Message Log File - View</strong></td>
<td>This menu item allows you to view Message Log reports by opening the file in a text editor. This feature is also accessible from the View Menu item.</td>
</tr>
<tr>
<td><strong>Message Log File - Clear</strong></td>
<td>This menu item allows you to clear Message Log reports. This feature is also accessible from the View Menu item.</td>
</tr>
<tr>
<td><strong>Job List View Options</strong></td>
<td>This feature enables/disables the ability to display the &quot;Click Here to Add Another Job&quot; Job every time a new Job has been created.</td>
</tr>
<tr>
<td><strong>Use &quot;&lt;Click Here to Add Another Job&gt;&quot; Feature</strong></td>
<td>This menu item will add a new Job to the end of the Job list named &quot;&lt;Click Here to Add Another Job&gt;&quot; every time a new Job is created.</td>
</tr>
<tr>
<td><strong>Suppress Add Job Confirm Dialog</strong></td>
<td>This menu item will suppress the Confirmation Dialog that is launched when clicking on the &quot;&lt;Click Her to Add Another Job&gt;&quot; Job.</td>
</tr>
<tr>
<td>View Job Groups* (Enhanced Package)</td>
<td>This feature enables/disables the ability to allow the user to organize/categorize Jobs within a Profile into Job Groups. When this feature is enabled, you can create as many Job Groups as desired. Each Job Group is represented by a Tab. Each Tab displays the Job Group Name, the number of Checked Jobs and the number of Total Jobs for the corresponding Job Group, in the following format: GROUP NAME [CHECKED JOBS / TOTAL JOBS]</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select All</td>
<td>This menu item will select/highlight all Jobs within the current Job Group for a quick and easy way of modifying all Jobs within a given Profile. If this feature is not enabled you must turn on the Allow Multiple Selection feature on from the Job Menu.</td>
</tr>
<tr>
<td>Last Run On</td>
<td>This is a display of the last run date/time of the selected Job within the current Profile. This is the date/time that will be used when comparing files for the Bi-directional Synchronization Mode option on the File Options screen. This feature is also displayed on the from the Folder Selection screen.</td>
</tr>
<tr>
<td>Last Run On - Reset</td>
<td>This allows a means of resetting the last run date/time of the selected Job within the current Profile.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Job Group Pop-Up Menu* (Enhanced Package)</th>
<th>Activated by right clicking on the Profile Job List, this Popup menu allows for the following features:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Job Group</td>
<td>This menu item will create and add a new Job Group to the existing Profile.</td>
</tr>
<tr>
<td>Edit or Delete Job Groups</td>
<td>These menu items will display the Modify Job Groups Dialog, allowing for the adding, renaming, moving, re-ordering, modifying and/or the deletion of Job Groups.</td>
</tr>
<tr>
<td>Edit Job Groups Dialog</td>
<td>To add a Job Group click &quot;New,&quot; then type the desired name into the field located at the bottom of the dialog. Repeat this process for each Job Group you wish to add. Entries can be deleted by selecting them from the list and clicking the &quot;Delete&quot; key at the bottom of the box. You can also use the &quot;Up&quot; and &quot;Down&quot; buttons to reorder the items.</td>
</tr>
<tr>
<td>All Tabs - Check All Jobs</td>
<td>This menu item will set all Jobs to the checked state allowing for a quick and easy way of checking all Jobs across all Job Groups.</td>
</tr>
<tr>
<td>All Tabs - Uncheck All Jobs</td>
<td>This menu item will set all Jobs to the unchecked state allowing for a quick and easy way of unchecking all Jobs across all Job Groups.</td>
</tr>
</tbody>
</table>

* Note: Some features described on this page require the Enhanced Package.
Selection Tree

Screens can be accessed through the Selection Tree that are used to set synchronization criteria for individual Jobs (Job Settings), as well as set global properties relating to execution of the entire Profile and all related Jobs (Global Settings). Once you have selected a Job or Jobs from the Profile Job List, all options configured on Job Settings screens will only be applied to those selections. After synchronization criteria for all individual Jobs have been established, use the Global Settings screens to set global properties relating to all Jobs, as well as choosing how you would like the Profile to be executed. The Profile Job List will appear gray when any Global Settings screen is displayed, indicating that all properties set on that screen will be applied to the entire Profile.
Selection Tree Modes

The Selection Tree Modes are located in a drop-down list above the Selection Tree. These modes can be used to show/hide PeerSync configuration windows. The Selection Tree can be set to Basic, Intermediate, Advanced or Customized. Some Selection Tree items will not be accessible depending on the package you are currently using. "Basic" is the default Selection Tree Mode.

Selection Tree Categories

New in PeerSync v7.4, customers who are running PeerLock v2.0.1 or higher on the same machine as PeerSync will now be able to configure PeerLock directly from the PeerSync Profiler. Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock, ability to access/view/edit the PeerLock Global Settings from the PeerSync Profiler, ability to install/uninstall the PeerLock Service, as well as launch and view PeerLock directly from the PeerSync Profiler.

The Selection Tree can be categorized into four sections: PeerSync, PeerLock, Startup/Service, and Run/View. By default these categories will not be shown unless you have PeerLock v2.0.1 or newer installed on the same computer as PeerSync. You can manually display these categories by adding PeerLock windows to the Customized tree mode.

Selection Tree Pop-Up Menu

Activated by right clicking on the Selection Tree, this menu duplicates the items listed in the Selection Tree, as well as, the items listed in the drop-down list located on the right side of the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync Selection Tree Category, this Menu offers the following options:

<table>
<thead>
<tr>
<th>Selection Tree Pop-Up Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show All Profile Options</td>
</tr>
<tr>
<td>This feature will toggle between showing all Profile Options and the Custom Options in the Selection Tree.</td>
</tr>
<tr>
<td>Customize</td>
</tr>
<tr>
<td>This feature will allow the user to select which Profile Options to display in the Custom Selection Tree, when the &quot;Show All Profile Options&quot; is turned off. When selected the user will be given the dialog box shown below to pick and choose which Profile Options to use.</td>
</tr>
</tbody>
</table>

Selection Tree Categories

- PeerSync
- PeerLock
- Startup/Service
- Run/View
1. PeerSync

1.1 PeerSync Job Settings

PeerSync Job Settings

A Job is a source-target backup/synchronization scenario.

Jobs are created by identifying a Source Folder and a Target Folder, to which the contents of the Source Folder will be synchronized to the Target Folder. Each Job has unique options, settings and modes that can be applied to it.

These options, settings and modes are categorized into screens based on what they will do to the Job or what they will do to the data that will be modified by the Job.

These selections determine which contents will be synchronized and in what manner they will be synchronized. As well as, when they will be synchronized according to your choice of real-time, interval scheduling, daily timer scheduling, trigger driven or manually initiated operations.

Note: Some settings are ignored when enabled in conjunction with other settings. For example, report summaries are ignored in multiple threaded or enhanced Real-Time mode.
1.1.1 Folder Selection

Folder Selection

<table>
<thead>
<tr>
<th>Mode</th>
<th>Source Folder</th>
<th>Target Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Host Name:</td>
<td>Name:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>192.168.171.149</td>
</tr>
<tr>
<td>TCP</td>
<td>\D:%JobName\</td>
<td>\E%JobName\</td>
</tr>
<tr>
<td>FTP</td>
<td>\D\DataSet 1\</td>
<td>\E\DataSet 1\</td>
</tr>
</tbody>
</table>

Include sub-folders

Swap Source and Target Folders

Set Alternate/Additional Targets

Last Save: 8/2/2012 1:38:50 PM (Saved by: DOMAIN\USER)

Note: Features listed on this page may require the TCP WAN Connector and/or File Transfer Protocol (FTP) options.

Each Job within a Profile is initially defined by using the Folder Selection screen to select a Source and Target Folder. The contents of a Source Folder will be synchronized to a Target Folder according to criteria further defined on other Settings screens. Once you have highlighted a Job or Jobs from the Profile Job List, this screen offers several different methods to locate and select folders for synchronization. File paths can be typed manually, or you can browse local and network drives to locate and select your desired folders.

Source Folder Selection

The options listed on this page can be accessed from the Folder Selection window. The following options are available for selecting a Source folder.

Using Normal Mode

Select a "Normal" Source folder if you can navigate to the desired Source directory via a Local Path, a UNC Path, or a Mapped Drive. This selection requires that the machine on which PeerSync is running has full access to the desired
Source directory. In some instances Network Logon may be required.

Select a Source Folder by typing the file path into the field provided or by using the Select Source Folder Button. By default, the Source Folder field will contain the path in which PeerSync has been installed: in most cases this will be C:\Program Files\PeerSync\Source. The convention outlined in this path must be used when manually typing entries, (i.e. a drive must be specified followed by a colon, with subsequent folders separated by backslashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

UNC names can be entered manually, or can be selected from the Network Neighborhood using the "Browse for Folder" dialog box (see Select Source Folder Button). UNC names will appear in the form \COMPUTER\SHAREDDEVICE\PATH. For example: \SERVER1\D\USERDATA.

Starting with the release of v9.0, we now support the ability to connect to a remote NetApp filer and register for real-time event notification. Please visit http://www.peersoftware.com or contact Sales for license information.

Note: We do not recommend using UNC paths for folders that reside on the local machine, in this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows Explorer into the Source Folder Field for automatic insertion.

The Source Folder Field holds a folder selection History of up to 10 entries. They can be selected by clicking on the drop down button located to the right of the field.

The current path will be displayed below the Source Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection field, the application will throw a message and use the default PeerSync installation path C:\Program Files\PeerSync\Source instead.

The Host Name and User Name & Password values (if provided) are displayed above the Source Folder Selection field (see Network Logon).

Using TCP Mode

Select a "TCP" Source folder if the Source directory is outside the scope of the machine on which PeerSync is running. TCP enables access to machines not located on the same network as PeerSync. As a prerequisite, the PSL listener needs to be
installed and running on the remote Source machine in order for PeerSync to be able to communicate with it. This feature supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over the public Internet for security purposes. Otherwise, you should use our Encryption feature with a user name and password to protect data and all communication as it is being transferred.

When selecting the TCP Mode for the first time the Source TCP/Port Configuration window will open automatically for Source Folder configuration. Otherwise, the previously entered TCP folder path will be displayed. This path can be manually edited by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be used when manually typing entries, (i.e. the key word TCP must be specified followed by a colon, two backslashes, the Source IP address or machine name, and subsequent folders separated by backslashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

The Source Folder Field holds a folder selection History of more then 10 entries. They can be accessed by clicking on the drop down button located to the right of the field.

The current path will be displayed below the Source Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection field, the application will throw a message and use the last valid TCP path specified or the default path TCP:\\127.0.0.1\C\Source. 127.0.0.1 represents the loopback IP address of the local host (i.e. the machine on which PeerSync is running).

The provided Host Name and User Name & Password values are displayed above the Source Folder Selection field.

<table>
<thead>
<tr>
<th>Using FTP Mode</th>
<th>Select an &quot;FTP&quot; Source Folder to automatically logon to a Source FTP server. This feature supports proxy servers/firewalls and has an option to adjust for GMT time on the FTP server side.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When selecting the FTP Mode for the first time the Source FTP Logon Configuration window will open automatically for Source Folder configuration. Otherwise, the previously entered FTP folder path will be displayed. This path can be manually edited by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be used when manually typing entries, (i.e. the key word FTP</td>
</tr>
</tbody>
</table>
must be specified followed by a colon, two forward slashes, the Source IP address or machine name, and subsequent folders separated by forward slashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

The Source Folder Field holds a folder selection History of more then 10 entries. They can be accessed by clicking on the drop down button located to the right of the field.

The current path will be displayed below the Source Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection field, the application will throw a message and use the last valid FTP path specified.

The provided Host Name and User Name & Password values are displayed above the Source Folder Selection field.

### Related Options
- **Source Folder Configuration Button**
- **Select Source Folder Button**
- **Explore/Open/Create Button**
- **Source Folder Popup Menu**

### Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit [http://www.peersoftware.com](http://www.peersoftware.com) or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit [http://www.peersoftware.com](http://www.peersoftware.com) or contact Sales for additional information.

3. You cannot monitor a TCP, FTP or any other remote folder/device in Real-Time.

4. Compression, Bi-directional synchronization mode, File Recovery, Exclude empty Source Folders, Turn file archive attribute off after synchronization and CRC32, as well as other non applicable features are ignored when using an FTP Source.

5. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP Source.

6. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.

7. Selecting a TCP Source and a TCP Target for the same Job is not supported.

8. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the synchronization process (Source or Target).

### Source Folder Configuration: Using Normal Mode

The Source folder configure button is activated by clicking on the Configure button located.
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens the Source Folder Configuration window. Alternatively, you may right-click on the Source Folder field and select Configure: Source Folder (See Source Folder Popup Menu). This window allows for network logon Name and Password information for a remote Source connection.

<table>
<thead>
<tr>
<th>Detection Method - Global</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection Method for Real-Time Monitoring</td>
<td>Choose the desired detection method for the Source folder. You may choose from the following options:</td>
</tr>
<tr>
<td>Normal (default)</td>
<td>Select this option to specify a local or remote drive which resides on the network (LAN, WAN, or VPN). This is the recommended detection method for most scenarios. Close the Source Folder Configuration dialog once you have selected your desired source folder detection mode and enter the path to the source folder in the Folder Selection screen (i.e. D:\Path\Folder).</td>
</tr>
<tr>
<td>NetApp fPolicy</td>
<td>Select this option to specify the path to a NetApp filer for either real-time or scanning scenarios. Close the Source Folder Configuration dialog once you have selected your desired source folder detection mode and enter the path to the source folder in the Folder Selection screen (i.e. \NetAppFiler\Share\Folder).</td>
</tr>
<tr>
<td>Detection Method Options</td>
<td>Exclude Users</td>
</tr>
<tr>
<td></td>
<td>When selecting NetApp fPolicy as the source detection mode, you have the option to filter/exclude real-time activity from a list of specific users. Real-time events from the users in this field will be excluded. Enter the desired user names in a command delimited format (i.e. user1, user2, user3).</td>
</tr>
<tr>
<td></td>
<td>Allow for remote real-time configuration</td>
</tr>
<tr>
<td></td>
<td>This option indicates whether or not the selected source folder detection method supports real-time detection for remote paths. Presently, this feature is only supported for NetApp fPolicy detection modes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connection Manager - Global</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Connection Manager tracks and determines if connections are lost to source and/or target folders. With this new capability PeerSync can proactively detect when a connection is lost or reconnected, giving the ability to restart real-time and/or scan Jobs if</td>
<td></td>
</tr>
<tr>
<td><strong>Automatically use recommended settings based on Detection Method (Default)</strong></td>
<td>Check this option if you wish to let the Connection Manager track the connection status on both the source and target locations. When a lost connection is restored, PeerSync will restart real-time and/or scan Jobs if the option to &quot;Scan Job once at start&quot; is enabled. In addition, this logic will apply to only connections which are set for real-time monitoring.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Connection Manger for Failed Connections</strong></td>
<td>Choose one of the following options to manually disable or enable the Connection Manger which tracks the connection status on the desired locations.</td>
</tr>
<tr>
<td><strong>Disabled</strong></td>
<td>Disable the Connection Manager</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the Connection Manger to track the connection status on the source location. Connectio ns Only</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the Connection Manger to track the connection status on the target location. Connectio ns Only</td>
</tr>
<tr>
<td><strong>Enabled</strong></td>
<td>Enable the Connection Manger to track the connection status on both the source and target locations. Target Connectio ns</td>
</tr>
<tr>
<td><strong>Connection Manager Options</strong></td>
<td>Only Set the Connection Manager to monitor only connections that are set for real-time detection.</td>
</tr>
<tr>
<td><strong>Only include connections that are set for real-time monitoring</strong></td>
<td>Scan real-time Jobs on reconnect if the Scan Job once at start option is enabled.</td>
</tr>
<tr>
<td><strong>Scan real-time Jobs on reconnect if &quot;Scan Job once at start&quot; is enabled</strong></td>
<td>Set the Connection Manager to scan real-time Jobs on reconnect if the Scan Job once at start option is enabled.</td>
</tr>
<tr>
<td><strong>NetApp Settings</strong></td>
<td>Edit or maintain default NetApp settings when selecting NetApp fPolicy as the detection method. These options are only applicable when using the NetApp fPolicy detection method.</td>
</tr>
</tbody>
</table>
**Automatically detect and use recommended NetApp configuration**

When using the **NetApp fPolicy** detection method, checking this option will automatically populate the required NetApp settings with the defaults. Uncheck this option if you wish to manually edit these settings.

<table>
<thead>
<tr>
<th>NetApp Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Server Name</td>
<td>Edit the host name or IP address of the NetApp filer.</td>
</tr>
<tr>
<td>Root Path Prefix</td>
<td>Edit the local path of the NetApp share you wish to monitor.</td>
</tr>
<tr>
<td>fPolicy Named</td>
<td>Edit the fPolicy name that is used to register for event notification on the filer. By default PeerSync uses PEERSYNC_COMPUTERNAME, where COMPUTERNAME is the name of the host where PeerSync is running. PeerSync will create the fPolicy name at the start of the Job.</td>
</tr>
<tr>
<td>Delete fPolicy on Close</td>
<td>By default PeerSync will remove/delete the fPolicy name it used to register for event notification when the Job is stopped. Disable this option if you do not want PeerSync to delete the fPolicy name when the Job is stopped.</td>
</tr>
</tbody>
</table>

**Network Logon Settings**

Provides the ability to connect to a source folder that may require a different account then the one PeerSync is running under.

<table>
<thead>
<tr>
<th>Network Logon Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect As</td>
<td>Provide the user name to allow PeerSync connection to the source directory that is not accessible using the current service or logged on account. Be sure to include the domain name if applicable (i.e. MyDomain\UserName).</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password information for login.</td>
</tr>
</tbody>
</table>

**Source TCP/Port Configuration**

The Source Folder Configure Button is activated by clicking on the Configure button located in right lower corner of the Source Folder panel/section. Selecting the Configure button opens the Source TCP/Port Configuration window. Alternatively, you may right-click on the Source Folder field and select Configure: Source Folder (See Source Folder Popup Menu).

**TCP Configuration Tab**

This tab provides a guided method for entering the Source TCP path.

<table>
<thead>
<tr>
<th>Host Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>Enter the IP address or machine name of the Source Folder into this filed. You may use the machine name only if the remote Source Machine resides on the same network as that on which PeerSync is running.</td>
</tr>
</tbody>
</table>
Path to Host

Provide the full path (i.e. C:\Documents and Settings\Source) to the Source folder in this field. The path entered needs to be a local path without a machine name or UNC format. This field does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path does not exist, PeerSync will create it during run time as long as a valid host name or IP address has been provided and it can find the drive letter specified.

Care must be exercised if your PSListener contains a "Root Path". If you specify such a path in your PSListener it will behave like an FTP server that sets Root Paths to limit user access to the local file system. If a "Root Path" exists on the PSListener it will limit PeerSync's ability to access directories on the remote device. PeerSync will only be able to access directories equal to or bellow the specified "Root Path" level provided that it meets the Port and Encryption requirements. In no circumstances can PeerSync access directories located above this path. If the remote path you enter in the Path to Host field references a directory above the "Root Path", PeerSync will create that folder structure at runtime bellow the "Root Path".

Example:

<table>
<thead>
<tr>
<th>PSListener &quot;Root Path&quot;</th>
<th>= C:\Backup\Users\Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>PeerSync's &quot;Path to Host&quot;</td>
<td>= C:\Backup\My Documents</td>
</tr>
<tr>
<td>Actual Remote Source Path</td>
<td>= C:\Backup\Users Admin\C\Backup\My Documents</td>
</tr>
</tbody>
</table>

Note: The "Root Path" will be ignored when performing byte-level replication using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab

This tab provides settings to be used by both the Source and Target connections when using TCP and/or Byte Replicator.

Time Out

Sets the amount of time a connection will wait to complete a data transfer before exiting and performing the failure operation.

Port

This is the TCP Port used to communicate with the Listener on the remote machine. This must match the port number that the PSListener is configured for. By default both Listener and PeerSync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in fewer bits. By default Compression is disabled to achieve faster performance.
User Information

This is an optional setting that allows you to specify a User Name and Password to be used for encryption as well as authentication purposes when connecting to the remote PSLListener. In order to activate encryption or authentication, you must specify both a User Name and a Password value. Strong DES encryption will be used to encrypt the data and communication as it is being transmitted over the Internet, LAN, WAN, or VPN.

The User Name and Password entries can be arbitrarily chosen and are not required to be valid. However, once specified, you must enter the same User Name and Password entries in the PSLListener Configuration residing on the remote location.

If you specify a User Name without a Password, the User Name entry will be ignored and no encryption or authentication with the PSLListener will occur.

Source FTP Logon Configuration

The Source Folder Configure Button is activated by clicking on the Configure button located in right lower corner of the Source Folder panel/section. Selecting the Configure button opens the Source FTP Configuration window. Alternatively, you may right-click on the Source Folder field and select Configure: Source Folder (See Source Folder Popup Menu).

FTP Configuration Tab

Provides a guided method for entering the Source FTP path as well as connection authentication.

<table>
<thead>
<tr>
<th>Host Name</th>
<th>Enter the IP address or machine name of the Source folder into this field. You may use the machine name only if the FTP Source machine resides on the same network as that on which PeerSync is running.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to Host</td>
<td>Provide the full path to the Source folder in this field (i.e. /FTProot/My Data/Source). Make sure the path begins at the base directory to which the FTP server allows connection. The path does not need to be preceded by the key phrase 'FTP' however it must start with a forward slash (/). This field does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path does exist, PeerSync will create it during run time as long as a valid host name or IP address has been provided.</td>
</tr>
<tr>
<td>User Name</td>
<td>Stores the Source FTP User Name information for login.</td>
</tr>
<tr>
<td>Password</td>
<td>Stores the Source FTP Password information for login.</td>
</tr>
</tbody>
</table>

FTP Settings Tab
Provides configuration for the FTP Source Selection.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Passive Mode</td>
<td>Sets the FTP mode to passive. The phrase passive refers to the FTP server which passively accepts connections and data while the client initiates both the control connection and the data connection to random ports specified by the server. Passive mode is enabled by default.</td>
</tr>
<tr>
<td>Host is using GMT</td>
<td>Option to adjust for GMT time on the FTP server side.</td>
</tr>
<tr>
<td>Time Out (seconds)</td>
<td>Sets the amount of time a connection will wait to complete a data transfer before exiting and performing the failure operation.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number used to initiate an FTP session or &quot;command&quot; connection to the FTP server. Uses standard port 21 by default.</td>
</tr>
<tr>
<td>Use Proxy - Firewall</td>
<td>This option allows you to specify the Host Name, User ID, Password, and Port number to a network Proxy - Firewall.</td>
</tr>
<tr>
<td>File types to transfer as ASCII</td>
<td>Through this field, file types can be selectively tagged for transfer as ASCII upon synchronization. File types can be typed manually, or can be specified using either the &quot;Files to Transfer as ASCII Button&quot; or the drop-down list located to the right of the field. The drop-down list located to the right of this field will be dynamically populated with file types as they are set through the dialog box described above. They are also added to the list when you exit the field after manually editing the file types field. File types can then be specified by selecting them from this list. This provides a way to store and/or retrieve sets of file types for later use with other Jobs. Alternatively, clicking on the &quot;Files to Transfer as ASCII Button&quot; to the right of this field opens a dialog box into which file types may be entered. To add a File Type click &quot;New,&quot; then type the desired file type into the field located at the bottom of the dialog. These file types are set by specifying file extensions (i.e. &quot;.txt&quot;) which, if found within a file name, will be transferred as an ASCII file during synchronization. Multiple strings will be semicolon delimited. These settings are not case sensitive, (i.e. &quot;A&quot; = &quot;a&quot;). Repeat this process for each File type. Entries can be deleted by selecting them from the list and clicking the &quot;Delete&quot; key at the bottom of the box. Once you have finished, click the &quot;OK&quot; button. The box will close and all of the file types you have specified will automatically appear in the Files to transfer as ASCII field.</td>
</tr>
</tbody>
</table>

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit [http://www.peersoftware.com](http://www.peersoftware.com) or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit [http://www.peersoftware.com](http://www.peersoftware.com) or contact Sales for additional information.
Located to the right of the Source Folder Selection Field, this button opens a "Browse for Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it using the left mouse button, and click "OK."

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

<table>
<thead>
<tr>
<th><strong>Explore/Open/Create Source Button</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>This button provides three options to be selected from the attached drop-down list. The button label will change to reflect whichever item has been checked on this list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Explore</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When &quot;Explore&quot; has been selected and the button is depressed, an Explorer-type window will open displaying all available directories. By default, this window will show the folder whose path is currently designated in the Source Field. If the folder shown in this field does not exist, Profiler will display a dialog alerting you to this fact and asking if you would like to create it. You may do so by clicking the &quot;Yes&quot; button located at the bottom of this dialog. Once you have done so the newly created folder will be shown in the Explorer-type window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Open</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When &quot;Open&quot; has been selected and the button is depressed, a traditional MS navigation window is opened displaying the contents of whichever folder is currently shown in the Source Folder Field. If this folder does not exist, Profiler will display a dialog alerting you to this fact and asking if you would like to create it. You may do so by clicking the &quot;Yes&quot; button located at the bottom of this dialog. Once you have done so the newly created Folder will be shown in the navigation window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Create</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When &quot;Create&quot; has been selected and the button is depressed, a &quot;Select Directory&quot; dialog will open allowing you to specify a Source Folder path by using the mouse to select a desired drive, directory, and folder. Folder paths can also be manually entered into the &quot;Directory Name&quot; field. If you enter a path for a folder that does not exist and hit the ENTER key or click &quot;OK,&quot; a dialog box will appear allowing you to create this folder.</td>
</tr>
</tbody>
</table>

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

<table>
<thead>
<tr>
<th><strong>Source Folder Popup Menu: Using Normal Mode</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first four features allow the user to Browse for Source Folder, Explore, Open and/or Create the Source Folder selection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Configure: Source Folder</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting this option displays the Source Network Logon Settings window. This allows the user to specify Network Logon credentials for the Source Folder which enables connection to directories that are not accessible with the current logged on account.</td>
</tr>
<tr>
<td><strong>Edit: Source Variable File</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
</tr>
<tr>
<td><strong>Create Auto Job Name</strong></td>
</tr>
</tbody>
</table>

**Source Folder Popup Menu: Using TCP Mode**

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first two features allow the user to Explore and Open the Source Folder selection.

<table>
<thead>
<tr>
<th><strong>Configure: Source Folder</strong></th>
<th>Selecting this option displays the Source TCP/Port Configuration window. This window provides a guided method for entering the Source TCP path as well as TCP and/or Byte Replicator settings (see TCP Configuration).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Auto Job Name</strong></td>
<td>This feature allows a simple way to generate meaningful Job names. When selecting this item, Job names are automatically generated based on their Source and Target paths which make it a simple task to organize the Job list.</td>
</tr>
</tbody>
</table>

**Notes:**

1. The TCP features listed above require the TCP WAN Connector option. Please visit [http://www.peersoftware.com](http://www.peersoftware.com) or contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode.

**Source Folder Popup Menu: Using FTP Mode**

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first feature allows the user to Open the Source Folder selection.

<table>
<thead>
<tr>
<th><strong>Configure: Source Folder</strong></th>
<th>Selecting this option displays the Source TCP/Port Configuration window. This window provides a guided method for entering the Source TCP path as well as TCP and/or Byte Replicator settings (see TCP Configuration).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Auto Job Name</strong></td>
<td>This feature allows a simple way to generate meaningful Job names. When selecting this item, Job names are automatically generated based on their Source and Target paths which make it a simple task to organize the Job list.</td>
</tr>
</tbody>
</table>

**Notes:**

1. The FTP features listed above require the File Transfer Protocol (FTP) option. Please visit [http://www.](http://www.)
2. The Browse for Source Folder, Explore, and Create options are not available when using FTP Source Mode.

<table>
<thead>
<tr>
<th>Target Folder Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>The options listed on this page can be accessed from the Folder Selection window. The following options are available for selecting a Target folder.</td>
</tr>
</tbody>
</table>

| Using Normal Mode | Select a "Normal" Target folder if you can navigate to the desired Target directory via a Local Path, a UNC Path, or a Mapped Drive. This selection requires that the machine on which PeerSync is running has full access to the desired Target directory. In some instances Network Logon may be required. |

Select a Target Folder by typing the file path into the field provided or by using the Select Target Folder Button. By default, the Target Folder field will contain the path in which PeerSync has been installed: in most cases this will be C:\Program Files\PeerSync\Target. The convention outlined in this path must be used when manually typing entries, (i.e. a drive must be specified followed by a colon, with subsequent folders separated by backslashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

UNC names can be entered manually, or can be selected from the Network Neighborhood using the "Browse for Folder" dialog box (see Select Target Folder Button). UNC names will appear in the form \COMPUTER\SHAREDDEVICE\PATH. For example: \SERVER1\D\USERDATA

Note: We do not recommend using UNC paths for folders that reside on the local machine, in this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows Explorer into the Target Folder Field for automatic insertion.

The Target Folder Field holds a folder selection History of more then 10 entries. They can be selected by clicking on the drop down button located to the right of the field.

The current path will be displayed below the Target Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection field, the application will throw a message and use the default PeerSync installation path C:\Program Files\PeerSync\Target instead.
| Using TCP Mode | The Host Name and User Name & Password values (if provided) are displayed above the Target Folder Selection field (see Network Logon).

Select a "TCP" Target folder if the Target directory is outside the scope of the machine on which PeerSync is running. TCP enables access to machines not located on the same network as PeerSync. As a prerequisite, the PSListener needs to be installed and running on the remote Target machine in order for PeerSync to be able to communicate with it. This feature supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over the public Internet for security purposes. Otherwise, you should use our Encryption feature with a user name and password to protect data and all communication as it is being transferred.

When selecting the TCP Mode for the first time the Target TCP/Port Configuration window will open automatically for Target Folder configuration. Otherwise, the previously entered TCP folder path will be displayed. This path can be manually edited by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be used when manually typing entries, (i.e. the key word TCP must be specified followed by a colon, two backslashes, the Target IP address or machine name, and subsequent folders separated by backslashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

The Target Folder Field holds a folder selection History of more than 10 entries. They can be accessed by clicking on the drop down button located to the right of the field.

The current path will be displayed below the Target Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection field, the application will throw a message and use the last valid TCP path specified or the default path TCP:\\127.0.0.1\C\Target. 127.0.0.1 represents the loopback IP address of the local host (i.e. the machine on which PeerSync is running).

The provided Host Name and User Name & Password values are displayed above the Target Folder Selection field (see Configuration Button).

Using FTP Mode | Select an "FTP" Target folder to automatically logon to a Target FTP server. This feature supports proxy servers/firewalls and has an option to adjust for GMT time on the FTP
When selecting the FTP Mode for the first time the Target FTP Logon Configuration window will open automatically for Target Folder configuration. Otherwise, the previously entered FTP folder path will be displayed. This path can be manually edited by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be used when manually typing entries, (i.e. the key word FTP must be specified followed by a colon, two forward slashes, the Target IP address or machine name, and subsequent folders separated by forward slashes). This field is not case sensitive, though spaces may only be entered where they are part of valid folder names (i.e. “Program Files”). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.

The Target Folder Field holds a folder selection History of up to 10 entries. They can be accessed by clicking on the drop down button located to the right of the field.

The current path will be displayed bellow the Target Folder Selection Field. An invalid path will display a red INVALID SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection field, the application will throw a message and use the last valid FTP path specified.

The provided Host Name and User Name & Password values are displayed above the Target Folder Selection field (see Configuration Button).

Related Options
- Target Folder Configuration Button
- Select Target Folder Button
- Explore/Open/Create Button
- Target Folder Popup Menu
- Alternate Target Path Selection

Notes:

1. TCP (i.e. TCP WAN Connector Option) and FTP are optional modes which may not be included in your package. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP Target.

3. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.

4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the synchronization process (Source or Target).
Using Normal Mode

The Target Folder Configuration Button can be activated by clicking on the Configure button located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target Network Logon Settings window. Alternatively, you may right-click on the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu). This window allows for network logon Name and Password information for a remote Target connection.

Using TCP Mode

The Target Folder Configuration Button can be activated by clicking on the Configure button located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target TCP/Port Configuration window. Alternatively, you may right-click on the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).

TCP Configuration Tab

This window provides a guided method for entering the Target TCP path.

<table>
<thead>
<tr>
<th>Host Name</th>
<th>Enter the IP address or machine name of the Target folder into this field. You may use the machine name only if the remote Target machine resides on the same network as that on which PeerSync is running.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path to Host</td>
<td>Provide the full path (i.e. C:\Documents and Settings\Target) to the Target folder in this field. The path entered needs to be a local path without a machine name or UNC format. This field does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path does exist, PeerSync will create it during runtime as long as a valid host name or IP address has been provided and it can find the drive letter specified.</td>
</tr>
</tbody>
</table>

Care must be exercised if your PSLetter contains a "Root Path". If you specify such a path in your PSLetter it will behave like an FTP server that sets Root Paths to limit user access to the local file system. If a "Root Path" exists on the PSLetter it will limit PeerSync's ability to access directories on the remote device. PeerSync will only be able to access directories equal to or below the specified "Root Path" level provided that it meets the Port and Encryption requirements. In no circumstances can PeerSync access directories located above this path. If the remote path you enter in the Path to Host field references a directory above the "Root Path", PeerSync will create that folder structure at runtime below the "Root Path".

Example:

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host" = C:\Backup\My Documents
Actual Remote Target Path = C:\Backup\Users\Admin\C\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab
Provides settings to be used by both the Source and Target connections when using TCP and/or Byte Replicator.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Out</td>
<td>Sets the amount of time a connection will wait to complete a data transfer before exiting and performing the failure operation.</td>
</tr>
<tr>
<td>Port</td>
<td>This is the TCP Port used to communicate with the Listener on the remote machine. This must match the port number that the PSLListener is configured for. By default both Listener and PeerSync use port 7333. Note: The Profiler will not support Well Known Port numbers 0 - 1023. You must use port numbers that are greater than or equal to 1024.</td>
</tr>
<tr>
<td>Compression</td>
<td>Uses a lossless compression algorithm to transmit data in fewer bits. By default Compression is disabled to achieve faster performance.</td>
</tr>
<tr>
<td>User Information</td>
<td>This is an optional setting that allows you to specify a User Name and Password to be used for encryption as well as authentication purposes when connecting to the remote PSLListener. In order to activate encryption or authentication, you must specify both a User Name and a Password value. Strong DES encryption will be used to encrypt the data and communication as it is being transmitted over the Internet, LAN, WAN, or VPN. The User Name and Password entries can be arbitrarily chosen and are not required to be valid. However, once specified, you must enter the same User Name and Password entries in the PSLListener Configuration residing on the remote location. If you specify a User Name without a Password, the User Name entry will be ignored and no encryption or authentication with the PSLListener will occur.</td>
</tr>
</tbody>
</table>

Using FTP Mode

The Target Folder Configuration Button can be activated by clicking on the Configure button located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target FTP Configuration window. Alternatively, you may right-click on the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).
### FTP Configuration Tab
Provides a guided method for entering the Target FTP path as well as connection authentication.

<table>
<thead>
<tr>
<th><strong>Host Name</strong></th>
<th>Enter the IP address or machine name of the Target folder into this field. You may use the machine name only if the FTP Target machine resides on the same network as that on which PeerSync is running.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Path to Host</strong></td>
<td>Provide the full path to the Target folder in this field (i.e. <code>/FTProot/My Data/Target</code>). Make sure the path begins at the base directory to which the FTP server allows connection. The path does not need to be preceded by the key phrase ‘FTP’ however it must start with a forward slash ( <code>/ </code>). This field does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path does exist, PeerSync will create it during run time as long as a valid host name or IP address has been provided.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Stores the Target FTP User Name information for login.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Stores the Target FTP Password information for login.</td>
</tr>
</tbody>
</table>

### FTP Settings Tab
Provides configuration for the FTP Target selection.

| **Enable Passive Mode** | Sets the FTP mode to passive. The phrase passive refers to the FTP server which passively accepts connections and data while the client initiates both the control connection and the data connection to random ports specified by the server. Passive mode is enabled by default. |
| **Host is using GMT** | Option to adjust for GMT time on the FTP server side. |
| **Time Out (seconds)** | Sets the amount of time a connection will wait to complete a data transfer before exiting and performing the failure operation. |
| **Port** | Port number used to initiate an FTP session or "command" connection to the FTP server. Uses standard port 21 by default. |
| **Use Proxy - Firewall** | This option allows you to specify the Host Name, User ID, Password, and Port number to a network Proxy - Firewall. |
| **File types to transfer as ASCII** | Through this field, file types can be selectively tagged for transfer as ASCII upon synchronization. File types can be typed manually, or can be specified using either the "Files to Transfer as ASCII Button" or the drop-down list located to the right of the field. The drop-down list located to the right of this field will be dynamically populated with file types as they are set through the dialog box described above. They are also added to the list when you exit the field after manually editing.
the file types field. File types can then be specified by selecting them from this list. This provides a way to store and/or retrieve sets of file types for later use with other Jobs.

Alternatively, clicking on the "Files to Transfer as ASCII Button" to the right of this field opens a dialog box into which file types may be entered. To add a File Type click "New," then type the desired file type into the field located at the bottom of the dialog. These file types are set by specifying file extensions (i.e. ".txt") which, if found within a file name, will be transferred as an ASCII file during synchronization. Multiple strings will be semicolon delimited. These settings are not case sensitive, (i.e. "A" = "a"). Repeat this process for each File type. Entries can be deleted by selecting them from the list and clicking the "Delete" key at the bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the file types you have specified will automatically appear in the Files to transfer as ASCII field.

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for Folder" dialog box: once this box has opened, locate your chosen Target folder, select it using the left mouse button, and click "OK."

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Explore/Open/Create Target Button

This button provides three options to be selected from the attached drop-down list. The button label will change to reflect whichever item has been checked on this list.

<table>
<thead>
<tr>
<th>Explore</th>
<th>When &quot;Explore&quot; has been selected and the button is depressed, an Explorer-type window will open displaying all available directories. By default, this window will show the folder whose path is currently designated in the Target field. If the folder shown in this field does not exist, Profiler will display a dialog alerting you to this fact and asking if you would like to create it. You can do so by clicking the &quot;Yes&quot; button located at the bottom of this dialog. Once you have done so, the newly created folder will be shown in the Explorer-type tree.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>When &quot;Open&quot; has been selected and the button is depressed, a traditional MS navigation window is opened displaying the contents of whichever folder is currently shown in the Target Folder Field. If this folder does not exist, Profiler will display a</td>
</tr>
</tbody>
</table>
dialog alerting you to this fact and asking if you would like to create it; you can do so by clicking "Yes" button located at the bottom of this dialog. Once you have done so the newly created Folder will be shown in the navigation window.

Create

When "Create" has been selected and the button is depressed, a "Select Directory" dialog will open allowing you to specify a Target Folder path by using the mouse to select a desired drive, directory, and folder (See image in "Source Folder Selection" topic above). Folder paths can also be manually entered into the "Directory Name" field. If you enter a path for a folder that does not exist and hit the ENTER key or click "OK," a dialog box will appear allowing you to create this folder.

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Target Folder Popup Menu: Using Normal Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The first four features allow the user to Browse for Target Folder, Explore, Open and/or Create the Target Folder selection.

Configure: Target Folder

Selecting this option displays the Target Network Logon Settings window. This allows the user to specify Network Logon credentials for the Target Folder which enables connection to directories that are not accessible with the current logged on account.

Edit: Target Variable File

This will allow the user to view/edit Variable Data Import and/or Job Data Import files that are used in the Target Folder selection. This option is only available if using Job data import files.

Create Auto Job Name

This feature allows a simple way to generate meaningful Job names. When selecting this item, Job names are automatically generated based on their Source and Target paths which make it a simple task to organize the Job list.

Set Alternate/Additional Targets

Selecting this menu item will open the Alternate/Additional Targets selection window. This feature allows for alternate or additional Target paths associated with the base Job.

Force Source Folder Root as Target Folder Root

Appends the Source folder directory to the Target folder path.

Target Folder Popup Menu: Using TCP Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The first two features allow the user to Explore and Open the Target Folder selection.
Configure: Target Folder

Selecting this option displays the Target TCP/Port Configuration window. This window provides a guided method for entering the Target TCP path as well as TCP and/or Byte Replicator settings (see TCP Configuration).

Create Auto Job Name

This feature allows a simple way to generate meaningful Job names. When selecting this item, Job names are automatically generated based on their Source and Target paths which make it a simple task to organize the Job list.

Force Source Folder Root as Target Folder Root

Appends the Source folder directory to the Target folder path.

1. The TCP features listed above require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.

3. The Browse, Explore, Create, and Set Alternate/Additional Target options are not available when using TCP and FTP Target Modes.

This link will be enabled if you are using a Normal Target Mode Selection. By selecting this link you can set and access your current Alternate Target Path Selections. Through this feature, Jobs can now have alternate or additional Target paths associated with the base Job. This allows for the ability to redirect data on a failed connection to the base Target and/
or easily setup, one-to-many scenarios for distribution purposes. Selecting this menu item will open the Alternate Target Path Selection dialog.

To add an alternate or additional Target click "New," then type the desired path into the field located at the bottom of the dialog or select the "Browse" button to select a path. Repeat this process for each Target path you wish to add. Entries can be deleted by selecting them from the list and clicking the "Delete" key at the bottom of the box. You can also use the "Up" and "Down" buttons to reorder the paths.

Notes:

1. This feature requires the Enhanced Package.
2. Alternate Target Path Selection is not available for TCP or FTP Target Mode Selections.
3. When using Alternate Target Path Selections you cannot use variables that are specific to the Job (i.e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be synchronized to the Target.

This button reverses placement of the file paths shown in the Source and Target Folder Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice versa).

Represents the date/time the last scan started for the selected Job. This is the date/time of the last bi-directional synchronization scan of a Job that will be used when comparing files during the Bi-directional Synchronization Mode option on the File Options screen. This feature is also displayed and can be reset from the Profile Job List Pop-Up Menu.

Represents the date/time and user when the selected Job was last saved.

This section describes additional features related to the Folder Selection topic. The features below apply to both the Source and Target folder selections and related configuration options.

Related Options

- File/Folder Path Variables
- Variable Data Import
- Job Data Import
- Dynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

1. Dynamic archives for yearly, monthly, weekly and/or daily backups
2. Dynamic synchronization based on date
3. Dynamic synchronization based on logged on user or machine name
4. Dynamic synchronization based on personal folders or other variables read in from the registry
5. Log file storage, manipulation and organization
6. Administrative report file storage, manipulation and organization
7. Deleted file storage, manipulation and organization
### File/Folder Path Variables

Depending upon the argument used, these folders will be dated, named after the currently logged user, named for the PC from which synchronization was launched, or based on a pre-determined variable stored out and read in from the registry. The following variables can be used in any folder path Job setting available through the Profiler:

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>%Date%</td>
</tr>
<tr>
<td>Time</td>
<td>%Time%</td>
</tr>
<tr>
<td>Date/Time</td>
<td>%DateTime%</td>
</tr>
<tr>
<td>Minute</td>
<td>%Minute%</td>
</tr>
<tr>
<td>Hour</td>
<td>%Hour%</td>
</tr>
<tr>
<td>Day</td>
<td>%Day%</td>
</tr>
<tr>
<td>Year</td>
<td>%Year%</td>
</tr>
<tr>
<td>Month/Year</td>
<td>%MonthYear%</td>
</tr>
<tr>
<td>Minute (all formats)</td>
<td>%n, nn%</td>
</tr>
<tr>
<td>Hour (all formats)</td>
<td>%h, hh%</td>
</tr>
<tr>
<td>Day (all formats)</td>
<td>%d, dd, ddd, ddddd, dddddd%</td>
</tr>
<tr>
<td>Month (all formats)</td>
<td>%m, mm, mmm, mmmm%</td>
</tr>
<tr>
<td>Year (all formats)</td>
<td>%y, yy%</td>
</tr>
</tbody>
</table>

### Custom Peer Variables

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logged On User Name</td>
<td>%UserName%</td>
</tr>
<tr>
<td>Computer Name</td>
<td>%ComputerName%</td>
</tr>
<tr>
<td>Job Name</td>
<td>%JobName%</td>
</tr>
<tr>
<td>Source Folder Path</td>
<td>%SourcePath%</td>
</tr>
<tr>
<td>Target Folder Path</td>
<td>%TargetPath%</td>
</tr>
<tr>
<td>Deletion Folder Path</td>
<td>%DeletePath%</td>
</tr>
<tr>
<td>Report File Path</td>
<td>%ReportPath%</td>
</tr>
</tbody>
</table>

### Windows Variables

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Directory</td>
<td>%WinDir%</td>
</tr>
<tr>
<td>Windows</td>
<td>%Windows% (also %SystemRoot%)</td>
</tr>
<tr>
<td>System Temp Path</td>
<td>%Temp%</td>
</tr>
<tr>
<td>System Temp Path</td>
<td>%Tmp%</td>
</tr>
<tr>
<td>System Drive Letter</td>
<td>%SystemDrive%</td>
</tr>
<tr>
<td>System 32 (WIN 9x/NT/00)</td>
<td>%System32%</td>
</tr>
</tbody>
</table>
### Windows Variables from the "HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders" Registry

<table>
<thead>
<tr>
<th>Desktop</th>
<th>%Desktop%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites</td>
<td>%Favorites%</td>
</tr>
<tr>
<td>Fonts</td>
<td>%Fonts%</td>
</tr>
<tr>
<td>Personal</td>
<td>%Personal%</td>
</tr>
<tr>
<td>Programs</td>
<td>%Programs%</td>
</tr>
<tr>
<td>Recent</td>
<td>%Recent%</td>
</tr>
<tr>
<td>SendTo</td>
<td>%SendTo%</td>
</tr>
<tr>
<td>Start Menu</td>
<td>%Start Menu%</td>
</tr>
<tr>
<td>Startup</td>
<td>%Startup%</td>
</tr>
<tr>
<td>Templates</td>
<td>%Templates%</td>
</tr>
</tbody>
</table>

**Notes:**

You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:

- HKEY_CURRENT_USER\Environment (used by default default)
- HKEY_CURRENT_USER\Volatile Environment (used by default)

The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows:

```
[Misc Options]
RegVarStr=\Environment;\Volatile Environment;
```

In addition, the `%USERPROFILE%` Environmental Variable is now also supported.

Use the variable `%Personal%` to define the "My Documents" folder in Profiles that will be used on multiple operating systems such as XP and Windows 7. Since the location of the My Documents folder is different on these operating systems, using the `%Personal%` variable will dynamically resolve to the correct location on each system. This simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.

Note for PeerSync Jobs linked to PeerLock: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.

PeerSync now contains tools for importing data from files. The ability to extract specific fields of data from a file has been included to allow unlimited scalability. Within an organization, one generic Profile can now be created, and utilizing text files, specific information about the user and the desired folders to be synchronized can be imported dynamically. Variables can be used to dynamically introduce data from a file into various fields throughout the interface including file paths, deletion paths, log file paths, log file names, etc.

Field data is imported through:

```
<<<#FileName.txt [section] item#>>>
```

In which the [section] is a defined field in a file, such as the example file content below.
Using "<<#FileName.txt [Info] Name#>>" will import "Cris Smith" into the path it was used in and using "<<#FileName.txt [Info] Home#>>" will import "c:\mydocuments" into the path it was used in.

Note: This feature requires the Enhanced Package.

PeerSync now contains tools for importing data from files to dynamically create Jobs. Within an organization, one generic Profile can now be created, and utilizing text files, specific information about the user and the desired folders to be synchronized can be imported dynamically. Lists can be used in Source and Target path names as such:

Source: "<<$FileNameSources.txt$>>"
Target: "<<$FileNameTargets.txt$>>"

or:

Source: "<<C:\Path\To\File\FileNameSources.txt$>>"
Target: "<<C:\Path\To\File\FileNameTargets.txt$>>"

Corresponding entries of each delimited file entry will be used to dynamically create a Job based upon the Jobs properties.

Note: This feature requires the Enhanced Package.

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder selection. The way you do this is to add a letter to the beginning of the UNC path that you wish to map the drive to. This can be done for the Source or Target selection (i.e. n:\COMPUTER\SHAREDDEVICE\PATH).

For Example: n\DELLSERVER\D\USERDATA

The example above will map the D drive on the DELLSERVER to the N drive upon start of PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature especially when running PeerSync as a service in the scenario where you want to synchronize to a mapped drive. This feature will allow for it to occur seamlessly.

Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of using mapped drives due to the fact that mapped drives are not understood when a user is not logged on.

Next/Last Available Drive Mapping

This feature allows for the dynamic mapping of the next (A) or last (B) available network drive by using the following format in the Source or Target Fields:
Local Drive Mapping

This feature allows for the dynamic mapping of a local drive by using the following format in the Source or Target Fields:

Map Next Available Example: A\COMPUTER\SHAREDDEVICE\PATH
Map Last Available Example: B\COMPUTER\SHAREDDEVICE\PATH

1.1.2 Automation

The Automation screen allows you to apply Real-Time Monitored or Scheduled synchronization to individual Jobs within a given Profile. Real-Time operations (also referred to as "File/Folder Change Detection") monitor Source Folders for any changes and synchronize them to the specified Target as they occur. Scheduled operations automatically launch synchronization according to a user-specified schedule. Through these settings, PeerSync allows you to build a Profile with as many as 255 different Jobs -- each run according to a unique schedule or in Real-Time (Also see Command Line Arguments for Global Automation Settings).
The options listed on this page can be accessed from the Automation window. This screen allows the user to set the frequency of scans as well as enable Real-Time replication.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Job Once at Start</strong></td>
<td>This feature directs PeerSync to run the current Job as an Automatic Operation. An Automatic Operation allows you to perform an immediate launch of the current Profile. As a non-persistent process, Automatic Operations are run a single time upon manual initiation by the user. We also refer to this type of run as an Initial Sync.</td>
</tr>
<tr>
<td><strong>Scan Job every x minute(s)</strong></td>
<td>Checking this feature assigns a Scheduled operation to the selected Job(s). The field associated with this feature allows you to set an interval in minutes: after this time has elapsed the selected folders will be synchronized. 5 minutes is the default setting. Intervals in seconds can be specified through the use of decimals, (i.e. 0.5, 2.5, etc.); the minimum interval is 0.01.</td>
</tr>
<tr>
<td><strong>Scan Job at x</strong></td>
<td>Checking this feature will allow for the synchronization of Jobs at a specific times of the day for selected days of the week. When selected the Daily Timer Options dialog will appear with the following options:</td>
</tr>
<tr>
<td>Run selected Jobs at</td>
<td>Available from the &quot;Daily Timer Options&quot; dialog opened by clicking on the button to the right of the &quot;Scan Job at&quot; field. Selecting this feature will run the Job at the selected time of day.</td>
</tr>
<tr>
<td>List of Job Selections</td>
<td>Available from the &quot;Daily Timer Options&quot; dialog opened by clicking on the button to the right of the &quot;Scan Job at&quot; field. This is a list of the currently selected Daily Timer selections. You can Add New selections by selecting the New button and Delete existing selections by selecting the Delete button.</td>
</tr>
<tr>
<td>Select days of week to run</td>
<td>Available from the &quot;Daily Timer Options&quot; dialog opened by clicking on the button to the right of the &quot;Scan Job at&quot; field. Allows you to turn on/off which days to run this schedule.</td>
</tr>
<tr>
<td>Selection Options</td>
<td>Available from the &quot;Daily Timer Options&quot; dialog opened by clicking on the button to the right of the &quot;Scan Job at&quot; field. This feature will give you the option to run the selected daily timer schedules in a Recurring mode (synchronization will run every time according to the set scheduled options) or Run Once (synchronization will run only once).</td>
</tr>
<tr>
<td><strong>Use Enhanced Scanning</strong></td>
<td>The Enhanced Scanning option is required for this feature to be enabled. Enhanced Scanning provides the ability to build multiple dynamic Jobs for parallel processing of folders during scans. This will significantly improve the time PeerSync takes to scan through directories. By default PeerSync scans through</td>
</tr>
</tbody>
</table>
a Job sequentially, one folder at a time. With the Enhanced Scan option enabled PeerSync will spawn a Job Thread for each folder or subfolder encountered during a scan.

When the Use Enhanced Scanning checkbox on the Automation window is checked the Enhanced Scanning dialog will open. By default the slider in the Enhanced Scanning dialog is set to the Off position all the way to the left side. To enable the Enhanced Scan feature move the slider to the right. Each slide position represents a depth level of 1, 2, 3, 4, and 5 respectively. Each value represents the depth level at which PeerSync will spawn a Job thread for each folder it encounters.

Example:

If you set the Enhanced Scanning slider to Level 3, then PeerSync will spawn 7 dynamic Jobs for the Users directory depicted bellow. It will in essence create a dynamic Job for each of the folders at Level 3 (Folder1, Folder2, Folder3, and Folder4). It will then create a Job for the folders at Level 2 (Users1 and User2) but will exclude all their subfolders. Lastly, it will create a Job for the directory at Level 1 (Users) and exclude all the subfolders.

Notes:

1. The Enhanced Scanning and the Multi-Threading add-on options are required for this feature. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. When using this option be sure you make available a large pull of Job Threads to be used by PeerSync so that dynamic Jobs can be created for each folder during a scan.

3. This feature is not supported when using FTP source or target modes.

4. This feature is not supported when using the Enhanced Bi-directional option.
The options listed on this page can be accessed from the **Automation** window. This screen allows the user to set the frequency of scans as well as enable Real-Time replication.

<table>
<thead>
<tr>
<th><strong>Use Real-Time Monitoring</strong></th>
<th>Selects the current Job(s) for Real-Time Monitoring.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Real-Time Options...</strong></td>
<td>This button opens an &quot;Additional Options&quot; dialog box. Once this box has opened, it allows you to choose from two Real-Time operations. The first is a Folder Replication feature, which monitors for changes to the Source Folder and synchronizes the Target accordingly. The second, a Folder Restoration feature, monitors for changes to the Target Folder and restores files on the Target accordingly. To properly use the restore feature, you will need to select the &quot;Always overwrite Target files&quot; option.</td>
</tr>
</tbody>
</table>

Notes:

1. **Bi-directional** will be ignored for Real-Time Jobs.

2. When synchronizing to an **FTP** Target, PeerSync will suppress Real-Time Jobs until initial synchronization has completed.

**Enhanced Real-Time Monitoring**

This feature allows the Real-Time feature in PeerSync to detect individual changes to files and synchronize only the file which has changed without scanning the entire folder where the change occurred. Normally, synchronization software scans and compares all files into a folder which is being synchronized. This feature does not scan folders unless the change is indeterminate. If a file or folder is renamed, PeerSync will rename the corresponding Target File or folder using rename functions as opposed to copying the newly renamed Source Folder to the Target and then subsequently deleting the outdated Target file/folder. This feature greatly reduces the time required to synchronize files and also reduces network bandwidth requirements.

With this option enabled PeerSync will continue to detect real-time events even during a scan.

Notes:

1. **Bi-directional** During comparison subtract/ add x minute(s) from Target, and **Trigger Selections**, as well as, other non applicable features may be ignored during Enhanced Real-Time.

2. It is recommended either use the Enhanced Real-Time option for all or none of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file output format for all modes of reporting and message logging (**Reporting**, **Admin Reporting** and
Email Reporting). The output will NOT contain a start and stop section or a summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Admin or Email reporting then the standard selection will be used. The reason this is done is due to the fact that processes will be running in parallel.

Use Standard Real-Time Monitoring

When the Real-Time feature detects a change to synchronize, this method will cause a scan to run on the root folder, but not the subfolders. For folder manipulations such as renames, the entire folder including its subfolders will be scanned.

Global Settings
See Source Folder Global Options.
What happens if PeerSync is performing a scan when it enters the Blackout period?
If the option to "Suspend active scans when a Blackout period starts" is enabled the scan will be suspended and resumed at the point it was left off after the Blackout period ends. If this option is not enabled, the scan will be stopped during the Blackout period and will be restarted from the beginning after the Blackout period ends.

What happens if PeerSync was in the middle of transferring a large file when it entered the Blackout period?
PeerSync will allow the transfer to complete but suspend any new events from being processed until the Blackout period ends. The suspended events or scans will be processed after the Blackout period ends.

What happens if a scan is scheduled to run during the Blackout period?
Regardless if the option to "Suspend active scans when a Blackout period starts" is enabled the scan that is scheduled to run during the Blackout period will run after the Blackout period ends. Multiple suspended scans for a single Job will be compiled into a single scan that will run at the end of the Blackout period.

1.1.4 Scan Limitations

Scan Limitations
- Maximum Duration of Scans
  - Set maximum duration of scans to 120 minutes

Initiate Scan on Trigger File Change
- Use Trigger Files
  - Default: GLBLCHG.000
  - Source Trigger File:
  - Target Trigger File:

Topics
- Maximum Duration of Scans
- Initiate Scan on Trigger File Change

Note: Features listed on this page require the Enhanced Package.

Enabling the Set maximum duration to x minutes option allows you to specify a maximum duration for each Job. This gives you the ability to limit the run time of a Job during initial, interval, and scheduled scans.
**Trigger Files**

These settings ensure that the Target Folders always remain updated to their corresponding Source by comparing dates indicated by individual Trigger Files. For example, if a Source Trigger is found to be newer than a corresponding Target Trigger, a synchronization process will be allowed to proceed for the selected Job(s). If the files date and time stamps match then the synchronization will not be processed. Therefore, the run of the sync process is in essence, determined by the trigger files.

<table>
<thead>
<tr>
<th>Trigger Files</th>
<th>Use Trigger Files</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This feature is used to activate or trigger synchronization based upon date comparison between an individual Source Trigger File and a separate Target Trigger File. If the Target Trigger File is older then the Source Trigger File, the entire Source Folder(s) will be synchronized.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default File Name</th>
<th>Displays the Default Global Trigger File Name: GLBC HG.000</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Source Trigger File</th>
<th>This field allows you to specify a Global Trigger File by entering it manually, or by selecting it using the browse button located at the right side of the field.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Use Current Paths</th>
<th>Automatically selects the current Trigger Files associated with the Source and Target Folders.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Target Trigger File</th>
<th>This field allows you to specify a Global Trigger File by entering it manually, or by selecting it using the browse button located at the right side of the field.</th>
</tr>
</thead>
</table>

**Note:** During Enhanced Real-Time, Trigger Selections will be ignored.
1.1.5 File Options

File Options

Mode Selection

- **Standard (update target files if source is newer)**
- **Always overwrite (update target files if source is newer or older)**
- **Bi-directional (both directions)**

Event Options

- **Add - synchronize new files**
- **Update - synchronize existing files**
- **Replicate - Delete unmatched files**

Deleteon Folder

- **Move deleted files to an alternate location**

Topics

- **Mode Selection**
- **Event Options**

---

**Mode Selection**

The options listed on this page can be accessed from the File Options window.

**Standard (update target files if source is newer)**

With this mode selection, PeerSync will update files on the Target only if the Source is newer.

**Always overwrite (update target files if the Source is newer or older)**

This feature automatically overwrites any files in the Target Folder that have a different date/time stamp than their corresponding Source File, even if the Target File is newer. This feature can be used to restore folders to a previous state either for backup/restore operations or to reset files after training operations.

**Bi-directional (both directions)**

With this feature selected, PeerSync will merge the data of the Source and the Target folders during Scan at Start, interval and scheduled scans. This feature may be ignored during Real-Time and Enhanced Real-Time modes. The following will happen when this feature is selected with the Replicate - Delete unmatched files/folders option enabled:

If a File exists in both Source and Target Folders, PeerSync will compare the Modified date/time of the files and update/overwrite the older file with the newer file. If the modified date/time is identical PeerSync will not perform any action.
If a File exists in only the Source or Target Folder
PeerSync will compare the Modified, Created and Accessed date/time of the file with the stored Last Run On date/time of the Job. If any of the three file date/times are newer than the stored Last Run On date/time the file will be added, otherwise the file will be deleted.

If a Sub-Folder exists in only the Source or Target Folder
The Source will be seen as the primary folder and any sub-folders with content existing on the Source will be added to the Target. If the folder is empty or exists on the Target, PeerSync will compare the Modified, Created and Accessed date/time of the folder with the stored Last Run On date/time of the Job. If any of the folder date/times are newer than the stored Last Run On date/time the folder and all of its contents will be added, otherwise the folder will be deleted.

Note:
PeerSync now also supports real-time or scheduled bi-directional replication using our TCP replication mode. To achieve real-time bi-directional replication across TCP, PeerSync and PSListener would need to be installed on both the Source and the Target machines. For scheduled bi-directional replication across TCP, PeerSync would need to be installed on one side, while the PSListener on the other. This feature is not supported when using a TCP or FTP Target.

Related Options
Global Bi-directional Options

Notes:
1. The Bi-directional feature is only supported when working with a Normal Source and a Normal or TCP Target.
2. The Bi-directional feature may be ignored when using FTP Source or Target.
3. The Bi-directional feature may be ignored when using TCP Source.
4. The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.
5. The Bi-directional feature may be ignored when using Compression.
6. Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for up to one day, even if you delete a file from the Source or Target.
7. Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional mode.

Event Options
The options listed on this page can be accessed from the File Options window.
Add - synchronize If the Source contains files not found within the Target and this
new files to Target feature is selected, those files will be added to the Target Folder during synchronization. This feature is selected by default.

Update - synchronize existing files in Target If this feature is selected, Target Folder files which are also found within the Source will be updated to match those Source files during synchronization. This feature is selected by default.

Replicate - Delete unmatched files If this feature is selected, any unmatched files found in Target Folders will be deleted automatically.

CAUTION: Use this feature carefully. If not configured properly, needed files may be permanently deleted. A deletion warning is NOT displayed by default: Profiler must be first set to display this warning through the "Deletion Warning Message" check box.

Related Options

- Deletion Options
- Move Options

Note: The Replicate feature may be ignored when using Compression.

Delete Options

The options listed on this page can be accessed by clicking on the Deletion Options button from the File Options window. Once the Replicate - Delete unmatched files option is turned on the Deletion Options button will be enabled for further configuration. Clicking on the Deletion Options button opens the "Additional Options" dialog box which contains the following features:

Deletion Warning Message The upper section of this screen allows you to enable or disable a Deletion Warning Message, as well as set the number of seconds for which a Message will be displayed. (a message is NOT enabled by default and is not available during Enhanced Real-Time). In addition, you can also choose to display a message requiring manual intervention in order to activate deletions.

Move Options

By clicking on the Move Options button in the File Options window you will be able to access the Move Deleted Files File Options dialog which has the following settings available:

Move Deleted Files Options This section provides a field where the user can designate an alternate folder to which unmatched files will be moved in order to avoid permanent deletion. This folder path can be typed manually, or selected using the browse button provided to the right of the field. If the designated folder exists, all unmatched files will be moved there, allowing you the opportunity to recover files deleted from the Target. This field also supports
**File/Folder Path Variables** and when used, the current path will be displayed above the field. Beneath this field are path options.

We strongly recommend using a Deletion Folder that is located on the Target host computer. Relocation to an alternate drive or host adds unnecessary processing and bandwidth overhead. For this reason PeerSync uses the following Deletion Folder variables:

- **%TARGETROOT%**
  This variable resolves to the root directory of the target path. For example if the target path is `\machine1\c$\Target\Docs`, the deletions path `%TARGETROOT%\Deletions` will resolve to `\machine1\c$\Deletions`. This variable is used by default.

- **%TARGETPARENT%**
  This variable resolves to the parent directory of the target path. For example if the target path is `\machine1\c$\Target\Docs`, the deletions path `%TARGETPARENT%\Deletions` will resolve to `\machine1\c$\Target\Deletions`.

### Relative Paths
This feature will move files deleted by PeerSync from the root folder to the root of the selected folder. Files deleted from subfolders will be moved to corresponding subfolders below the root selected deletion folder. This feature is intended (works best) for a Profile with a single Job.

**Example:**

- **Source Folder:** `C:\MyDocs\Files\`
- **Target Folder:** `D:\MyDocs\Files\`
- **Move Path:** `C:\DeleteFolder\`

  If you delete: `C:\MyDocs\Files\Subl\File.txt`
  PeerSync will move: `D:\MyDocs\Files\Subl\File.txt`
  **To:** `C:\DeleteFolder\Subl\File.txt`

### Preserve Paths
This feature will recreate the original path of the deleted file under the specified path. Therefore, a file deleted by PeerSync will be moved into a folder that corresponds to the file’s original location: under the selected deletion folder. This feature is intended (works best) for a Profile with Multiple Jobs.

**Example:**

- **Source Folder:** `C:\MyDocs\Files\`
- **Target Folder:** `D:\MyDocs\Files\`
- **Move Path:** `C:\DeleteFolder\`

  If you delete: `C:\MyDocs\Files\Subl\File.txt`
  PeerSync will move: `D:\MyDocs\Files\Subl\File.txt`
  **To:** `C:\DeleteFolder\D\MyDocs\Files\Subl\File.txt`

### Use Recycle Bin
This feature allows you to specify the Windows Recycle Bin as...
| Delete unmatched Target Files older than x days | This feature is intended for the cleanup of files that were candidates for deletion but were selected to be moved to an unmatched folder. By use of this feature, PeerSync can be used to temporarily store files setup for deletion and then have the files deleted after a specified number of days. By default deletion folders are checked every 24 hours or immediately after the initial scan (if Scan Job Once at Start is enabled). This interval can be modified by using the /LH:n argument where n is represented in minutes. |

Notes:

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete unwanted files or use the **Delete unmatched Target Files older than x days** option.

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will be permanently deleted.

4. When synchronizing to an **FTP Target**, the **Move unmatched Target Files** option is not available.

5. When using **Compression**, the **Move unmatched Target Files** option is not available.

6. The Deletion Warning Message option is not available during **Enhanced Real-Time**.

7. When using the **Alternate Target Path Selections** feature you cannot use variables that are specific to the Job (i.e. %JobName%, %SourcePath%, etc.) for the **Move unmatched Target Files** option.
### 1.1.6 Open Files

**Open Files**
- **Include open files** (allow read and write access to source file during transfer)
- **Include open files** (allow read access to source file during transfer)
- **Exclude open files** (allow read access to source file during transfer)
- **Exclude open files** (deny all access to source file during transfer)

**Open/Locked Files**
- To configure options for Open/Locked Files click here: [Managed Files](#)

**Related Global Settings**
- To set Global Recovery/Offline Options click here: [Global Settings](#)

---

**Topics**
- Open Files Overview
- Managed Files
- Global Settings

---

#### Open Files

The options listed on this page can be accessed from the Open Files window.

| **Include open files** (allow read & write access to source file during transfer) | Use this option when you want to include open files and allow users to modify them while they are being transferred. For locked files such as database files, PeerSync will first attempt to process them using the Managed Files setting if enabled. If this process is not enabled or fails, locked files will be retried based on the retry open/inaccessible files setting. **Note:** If PeerSync is able to synchronize files which are in use by other applications, access to those applications may in certain instances be temporarily lost during synchronization. |
|---|
| **Include open files** (allow read access to source file during transfer) | Use this option when you want to include files that are open for read-only access. Users will be able to open source files for read-only access while they are being transferred. For files that are being modified or are locked PeerSync will first attempt to process them using the Managed Files setting if enabled. If this process is not enabled or fails, these files will be retried based on the retry open/inaccessible files setting. |
| **Exclude open files** (allow read access to source file during transfer) | Use this option when you want to replicate only files that are closed. Files that are opened or locked will be retried based |
source file during transfer) on the `retry_open/inaccessible_files` setting. Users will be denied write access to source files that are being transferred but may have the option to open them in read-only mode.

We recommend you use this option when doing replication/collaboration from one source to multiple destinations. This option allows PeerSync to replicate files from one source to multiple destinations, in parallel, while at the same time protecting the source files from write access during their transfer.

Exclude open files (deny all access to source file during transfer) Use this option when you want to replicate only files that are closed. Files that are opened or locked will be retried based on the `retry_open/inaccessible_files` setting. Users will be denied complete access to the source files that are being transferred.

We recommend you use this option when doing real-time bi-directional synchronization/collaboration between two hosts. For collaboration between more than two machines we recommend you use the Exclude open files (allow read access to source file during transfer) option.

**Related Options**

- Managed Files
- Global Settings

Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the Managed Files setting to use VSS, locked files will be retried based on the `retry_open/inaccessible_files` setting.
1.1.7 Managed Files

Managed Files

| Enable Managed File Access (Source Files Only) |

Note:
Files that are synchronized via Managed Files will be processed after the "Scan Job once at start" option (if enabled) and on a specified Global interval for the Profile.

The Global interval to process files is set to 120 minutes and can be modified by clicking the link below.

Managed Files Options

- Synchronize open/locked files via Managed Files
- Synchronize ALL files via Managed Files (including files that are not open/locked)

Related Global Settings

- To set Global Managed Files Options click here Global Settings

Note: Features listed on this page require the VSS option.

Managed Files

The options listed on this page can be accessed from the Managed Files window.

| Enable Managed File Access (Source Files Only) | Enabling this option will allow you to reliably backup open and locked files while users continue to work on them. For this feature to be available you will require the Volume Shadow Copy Service (VSS) add-on module. This technology has been integrated with PeerSync to allow synchronization of critical data such as system files and databases. By default this feature is enabled at the end of a manual synchronization and is run every 2 hours during persistent (Real-Time or scheduled) modes. This interval can be modified from the Global Settings screen via the Global Managed Files Options link to a minimum interval of 30 minutes. For more features on configuring this option please view the Managed Files Arguments. |
| Synchronize open/locked files via Managed Files | Through the use of this feature PeerSync will enable processing of the Open and Locked Files from the local machine, through the use of the Volume Shadow Copy Service (VSS) technology. Please note VSS will delay processing of files to the specified interval. VSS is an add-on module. |
Synchronize ALL files via Managed Files (including files that are not open/locked)

Through the use of this feature, you can force PeerSync to send all the file processing through the Volume Shadow Copy Service (VSS) technology. Please note VSS will delay processing of files to the specified interval. VSS is an add-on module.

Related Options

Global Settings

Notes:

1. These options require the VSS add-on module. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. This feature only works for local Source folders and will be ignored with an FTP Source.

3. This feature may be ignored when using an FTP Target in conjunction with File Compression.

4. This feature may be ignored when using Folder Compression.

1.1.8 Performance

Performance Options

The options listed on this page can be accessed from the Performance window.

File Read/Write

This feature allows you to change the read/write buffer sizes to
| Buffer Size | optimize performance/speed across various network environments or on the local machine. In most cases this will increase performance dramatically but you will probably need to test this feature in your environment to determine what advantages can be gained from altering this size.

The minimum value is 256 bytes.
The default value is 64 KB.
The maximum value that can be set using the track bar is 128 KB.
The maximum value that can be set using the up arrow or by manually typing in the spin edit field is 128 KB. |
| Buffer Size Upper Limit (* Multi Threading Option) | A higher upper limit of 1 MB is available with the Multi Threading Option option. This value can be set using the up arrow or by manually typing a set value into the spin edit field.

Note: This option may be internally set to a maximum value when using an FTP Source or Target. |
| Throttle bandwidth - Use x percent of available bandwidth | This feature is designed to limit or slow down the pulse of reads and writes performed by PeerSync, at the percentage specified, in order to keep bandwidth available for other applications to use. This is done at the file level and is performed by each Copy Thread during the transfer of each file. As we copy a file we track how long it takes to read and write data from the source to the target. Every 100 milliseconds from the start of a file transfer we calculate how much time to allot for processing and sleeping based on the percentage set for the option.

Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds every 100 milliseconds
50% Process for 50 milliseconds Sleep for 50 milliseconds every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds every 100 milliseconds

In summary, PeerSync determines bandwidth throttling by calculating the amount of time required to send a packet of data across your network and then applying a delay based on the throttling percentage specified.

Notes:
1. This methodology should dynamically allow for PeerSync to transfer data at a fast pace when no other applications are using bandwidth and allow it to back off when other applications are using bandwidth.
2. This methodology is more accurate when using smaller Read/Write Buffer settings.
3. This methodology does not include small files that take less than 100 micro-seconds to transmit across your network. |
| Enable intelligent network load balancing (when applicable) | The network load balancing option will automatically set a read/write buffer size based on recommendation from NIC network cards (Installed network cards must also support this feature). |
| Set maximum number of copy threads to x (*Multi Threading Option*) | This feature will limit the number of copy threads to be spawned and used for the selected Job during folder scans. This thread limit does not apply to enhanced Real-Time events. By using limits for scanning, it helps the Profile to better process Enhanced Real-Time events during heavy scan operations. |

**Related Options**

Options/Commands

Note: Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.

1.1.9 Byte Replicator

**Byte Replicator**

- **Use block/byte level synchronization**
  - **On Failure:** Use Default File Copy for Synchronization

**Block Size Selection**

- **Improved Bandwidth Utilization**
  - **Improved Performance**
  - **Smaller Block Size**
  - **Larger Block Size**
  - **Reset to Default**

- **File Exclusions**
  - **Excluded File Types:** ON - Minimum File Size: 100 KB

- **Port Configuration**
  - **Port:** 7333 - Time Out: 120 seconds - Compression: OFF

Note: This option requires our PSLlistener tool to be installed on the remote computer with identical Encryption and Port configurations.

**Topics**

Byte Replicator Options

Note: Features listed on this page require the Byte Replicator options.
The Byte Replicator screen enables and configures Block/Byte level synchronization for the selected Job. Through the use of this feature PeerSync will be able to transmit only the bytes/blocks of a file that have changed instead of transferring the entire file.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use block/byte level synchronization</td>
<td>Select this option to enable/disable block/byte level replication. If this is disabled, PeerSync will use the standard copy method to synchronize the file. If the Byte Replicator fails to synchronize a file, i.e. On Failure, PeerSync will either: 1. Log Messages &amp; Use Recovery Intervals (if applicable) 2. Use Default File Copy for Synchronization</td>
</tr>
<tr>
<td>Block Size Selection</td>
<td>This slider controls whether either Performance or Bandwidth Utilization is most important. Files synchronized with the slider set Low will take longer to complete than with the slider set High.</td>
</tr>
<tr>
<td>File Exclusions</td>
<td>Clicking on the Exclusions button in the Byte Replicator window opens the Byte Replicator File Exclusions dialog. Files that match types in the exclusion string (types by file extension) or files that have a size lower than the Minimum File Size will use the default file copy method instead of the Byte Replicator feature.</td>
</tr>
<tr>
<td>Excluded File Types by Extension</td>
<td>Field containing a list of file types that will use the default file copy method instead of the Byte Replicator. This feature can be configured by clicking the button to the right of this field. For example, to exclude files with the extension LOG you may add either .log or log to the exclusion list. Multiple entries need to be semicolon (;) delimited.</td>
</tr>
<tr>
<td>Minimum File Size</td>
<td>Files with sizes lower than the value in this field will be copied using the default file copy method instead of using the Byte Replicator.</td>
</tr>
<tr>
<td>Port Configuration</td>
<td>Clicking on the Port Configuration button in the Byte Replicator window displays the Port Configuration dialog. This window allows for a common TCP and/or Byte Replicator configuration option for both the Source and Target paths (see the TCP Port Configuration tab for more information).</td>
</tr>
</tbody>
</table>

Notes:

1. The Byte Replicator is an optional feature which may not be included in your package. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is...
assigned as an administrative share (i.e. D$) in order for the Byte Replicator to work properly.

3. In order for Byte Replicator to be enabled, the following criteria must be present:
   - The Target Path cannot be an FTP Target
   - The PS Listener Service has been installed on the remote machine
   - The PeerSync license has the Byte Replicator add-on feature

### 1.1.10 Revisioning

<table>
<thead>
<tr>
<th>Revisioning Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revisioning - Keep backup files of overwritten target files</td>
<td>Select this option to enable/disable the use of Revisions.</td>
</tr>
<tr>
<td>Number of backup files to keep</td>
<td>Designates the number of revisions to keep for each file. PeerSync revisions each file by adding a &quot;.PSBAK1&quot; extension to the existing Target File before replacing it with the updated Source File.</td>
</tr>
</tbody>
</table>

Example: "MyFile.txt" will become "MyFile.txt.PSBAK1"

If more than one backup is selected, each file will be renamed to the next revision when an update occurs:
Example: "MyFile.txt.PSBAK1" is renamed to ".MyFile.txt.PSBAK2"

The newest revisions (backup files) will bear the lowest number while the oldest will have the higher number:

Example: Newer... PSBAK1, PSBAK2, PSBAK3, PSBAKn ... Older

Note: If the “Delete Unmatched” option is selected and the Source File that has corresponding PSBAK files deleted, all associated PSBAK files will also be deleted.

<table>
<thead>
<tr>
<th>Keep files in Target Folder</th>
<th>By default, revisions will be stored in the Target Folder where the updated Target Files reside.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep files in Deletion Folder</td>
<td>You also have the option of using the Deletion Folder for storing revisions. This is quite useful when used in conjunction with the Delete_unmatched_Target_Files_older_than_x_days option, which is used for automatic cleanup of old revisions.</td>
</tr>
<tr>
<td>Keep files in Alternate Folder</td>
<td>You may specify the folder path where you would like the revisions stored to. This option will give you the ability to specify a separate revision folder per Job. We strongly recommend using a Revisions Folder that is located on the Target host computer. Relocation to an alternate drive or host adds unnecessary processing and bandwidth overhead. For this reason PeerSync uses the following Revisions Folder variables:</td>
</tr>
<tr>
<td></td>
<td>%TARGETROOT%</td>
</tr>
<tr>
<td></td>
<td>This variable resolves to the root directory of the target path. For example if the target path is \machine1\c$\Target\Docs, the revision path %TARGETROOT%\Revisions will resolve to \machine1\c$Revisions. This variable is used by default.</td>
</tr>
<tr>
<td></td>
<td>%TARGETPARENT%</td>
</tr>
<tr>
<td></td>
<td>This variable resolves to the parent directory of the target path. For example if the target path is \machine1\c$\Target\Docs, the revisions path %TARGETPARENT%\Revisions will resolve to \machine1\c$\Target\Revisions.</td>
</tr>
</tbody>
</table>

Notes:

1. This feature may be ignored when using an FTP Source.
2. This feature may be ignored when using Folder Compression.
### 1.1.11 Miscellaneous

#### Target File/Folder Alterations

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use intermediate file during copy</td>
<td>If this box is checked, a temporary file will be created in the Target Folder: the contents of the Source File will then be copied into this temporary file. After a successful copy, the Target File will be deleted and the temporary file will be renamed to bear the Target File name. This feature ensures that the updated file will only replace the Target File if copy is successful. If the copy process should be interrupted because of some outside factor (network down, power outage, etc), the original Target file will still be preserved. This option is enabled/disabled automatically when the Bi-directional or Revisioning options are enabled/disabled.</td>
</tr>
<tr>
<td>Trigger additional event after successful copy</td>
<td>When this option is checked PeerSync will apply the timestamp of the target file after successfully completing the file transfer in order to trigger an event on the target side. This action will cause the PeerSync installed on the Target to take further action with the file such as transferring it to another location that is not accessible from the originating machine.</td>
</tr>
<tr>
<td>Transfer NT security descriptions (ACLs)</td>
<td>If this feature is checked, PeerSync will transfer over and match the security descriptions (ACLs) to the Target file upon</td>
</tr>
</tbody>
</table>

#### Source File/Folder Alterations

- Move Files - Delete source file after successful copy to target
- Turn file archive attribute off after synchronization

#### Additional Event Options

- Include attribute change as synchronization criteria
synchronization, under Windows NT platforms. When this option is enabled, the "ACL Options" and Global Settings link will be enabled for further configuration.

<table>
<thead>
<tr>
<th>ACL Options</th>
<th>This dialog is available if you enable Transfer NT security descriptions (ACLs) or click on the &quot;ACL Options&quot; button located on the Miscellaneous window. The options in this dialog allow you to specify the types of permissions you want PeerSync to transfer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force target file attribute settings</td>
<td>If this feature is selected, the File Attributes Options dialog will be displayed. In this dialog, you may select to force any attribute on or off for the Target files that are synchronized within the selected Job(s).</td>
</tr>
<tr>
<td>File Attribute Options</td>
<td>This dialog provides the user the selection to ignore, force on, or force off attribute settings on Target files that are synchronized within the selected Job(s).</td>
</tr>
</tbody>
</table>

**Related Options**

- **Global Settings**

**Notes:**

1. Care must be exercised when using ACL options to synchronize files and folders between different domains. File security transfers could make the target file inaccessible after transfer/update.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned as an administrative share (i.e. D$) in order for ACLs to work properly.

3. This feature may be ignored when using an FTP or TCP Source or Target.

4. This feature may be ignored when using Folder Compression.

**Source File/Folder Alterations**

These options can be found in the Miscellaneous window.

<table>
<thead>
<tr>
<th>Move Files - Delete source file after successful copy to target</th>
<th>This feature will delete the Source file after the file is copied to its corresponding Target folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn file archive attribute off after synchronization</td>
<td>This feature resets the archive flag on the Source and Target file after synchronization. The Windows file system automatically sets the archive bit for every file that has changed; normally, this is used to indicate that a given file has been modified since the last time its archive bit was set. Most tape back-up programs use this flag to determine which files have changed since the last backup. This option will alter Source files. PeerSync uses this feature to reduce the number of files that are checked on the Source drive.</td>
</tr>
</tbody>
</table>

Note: This feature should not be used with the Delete Unmatched Target Files option on the File Options screen because conjunct use of the two options will greatly increase the chance of data loss.
Notes:

1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This process only occurs after successful synchronization of a changed file.

2. This feature may be ignored when using an FTP Source.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature. This configures all files for synchronization and consequently qualifies them for the reset of archive flags. This feature only needs to be selected once to be applied to existing sync operations.

Additional Event Options

This option can be found in the Miscellaneous window.

| Include attribute change as synchronization criteria | This feature allows for the synchronization of files that have different attributes. If this feature has been selected, a Source file whose attributes do not match the Target will still be included in the synchronization process.

Notes:

1. This option is not supported for Jobs using FTP source or target.

2. By default this option only works during scans. Use the /LA command line argument if you wish to enable attribute detection in real-time.

1.1.12 Additional Features

Additional Features

- **Additional Options**
  - **Enable file recovery**
  - **Replace in-use files upon reboot**

- **Validation Options**
  - **Perform binary comparison on all files (using CRC32)**
  - **Validate target file (using CRC32)**

- **File Time Change Options**
  - **During comparison subtract**<br> 0 <br> minute(s) from target
  - **Convert file times to GMT for comparison between time zones**
  - **After synchronization subtract**<br> 0 <br> minute(s) from target
Additional Options

The options on this page can be accessed from the "Additional Features" window, available only with the Enhanced Package.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable file recovery</td>
<td>This enables the file recovery option to continue a file copy which may have been interrupted. If the Source and Target file name and date match but the Target file is smaller, PeerSync will start the copy operation from the last byte that was sent the next time a sync operation is executed on the folder. Note: Enable file recovery will be ignored with an FTP Source or FTP Target.</td>
</tr>
<tr>
<td>Replace in-use files upon reboot</td>
<td>If this feature is selected, once a file is open and locked on the Target Folder, it will be set to be replaced the next time the machine is rebooted. Note: This option is only applicable for Jobs with a local Target Folder.</td>
</tr>
<tr>
<td>Reboot Options Button</td>
<td>This button opens the Reboot Options dialog box. The default option is &quot;Do not reboot&quot;, you may also choose to &quot;Display reboot dialog&quot;, or to &quot;Automatically reboot&quot;.</td>
</tr>
</tbody>
</table>

Validation Options

These settings can be accessed from the "Additional Features" window, available only with the Enhanced Package.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform binary comparison on all files (using CRC32)</td>
<td>Option to check all Source and Target files for binary match during folder scan/compare cycle (using CRC32). This check ensures that what is on the Target matches the Source at a binary level.</td>
</tr>
<tr>
<td>Validate target file (using CRC32)</td>
<td>Option to validate file using CRC32 binary comparison after successful file copy operation. Clicking on the Retry Options... button opens the Validate File Copy Options dialog box. In this window you may set PeerSync to continue re-validating a file a set number of times. Checking this option will enable the CRC Retry cycle, where, if a file is not validated, PeerSync will retry the CRC32 validation x times. The default retry value is 1.</td>
</tr>
</tbody>
</table>

Note: Features described on this page require the Enhanced Package.
Set maximum number of tries to
Specify the number of times PeerSync will perform CRC32
validation on a file if the initial validation fails. The default retry
value is 1.

Note: Features described on this page require the Enhanced Package.

<table>
<thead>
<tr>
<th>File Time Change Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>These settings can be accessed from the &quot;Additional Features&quot; window, available only with the Enhanced Package.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>During comparison subtract/add x minute (s) from target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option to add or delete time from Target file during folder comparison. This allows for synchronization of files between dissimilar time zones or to allow for some time difference between Source and Target in case Target machine date is slightly different from Source.</td>
</tr>
<tr>
<td>Note: This feature may be ignored during Enhanced Real-Time.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Convert file times to GMT for comparison between time zones</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option to convert file times to GMT for comparison between time zone differences of the Source and Target folders. This feature is quite useful way of synchronizing data between machines located in different parts of the world.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After synchronization subtract/add x minute (s) from target</th>
</tr>
</thead>
<tbody>
<tr>
<td>This option can add or delete time from Target file after synchronization. This allows for synchronization of files between dissimilar time zones, or to allow for some time difference between Source and Target in case Target machine date is slightly different from Source.</td>
</tr>
</tbody>
</table>

Note: Features described on this page require the Enhanced Package.
1.1.13 Exceptions

The Exceptions screen is used after you have selected a Job or Multiple Jobs from the Profile Job List and then created an associated Source and Target Folder on the Folder Selection screen. Through Exception options, PeerSync allows you to selectively apply synchronization to files contained within the Source Folder according to a wide range of explicit criteria.

Include Files

The options on this page can be accessed from the Exceptions window.

Include Files

Use this field to determine which file types will be included as part of synchronization. File Type Inclusions are specified by a star command followed by the file extension (i.e. *.doc). You can also specify specific file names and/or sub strings using the * wildcard character.

The default setting * includes all files.
Multiple Inclusions can be used and are semicolon delimited (i. e. ".doc;.txt;.exe}).

Inclusions are not case sensitive, (i.e. "A" = "a").

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.doc</td>
<td>includes any file ending with the extension .doc</td>
</tr>
<tr>
<td>docs</td>
<td>includes any file that contains the string docs</td>
</tr>
<tr>
<td>copy*</td>
<td>includes any file starting with the string copy</td>
</tr>
<tr>
<td>file;</td>
<td>includes any file containing the strings file or data</td>
</tr>
<tr>
<td>data;</td>
<td>includes any file containing the strings file or data</td>
</tr>
</tbody>
</table>

You may also use the ? wildcard character to further narrow down your inclusions. The ? wildcard character can be used to substitute any single character in the file name including numbers.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>????.*</td>
<td>includes files that have extensions and contain only 4 characters in the name</td>
</tr>
<tr>
<td>June?</td>
<td>includes files that have extensions, start with the word June, and are followed by 4 characters</td>
</tr>
<tr>
<td>???.*</td>
<td>includes files that have the characters ne in the 3rd and 4th positions followed by at least 4 characters</td>
</tr>
</tbody>
</table>

Inclusions can be typed manually, or can be specified using either the Include File Types button or drop-down list located to the right of the field.

**Include Files Button**

Opens an "Exceptions" dialog box into which file extensions may be entered. The "include all files" command * will be shown by default.

To add an extension, click "New." Next, type the desired extension into the field located at the bottom of the dialog. Repeat this process for each desired file type. Inclusions can be deleted by selecting them from the list and clicking the "Delete" key at the bottom of the dialog box. Once you have finished, click the "OK" button. The dialog will close and all of the Inclusions you have specified will automatically appear in the Include File Types field in the proper format (separated by semi-colons).

The drop-down list located to the right of this field will be dynamically populated with Inclusions as they are set through the "Exceptions" dialog described above. They are also added to the list when you exit the field after manually editing the Include File Types field. Inclusions can then be specified by selecting them from this list. This provides a way to store and/or retrieve sets of Inclusions for later use with other Jobs.
Exclude Files

The options on this page can be accessed from the Exceptions window.

**Exclude Files**

Through this field, files can be selectively excluded from synchronization using sub strings or using wild cards. Exclusions are set by specifying individual characters (i.e. `~`), sets of characters (i.e. `copy*`), or file extensions (i.e. `*.tmp`) which, if found within a file name, will exclude that file from synchronization.

Multiple characters and strings can be used and are semicolon delimited (i.e. `~;*.tmp;copy*`)

These settings are not case sensitive, (i.e.`"A" = "a"`)  

<table>
<thead>
<tr>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>~</code></td>
<td>excludes any file containing the character <code>~</code></td>
</tr>
<tr>
<td><code>tmp</code></td>
<td>excludes any file that contains the string <code>tmp</code></td>
</tr>
<tr>
<td><code>copy*</code></td>
<td>excludes any file starting with the string <code>copy</code></td>
</tr>
<tr>
<td><code>*.tmp</code></td>
<td>excludes any file ending with the extension <code>.tmp</code></td>
</tr>
<tr>
<td><code>..tmp; bak;~</code></td>
<td>excludes any file bearing the strings <code>.tmp</code>, <code>.bak</code> or the character <code>~</code></td>
</tr>
</tbody>
</table>

You may also use the `?` wildcard character to further narrow down your exclusions. The `?` wildcard character can be used to substitute any single character in the file name including numbers.

<table>
<thead>
<tr>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>*tmp?</code></td>
<td>excludes all files that contain the string <code>tmp</code> followed by at least one character before the extension</td>
</tr>
<tr>
<td><code>.*</code></td>
<td>excludes all files that contain the string followed by at least one character before the extension</td>
</tr>
</tbody>
</table>

Exclusions can be typed manually, or can be specified using either the Exclude Files Button or drop-down list located to the right of the field.

**Exclude Files Button**

Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired character or string into the field located at the bottom of the dialog. Repeat this process for each Exclusion. Entries can be deleted by selecting them from the list and clicking the "Delete" key at the bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the Exclusions you have specified will automatically appear in the Exclude Files field.

The drop-down list located to the right of this field will be dynamically populated with Exclusions as they are set through the dialog box described above. They are also added to the list when you exit the field after manually editing the Exclude
Files field. Exclusions can then be specified by selecting them from this list. This provides a way to store and/or retrieve sets of Exclusions for later use with other Jobs.

### Exclude Folders

The options on this page can be accessed from the Exceptions window.

#### Exclude Folders

Use this field to exclude folders from synchronization by specifying a folder name in file path format, (i.e. `\TEMP\` or `C:\WINDOWS\`). These examples will exclude any folder path that contains these strings including sub-folders.

If you wish to exclude only a specific or root folder such as "C:\WINDOWS\" but include sub-folders you must include a "#" in front of the complete folder path (i.e. "#C:\WINDOWS\"). This example will exclude any files in this directory but include any files in its sub-folders. A semicolon separates multiple folder exclusions.

If you wish to exclude multiple folders that contain the same string do not include the "\" at the end of the folder exclude (i.e. `\Docs\`).

These settings are not case sensitive, (i.e. "A" = "a")

<table>
<thead>
<tr>
<th>Examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\Docs\</code></td>
<td>- excludes files and sub-folder in folders starting with Docs (i.e. Docs, Docs1, DocsA, etc.)</td>
</tr>
<tr>
<td><code>\\Docs</code></td>
<td>- excludes files and sub-folder in folders named Docs</td>
</tr>
<tr>
<td><code>C:\Docs\</code></td>
<td>- excludes files and sub-folder in the folder C:\Docs\</td>
</tr>
<tr>
<td><code>#C:\Docs\</code></td>
<td>- excludes files in the folder C:\Docs\ but includes files in its sub-folders</td>
</tr>
</tbody>
</table>

Exclusions can be typed manually, or can be specified using either the Exclude Folders Button or drop-down list located to the right of the field.

### Exclude Folders Button

Opens a dialog box into which Folder Exclusions may be entered.

To add an Exclusion, click "New," then type the desired folder name into the field located at the bottom of the dialog. Repeat this process for each Exclusion. Entries can be deleted by selecting them from the list and clicking the "Delete" key at the bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the Exclusions you have specified will automatically appear in the Exclude Folders field. The drop-down list located to the right of this field will be
<table>
<thead>
<tr>
<th><strong>Exclude empty source folders</strong></th>
<th>This feature will exclude and will not sync empty Source Folders to the Target.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exclude File by Size</strong></td>
<td>The options on this page can be accessed from the <strong>Exceptions</strong> window.</td>
</tr>
<tr>
<td><strong>Exclude File Sizes</strong></td>
<td>Use the &quot;Less Than&quot; or &quot;Greater Than&quot; fields to exclude files based on their size in bytes. Zero, by default, includes all files.</td>
</tr>
<tr>
<td><strong>Include Files by Date</strong></td>
<td>The options on this page can be accessed from the <strong>Exceptions</strong> window.</td>
</tr>
<tr>
<td><strong>Selected File Dates</strong></td>
<td>Use this field to specify files set for synchronization according to their date stamp. The default setting includes all file dates. Clicking the button to the right of this field opens a &quot;Select File Dates&quot; screen. This screen allows you to include all files, include files more than x days old, include files bearing the current and past x day's date, or specify a range of the dates. The Set Today's Date button automatically updates the existing range to reflect the current day.</td>
</tr>
<tr>
<td><strong>Include Files by Attributes</strong></td>
<td>The options on this page can be accessed from the <strong>Exceptions</strong> window.</td>
</tr>
<tr>
<td><strong>Current Attributes</strong></td>
<td>This field displays &quot;Default&quot; or &quot;Customized&quot; to indicate whether the default attributes have been changed. Clicking the button to the right of this field opens a window from which file/folder attributes may be included. All attributes are selected by default. Uncheck the file/folder attributes you do not wish to be used as criteria for synchronization.</td>
</tr>
<tr>
<td><strong>Exclude Files by Attributes</strong></td>
<td>The options on this page can be accessed from the <strong>Exceptions</strong> window.</td>
</tr>
<tr>
<td><strong>Current Attributes</strong></td>
<td>This field displays &quot;Default&quot; or &quot;Customized&quot; to indicate whether the default attributes have been changed. Clicking the button to the right of this field opens a window from which file/folder attributes may be excluded. All attributes are unchecked by default. Select the file/folder attributes you wish to be used as criteria for exclusion.</td>
</tr>
</tbody>
</table>
1.1.14 Reporting

The options listed on this page can be accessed from the Reporting window. PeerSync automatically generates Log Files providing a detailed history of all synchronization events. This screen is used to view Log Files and set their reporting characteristics.

**Use Log File**
This feature enables or disables Log file generation. The default file, PeerSync.Log, is located in the path in which PeerSync has been installed. This field also supports File/Folder Path Variables and when used the current path will be displayed above the field.

**Overwrite Existing Log File**
Use this feature to report only the most recent PeerSync activity in the Log File. If this feature is not selected, all PeerSync processes will be reported in succession.

**View Log File**
This button allows you to view Log reports by opening the file in a text editor.

**Clear Log File**
This button allows you to clear Log reports.

**Reporting File Content**
The options listed on this page can be accessed from the Reporting window. Using the
check boxes provided in this section of the Reporting screen, you can specify what will be reported in the Log File. The Default setting is to include all items except Folder Names.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added Files</td>
<td>This feature adds an entry for any file that has been added to the Target.</td>
</tr>
<tr>
<td>File Date</td>
<td>Includes date associated with each file contained in the Log.</td>
</tr>
<tr>
<td>File Size</td>
<td>Includes size of each file contained in the Log.</td>
</tr>
<tr>
<td>Updated Files</td>
<td>This feature adds an entry for any file that has been updated in the Target.</td>
</tr>
<tr>
<td>File Time</td>
<td>Includes time associated with each file contained in the Log.</td>
</tr>
<tr>
<td>Transfer Time</td>
<td>Includes time it takes to transfer the file in milliseconds.</td>
</tr>
<tr>
<td>Summary</td>
<td>Appends a summary of activity to the end of the report.</td>
</tr>
<tr>
<td>Folder Names</td>
<td>Indicates the names of synchronized folders.</td>
</tr>
<tr>
<td>Folder Creation</td>
<td>This feature creates an entry for any folders that did not exist in the Target and had to be created during the synchronization process.</td>
</tr>
<tr>
<td>Messages</td>
<td>This feature logs any messages or application errors found during synchronization.</td>
</tr>
<tr>
<td>Exceptions</td>
<td>This feature logs any file/folder exclusion found during synchronization.</td>
</tr>
<tr>
<td>ACLs</td>
<td>This feature logs any file/folder ACL updates during scans and real-time.</td>
</tr>
</tbody>
</table>

Note: Application errors are additionally written to a file called "PS Error.log," regardless of whether or not that option has been selected.

<table>
<thead>
<tr>
<th>Log File Size/Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the maximum log file size to x bytes</td>
<td>By entering an amount into this field you can limit the size of Log Files created by PeerSync. When this limit is reached, the next reporting session will first rename the existing file to FILENAME.BAK1.Log and then create a new, blank Log File to which subsequent data will be added. Two backups FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept for each unique Log file.</td>
</tr>
</tbody>
</table>

Unicode content | This option will enable the reporting of Unicode content. |

SNMP Options

The options listed on this page can be accessed from the Reporting window, available only with the Enhanced Package.
Use SNMP reporting (errors only)

Use Simple Network Management Protocol error reporting.

SNMP Options Button

This button opens the SNMP Options dialog box. Once this box has opened, it allows you to select the Destination IP and Trap Prefix to be used for SNMP reporting. Please refer to your SNMP management software for more details.

Note: To properly use the installed mib file you need to rename the psi_def.mib to psi.mib.

Note: Features described on this page require the Enhanced Package.

1.1.15 Admin Reporting

Admin Reporting

- Create administrative report files

  - Report File Content
    - Summary/Messages only
  - Report File Name
    - Logged On User: MonikaC

- Report File Path
  - C:\Program Files (x86)\PeerSync\9.0 UAC\Logs\Admin\2012-08-02\C:\Program Files (x86)\PeerSync\9.0 UAC\Logs\Admin\%yyyy%-%mm%-%dd%

- Admin Report Cycle Options
  - Create a report once a day
  - Every day at 12:00 PM

Advanced Settings...

Topics

- Admin Reporting Overview
- Report File Content
- Report File Name
- Report File Path
- Admin Report Cycle Options
- Advanced Settings

Admin Reporting

The options listed on this page can be accessed from the Admin Reporting window. This screen allows you to create a unique report for administration purposes. Admin Reports generated during sync operations can be saved to a specific administrative folder (in a local or network path). Admin Reports are made uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User Name with date/time stamps).
Create administrative report files | This feature enables or disables the Administrative Reporting feature.

<table>
<thead>
<tr>
<th>Report File Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Summary/Messages only</strong></td>
</tr>
<tr>
<td><strong>Standard report file content</strong></td>
</tr>
<tr>
<td><strong>Messages only</strong></td>
</tr>
</tbody>
</table>

Note: Admin reporting files do not display Unicode characters.

Report File Name | The options listed on this page can be accessed from the Admin Reporting window. |
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report file name</strong></td>
</tr>
</tbody>
</table>

Report File Path | The options listed on this page can be accessed from the Admin Reporting window. |
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report file path</strong></td>
</tr>
</tbody>
</table>

Admin Report Cycle Options | The options listed on this page can be accessed from the Admin Reporting window. |
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create a report for every event</strong></td>
</tr>
<tr>
<td><strong>Create a report on an interval</strong></td>
</tr>
<tr>
<td><strong>Create a report once a day</strong></td>
</tr>
</tbody>
</table>
Create a report once a week

This option allows for a report to be generated once a week. You may specify the day of the week from the drop down list to the right of this option.

Only use Advanced Settings

This option allows for a report to be generated based on the configuration of the Advanced Settings only.

Advanced Settings

The options listed on this page can be accessed on the "Advanced Settings" button from the Admin Reporting window.

At the start of this Profile

This option allows for a report to be created at the start of the Profile.

At the stop of this Profile

This option allows for a report to be created at the stop of the Profile.

For each individual error message as it occurs

This option allows for a report to be created for each error.

After each scan (log all non-scan events on the cycle specified)

This option allows for a report to be created once a day. You may specify the time of the day from the input field to the right of this option.

After each scan/cycle even if no events occurred

This option allows for a report to be created after each scan even when no events occurred.

1.1.16 Email Reporting

- Create administrative email messages
- Report File Content
  - Summary/Messages only
- Report File Name
  - Logged On User: MonikaC
- Email Configuration
  - Email to: user@company.com
  - Attach log files
  - Delete after successful send
- Email Report Cycle Options
  - Send an email once a day
  - Every day at 12:00 PM
- Advanced Settings...
E-Mail Reporting

The options listed on this page can be accessed from the E-Mail Reporting window. This screen allows you to create a unique report for administration purposes. E-mail Reports generated during sync operations can be sent to an administrator, shared mailbox or a specified user. E-mail notification of synchronization activity can be sent upon completion of entire Profile or during persistent synchronization operations. E-mail Reports are made uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User Name with date/time stamps).

<table>
<thead>
<tr>
<th>Create administrative E-mail messages</th>
<th>This feature enables or disables the E-Mail Reporting feature.</th>
</tr>
</thead>
</table>

Note: E-mail reporting messages do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the E-Mail Reporting window.

<table>
<thead>
<tr>
<th>Summary/Messages only</th>
<th>Appends a summary of activity to the end of the report. This option will also log messages.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard report file content</td>
<td>This feature directs Report content to follow those conventions also utilized in PeerSync Log Files.</td>
</tr>
<tr>
<td>Messages only</td>
<td>Only reports messages and application errors.</td>
</tr>
</tbody>
</table>

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary is selected.

Report File Name

The options listed on this page can be accessed from the E-Mail Reporting window.

| Report file name | Allows you to choose between a "Local Computer" or "Logged-On User" Administrative Report. The e-mails will bear the selected name as part of the Subject filed. For example: "PeerSync Summary Report for COMPUTER (PeerSync Started)". |

E-mail Configuration

The options listed on this page can be accessed by clicking on the "Email Configuration" button from the E-Mail Reporting window.
<table>
<thead>
<tr>
<th><strong>Attach log files</strong></th>
<th>Allows you to attach the reporting section log file to e-mails generated by this application.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delete after successful send</strong></td>
<td>Deletes the log file after a successful e-mail attached send.</td>
</tr>
<tr>
<td><strong>E-mail Configuration Button</strong></td>
<td>This button opens the Email Configuration dialog box: Once this box has opened, it allows you to select the SMTP Host, User ID, Port, who to send to, and who to send Carbon Copies to and what e-mail address to send from.</td>
</tr>
<tr>
<td><strong>SMTP Host</strong></td>
<td>The host name or IP address of the SMTP mail server to send alert emails to.</td>
</tr>
<tr>
<td><strong>User ID</strong></td>
<td>The username to authenticate with the SMTP mail server. This is normally not needed. (Optional)</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>TCP/IP connection port. It is recommended that you leave the default setting unless your email server requires otherwise.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td>The email address of the person who is to receive the email. This user sometimes needs to be a valid user on the SMTP mail server. You may add multiple email addresses in this field. Use a semicolon (;) as a delimiter.</td>
</tr>
<tr>
<td><strong>CC</strong></td>
<td>The email address of the person who is to receive a Carbon Copy of the email. You may add multiple email addresses in this field. Use a semicolon (;) as a delimiter.</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>The email address that will appear in the From field of the email. This e-mail does not need to be a valid e-mail. For example it can be used to identify the Job that generated the e-mail by using the %JobName% variable (i.e. %JobName% @MyCompany.com).</td>
</tr>
<tr>
<td><strong>Send Test Email</strong></td>
<td>Clicking on the Test Connection button will send a test email to the configured email address(es) and let you know if PeerSync was able to successfully connect and send an email via the configured SMTP mail server. It is highly recommended that you test the configuration before saving the options.</td>
</tr>
</tbody>
</table>

**E-mail Report Cycle Options**

The options listed on this page can be accessed from the E-Mail Reporting window.

| **Create a report for** | This option allows for an E-mail to be sent on every event |
### Send E-mail Reports

The options listed on this page can be accessed by clicking on the "Advanced Settings" button on the **E-Mail Reporting** window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>At the start of this Profile</td>
<td>This option allows for an E-mail to be sent on every event (Add/Update/Delete/Message).</td>
</tr>
<tr>
<td>At the stop of this Profile</td>
<td>This option allows for an E-mail to be sent at a specific interval. You may specify the interval from the input field to the right of this option.</td>
</tr>
<tr>
<td>For each individual error message as it occurs</td>
<td>This option allows for an E-mail to be sent at a specific interval. You may specify the interval from the input field to the right of this option.</td>
</tr>
<tr>
<td>After each scan (send all non-scan events on the cycle specified)</td>
<td>This option allows for an E-mail to be sent once a day. You may specify the time of the day from the input field to the right of this option.</td>
</tr>
<tr>
<td>After each scan/cycle even if no events occurred</td>
<td>This option allows for an E-mail to be sent after each scan even when no events occurred.</td>
</tr>
</tbody>
</table>

### E-mail Report Content

The options listed on this page can be accessed by clicking on the "Advanced Settings" button on the **E-Mail Reporting** window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send content in the body of the E-mail</td>
<td>This option will write the content for the email report into the body of the e-mail.</td>
</tr>
<tr>
<td>Send content as an attachment to the E-mail</td>
<td>This option will generate a file with the content of the e-mail report and attach the file to the e-mail.</td>
</tr>
<tr>
<td>Place content in a file</td>
<td>This option will generate a file with the content of the e-mail.</td>
</tr>
</tbody>
</table>
and send a link in the E-mail report and a link to the file will be sent within the body of the e-mail.

### 1.1.17 Compression

#### Compression

- **Compression Options**
  - Use folder compression
  - Use file compression

- **Compress/Expand**
  - Compress target
  - Expand source

- **Compressed File Extension**
  - ZIP

- **Compression Speed**
  - Normal
  - Maximum compression
  - Maximum speed

- **Password-Encryption**
  - [Change Password]

While compressing your choice of folders, the Compression utility also employs a unique method to minimize file damage. While creating Target directory structures to match those found in the Source, the folder compression option creates a single file for every folder contained within the Target Folder set. This minimizes the amount of data added to each compressed file. If a single file were used for the entire directory structure were to become corrupt, all files might be lost. PeerSync's "one file per folder" scenario ensures that if damage occurs, it is limited to individual folders only. We also offer file compression, which will compress the Source Files to the corresponding Target Files down to the file level which adds even more flexibility.

During folder compression, all selected Source Files are synchronized to the compressed Target Folder file bearing the name of the active folder plus the user selected extension (default extension is "ZIP").

During file compression, all selected Source Files are synchronized to the compressed Target Folder file bearing the name of the active file plus the user selected extension (default extension is "ZIP").
Compressed folder files can be expanded using most PKZip compatible extraction utilities. In addition, passwords can be specified and entered on this screen to protect against unauthorized access to compressed files.

### Compression Options

The options listed on this page can be accessed from the **Compression** window.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use folder compression</td>
<td>This check box enables or disables the folder compression feature which will compress files in each sub-folder to a single file per sub-folder. Notes: 1. Folder Compression may be ignored when using an FTP Source or FTP Target. 2. Bi-directional, Transfer NT security descriptions (ACLs), Move unmatched target files, Force target file attribute settings, Use intermediate file during copy and Revisioning, as well as, other non applicable features may be ignored when using Folder Compression.</td>
</tr>
<tr>
<td>Use file compression</td>
<td>This check box enables or disables the file compression feature which will compress file by file. Notes: 1. File Compression may be ignored when using an FTP Source. 2. Bi-directional, Transfer NT security descriptions (ACLs) and Move unmatched Target Files, as well as, other non applicable features may be ignored when using Folder Compression.</td>
</tr>
</tbody>
</table>

### Compress/Expand

The options listed on this page can be accessed from the **Compression** window.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compress target</td>
<td>Selecting this feature enables compression of the Target Folder.</td>
</tr>
<tr>
<td>Expand source</td>
<td>This feature extracts (expands) the Source folder. Use this feature to extract files from Source Folders that have already undergone compression. Note: This option is not supported when using a TCP target.</td>
</tr>
</tbody>
</table>

Note: A compressed Source Folder can not be synchronized to a compressed Target Folder.

### Compression File Extension

The options listed on this page can be accessed from the **Compression** window.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressed File Extension</td>
<td>The extension entered into this field will be applied to the compressed folder file name. For example, if &quot;rar&quot; is entered for a folder named &quot;Samples,&quot; the compressed folder file name will be &quot;Samples.rar.&quot;</td>
</tr>
</tbody>
</table>
**Note:** It is NOT necessary to add a period (".") before this extension name. The default extension is "ZIP," which associates the file with a Zip application (i.e. WinZip).

### Compression Speed

The options listed on this page can be accessed from the Compression window.

<table>
<thead>
<tr>
<th>Compression Speed</th>
<th>This setting allows you to set the compression speed and level of compression. You may choose from &quot;Normal&quot; compression, &quot;Maximum&quot; compression or &quot;Maximum speed&quot;.</th>
</tr>
</thead>
</table>

### Encryption

The options listed on this page can be accessed from the Compression window.

<table>
<thead>
<tr>
<th>Password Encryption</th>
<th>The password entered into this field will be used as a key to encrypt the compressed files. Without this key the original file CAN NOT be extracted from the compressed files. Do Not Lose This Password. Without it you will not have access to your encrypted files, nor will Peer Software be able to recover them.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Change Password</th>
<th>Selecting this button will display the Password Change dialog box. This allows you to change your existing password for the selected Job. This box requires you to enter your old password in addition to whichever new one you wish to begin using. This dialog box is also used to create a password if you do not currently have one. The password will be encrypted and saved for the selected Job.</th>
</tr>
</thead>
</table>

**Note:** You may only change the password for a single Job at a time. The old password must be checked against the stored password for this feature to be changed.
## 1.1.18 Pre/Post Process

<table>
<thead>
<tr>
<th>Pre/Post Process</th>
<th>Select Application/Script to Run Before/After Selected Job</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Before</strong></td>
<td>Use this field to specify (by file path) which application or script you would like to run before processing a Profile. File paths can be manually entered, or the open folder icon can be used to locate files. You may also use pre defined configuration commands. See our support page for a list of available options.</td>
</tr>
<tr>
<td><strong>After</strong></td>
<td>Use this field to specify (by file path) which application or script you would like to run after processing a Profile. File paths can be manually entered, or the open folder icon can be used to locate files. You may also use pre defined configuration commands. See our support page for a list of available options.</td>
</tr>
<tr>
<td><strong>Wait for application to end before continuing</strong></td>
<td>Check this feature if you want PeerSync to wait for the applications specified in the &quot;Before&quot; and &quot;After&quot; fields to close before processing additional tasks.</td>
</tr>
<tr>
<td><strong>Use maximum wait time of x seconds</strong></td>
<td>Selecting this feature sets a limit (in seconds) for how long PeerSync will wait for the applications specified in the &quot;Run Before&quot; and &quot;Run After&quot; fields to close. In order to activate this</td>
</tr>
</tbody>
</table>
function, the "Wait for Application to Terminate" function must be checked. The default, when this feature is not checked, is to wait indefinitely.

1.2 Advanced Options

<table>
<thead>
<tr>
<th>Advanced Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Migrate Shares</strong></td>
</tr>
<tr>
<td><strong>Match Shares: Add, Update and Delete</strong></td>
</tr>
</tbody>
</table>

Copy shares within the source folder to the relative target folder, where non-matching shares within the target folder are removed.

- **Global Migrate Shares Options (For All Jobs with Migrate Shares Enabled)**
  - **Process Migrate Shares after each scan**
  - **Process Migrate Shares every** 120 minute(s)

- **Global Advanced File Xfer Options (For All Jobs)**
  - Admin Backup (i.e. Files that are denied access because of the current ACL settings)
  - Advanced Backup (i.e. Reparse Points, Sparse, Offline, Stub Files, etc.)
  - Alternate Data Stream (ADS) Backup

1.2.1 Migrate Shares

**Migrate Shares**

The following settings can be accessed from the Advanced Options window.

<table>
<thead>
<tr>
<th>Add Shares: Do Not Update or Delete</th>
</tr>
</thead>
</table>
| Copy shares from the source folder to the relative target folder, where non-matching shares within the target folder are left on the target.

<table>
<thead>
<tr>
<th>Match Shares: Add, Update and Delete</th>
</tr>
</thead>
</table>
| Copy shares from the source folder to the relative target folder, where non-matching shares within the target folder are removed.

<table>
<thead>
<tr>
<th>Replace Shares: Add and Overwrite</th>
</tr>
</thead>
</table>
| Copy shares from the source folder to the relative target folder, where existing matching shares on the target system are overwritten.

<table>
<thead>
<tr>
<th>Add Shares with the selected Prefix</th>
</tr>
</thead>
</table>
| Copy shares from the source folder to the relative target folder, with the selected prefix.

<table>
<thead>
<tr>
<th>Add Shares with the selected Prefix</th>
</tr>
</thead>
</table>
| Copy shares from the source folder to the relative target folder, with the selected prefix.
### 1.2.2 Global Migrate Shares Options

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Open and Inaccessible Files</td>
<td>The following settings can be accessed from the Advanced Options window.</td>
</tr>
<tr>
<td>Process Migrate Shares after each scan</td>
<td>If the Migrate Shares option is checked, this setting will process the selected share migration setting after each scan.</td>
</tr>
<tr>
<td>Process Migrate Shares every x minute(s)</td>
<td>If the Migrate Shares option is checked, this setting will process the selected share migration setting every x minutes.</td>
</tr>
</tbody>
</table>

### 1.2.3 Global Advanced File Xfer Options

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Open and Inaccessible Files</td>
<td>The following settings can be accessed from the Advanced Options window.</td>
</tr>
<tr>
<td>Admin Backup</td>
<td>Provides the ability to replicate files and folders that are denied access because of their current ACL settings.</td>
</tr>
<tr>
<td>Advanced Backup</td>
<td>Select this option to replicate files such as Symantec Enterprise Vault stub files or files/folders which may be Reparse Points, Sparse, Offline, Stub Files, etc.</td>
</tr>
<tr>
<td>Alternate Data Stream (ADS) Backup</td>
<td>Replicate hidden Alternate Data Streams (ADS) which may be stored behind a filename.</td>
</tr>
</tbody>
</table>

### 1.3 PeerSync Global Settings

The Global Settings section contains features that apply to the entire Profile (all selected Jobs).

Following is a list of Global Settings that can also be found on other screens:

- Global Recovery/Offline Options
- Global Performance Options
- Global ACL Options
- Global Bi-directional Options
- Global Managed Files Options
- Current Command Line Argument Selection
### 1.3.1 Global Recovery/Offline Options

#### Retry Open and Inaccessible Files

The following settings can be accessed from the Global Settings window. Alternatively you can access them from the Options > "Global Settings" > "Global Recovery/Offline Options" menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry open/inaccessible files every x seconds</strong></td>
<td>Use this feature to specify, in seconds, how often PeerSync will attempt to synchronize Source Files that are in use. If the &quot;Include open files&quot; option on the File Options screen has not been checked and &quot;Retry&quot; is selected, PeerSync will continue attempting to synchronize files that are opened by other applications. &quot;Retry&quot; will also work when &quot;Include open files&quot; has been checked and a file is read-locked by another application. When the &quot;Retry&quot; option is on, PeerSync will synchronize the open file within x seconds after the file has been closed.</td>
</tr>
<tr>
<td><strong>Set maximum number of retries to x</strong></td>
<td>This feature sets a limit indicating how many times to attempt to process open files. If the maximum number of retries gets exceeded for a particular file PeerSync will remove it from the retry-list until another real-time event occurs on the file or a scan detects that the file needs to be added/updated. Setting the retry cycle to 0 will check the file indefinitely.</td>
</tr>
</tbody>
</table>

#### Failed Connection Options

The following settings can be accessed from the Global Settings window. Alternatively you can access them from the Options > "Global Settings" > "Global Recovery/Offline Options" menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry failed connections every x minutes</strong></td>
<td>PeerSync monitors persistent Jobs (Real-Time, scheduled, interval) for connectivity, and suspends the Job until a connection is resumed. This allows PeerSync to ensure that synchronizations are only attempted when a connection exists. This feature is set by default to a 1 minute interval and can be modified or disabled.</td>
</tr>
<tr>
<td><strong>Run a scan on reconnect (if needed)</strong></td>
<td>This feature will initiate a full scan at reconnect to process any file/folder changes which may have occurred during the connection failure. A scan will be performed only if a failure occurs in the middle of scan or if a scan was missed when the</td>
</tr>
</tbody>
</table>
connection was lost.

| Store missed events and process on reconnect | This feature pertains to any Job running in a Real-Time mode. Having this option enabled will store Real-Time events during failed connections and will process these events at Reconnect, eliminating the Source/Target Folder scan. |

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

1.3.2 Global Performance Options

The options listed on this page can be accessed by clicking on the "Global Performance Options" link on the PeerSync Global Settings window as well as the Options/Commands window and the Options menu. Please visit Global Performance Options for more information on this topic.

Set Application Priority

If this feature is selected, an icon will appear on the system tray when PeerSync is loaded. When you right/click on this icon a menu will appear. Through this menu the Profiler can be shown, the About PeerSync screen can be accessed, and PeerSync can be terminated. Once this dialog has opened, it gives you the ability to Set the Application Priority allowing PeerSync to run at a higher or lower priority then other applications.

Use Multiple Job Threads / Set maximum number of Job threads to x (Multi Threading)

This option is accessible with the Multi-Threading add-on module available for the Server version of PeerSync only. Enable this option to allow multiple Job threads to be used for parallel processing of Jobs. Without this feature each Job will run sequentially in the order it is listed, scheduled to run, or in the order that events are received.

Use Multiple Copy Threads / Set maximum number of Copy threads to x (Multi Threading)

This option is accessible with the Multi-Threading add-on module available for the Server version of PeerSync only. Enable this option to allow multiple Copy Threads to copy multiple files in parallel processes (i.e. Simultaneous Distribution - Synchronizing from one server to multiple servers simultaneously in a Web Farm type environment).

Use Enhanced Event Processing

This option provides the ability to parallel process real-time, retry or any other non-scan events. Enabling this feature will improve the speed of synchronization during real-time or any other non-scanning scenarios.

Exclude Common Job Exceptions in Event Processing

This option checks the global exclusions list before file hits such as before event processing and before adding the event to the visual list. The command line argument for this option is /QR.
Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

2. Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.

3. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message logging (Reporting, Admin Reporting and E-mail Reporting). The output will NOT contain a start and stop section or a summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Admin or Email reporting then the standard selection will be used. The reason this is done is due to the fact that processes will be running in parallel.

4. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your threads over this limit may lead to potential operational issues. We strongly discourage the use of more then 50 threads, however, you do have the option to exceed this limit by placing a greater than symbol " >" before your desired thread value (maximum allowed is 200). We recommend you test your setting to ensure PeerSync continues to operate acceptably in your environment.

5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job Threads and Multiple Copy Threads.

6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use the Set Processor Affinity argument in this scenario.

1.3.3 Global ACL Options

<table>
<thead>
<tr>
<th>ACL Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>This screen is activated by clicking on the Global Settings link located to the right of the ACL Options button in the Miscellaneous window as well as from the PeerSync Global Settings window or the Options menu. This window has the following features:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Monitor ACL changes during real-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>This global feature will enable Real-Time monitoring to detect and process ACL changes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Check for ACL changes during scans</th>
</tr>
</thead>
<tbody>
<tr>
<td>This global feature will validate and apply ACLs during folder scans.</td>
</tr>
</tbody>
</table>

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

2. Folder security checks occur during scans and folder create only.

3. For real-time detection of ACLs for empty folders or folders that contain files for which inheritance is disabled add the /LG1 option to the command line argument.

4. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.

1.3.4 Global Bi-directional Options

<table>
<thead>
<tr>
<th>Global Bi-directional Options</th>
</tr>
</thead>
</table>
This screen is activated by clicking on the Global Settings link located to the right of the Bi-directional option in the File Options window as well as from the PeerSync Global Settings window or the Options menu. This window has the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always create a super-set during bi-directional synchronization</td>
<td>This feature will alter the way the Enable bi-directional synchronization mode option functions by always creating a super-set of the data on the source and target. In this mode folders and files will always be added and not deleted.</td>
</tr>
<tr>
<td>Use enhanced bi-directional synchronization mode options</td>
<td>This feature will alter the way the Enable bi-directional synchronization mode option functions by using enhanced features to track all file and folder adds, updates, deletions, renames and moves between scan cycles. In this mode, PeerSync will use a hidden system trigger file within each sub-folder to store information about the last scan cycle for that sub-folder. Using this trigger file, PeerSync can determine if a Folder was added, deleted, renamed or moved since the last scan. Note: This feature is not supported when using the Enhanced Scanning option.</td>
</tr>
</tbody>
</table>

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

2. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-directional synchronization.

3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing standard or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of command line arguments. These options will ensure that during standard or enhanced bi-directional synchronization, deleted files from one side are not re-added by the other side. These arguments should NOT be used if there are more than two machines involved in a bi-directional synchronization.

1.3.5 Global Managed Files Options

File Manager Interval

By clicking on the Global Settings link from the Managed Files window you will be able to configure the File Manager Interval option. Alternatively you can access this screen from the Global Settings window or from the Options menu.

PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow synchronization of open/locked files. In order to enable this feature you will require the Managed Files add-on module. Developed by Microsoft, VSS is a storage management framework designed to create a point-in-time copy/snapshot of a volume. This method works well with applications that are VSS compliant. VSS does not support Novell NetWare systems.

Run Managed Files List Manager every x minutes

By default the Managed Files is set to run on an interval of 120 minutes. This interval may be changed by simply changing the interval time. By default, Managed Files will run at the end of the initial scan if Scan Job once at start is enabled. Subsequent
open and locked files detected in real-time or during scans will be thrown into the Managed Files list to be processed based on the Managed Files interval.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

2. These options require the VSS add-on module. Please visit http://www.peersoftware.com or contact Sales for additional information.

3. The minimum Managed Files interval is 30 minutes.

4. This feature only works for local Source folders and will be ignored with an FTP Source.

5. This feature may be ignored when using an FTP Target in conjunction with File Compression.

6. This feature may be ignored when using Folder Compression.

### 1.3.6 Current Command Line Arguments

<table>
<thead>
<tr>
<th>Global Command Line Arguments List</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Options/Commands window, double-clicking on the &quot;Command Line Arguments&quot; field or selecting the button to the right of it will open the Command Line Arguments dialog. The Command Line Arguments dialog can also be accessed from the PeerSync Global Settings window as well as from the Options/Commands window or the Options menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command Line Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this dialog you can modify, add or delete arguments to be used when launching PeerSync through any of the modes described in the Startup/Service screen or via the Run/View Current Profile Activity screen. This dialog displays the current arguments selected for the Profile and will also allow for the selection and modification of additional Command Line Arguments by double-clicking this field or selecting the Current Arguments Button to the right of the field.</td>
</tr>
</tbody>
</table>

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.
1.3.7 Options/Commands

Options/Commands

Display/Reporting Options - All Jobs
- Show tray icon
- Enable display options
- Enable reporting options

Performance Options - All Jobs
- Use Multiple Job Threads - Set maximum number of threads to: 5
- Use Multiple Copy Threads - Set maximum number of threads to: 10
- Use Enhanced Event Processing
- Set Application Priority: High Normal Priority

Command Line Arguments

Enable Basic Display
- This feature will have PeerSync open the Profiler, if it is not already open, and send status messages to be displayed on the Run/View PeerSync screen.

Enable Advanced Display
- This option activates the Show Advanced Display link at the bottom right corner of the Run/View PeerSync screen. When this link is clicked, the PeerSync Advanced Display panel will be shown. The advanced display contains a Jobs Stats panel on the top and an Advanced Run/View PeerSync panel at the bottom. The command line argument to disable this option is /QQ<<.

Profiler Options

Options located on this screen can be accessed from the Options/Commands > Display Options window and the Options > Global Settings > Display Options menu.

PeerSync Options (Application Runs Only)

Options located on this screen can be accessed from the Options/Commands > Display Options window and the Options > Global Settings > Display Options menu.

Display status in
- This feature will show the PeerSync Status Display dialog
PeerSync box during synchronization to view activity, status and other information while PeerSync is running.

<table>
<thead>
<tr>
<th>Display status in PeerSync upon completion</th>
</tr>
</thead>
<tbody>
<tr>
<td>This feature will have PeerSync pop-up the PeerSync Status Display dialog at the end of synchronization (only in non-persistent modes) to view activity, status and other information upon completion.</td>
</tr>
</tbody>
</table>

### Profiler/PeerSync Options

Options located on this screen can be accessed from the Options/Commands > Display Options window and the Options > Global Settings > Display Options menu.

<table>
<thead>
<tr>
<th>Job Stats</th>
</tr>
</thead>
<tbody>
<tr>
<td>This feature allows for the Jobs Stats panel in the PeerSync Advanced Display to get updated. Use /QP to disable this option via the command line.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Job Scans</th>
</tr>
</thead>
<tbody>
<tr>
<td>When enabled, this option adds a Job Scans tab to the Advanced Run/View PeerSync panel. This table lists Base/Root, Enhanced/Expanded, and RT/Sub-folder scans with statistics and progress for all the Jobs or only the selected Job. The command line argument for this option is /Q8BJ+.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File Copy Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>This feature will show the progress of a file transfer in the PeerSync Status Display or the Advanced Run/View PeerSync panel. This feature requires the Multi-Threading Option. The command line argument for this option is /QQ.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Historical Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>When enabled, this option adds a Historical Data tab to the Advanced Run/View PeerSync panel. This tab contains a subset of data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the selected Job. The command line argument for this option is /Q8BH+.</td>
</tr>
</tbody>
</table>

### Observer Display Options

Options located on this screen can be accessed from the Options/Commands > Display Options window and the Options > Global Settings > Display Options menu.

<table>
<thead>
<tr>
<th>Send status information to PS Observer Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td>This will send statistical information about the current Profile to the PSObserver, if it is installed/available. This utility allows for the ability to monitor PeerSync activity across the LAN for the centralized viewing of all PeerSync activity on the network.</td>
</tr>
</tbody>
</table>

Related Options:
- Performance Options
- Command Line Arguments
Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands screen.

2. Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. PeerLock

2.1 PeerLock Job Settings

<table>
<thead>
<tr>
<th>PeerLock Job Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Job Settings</strong></td>
</tr>
<tr>
<td>✓ Include this Job in PeerLock</td>
</tr>
<tr>
<td>✓ Append Default File/Folder Exclusions from PeerLock</td>
</tr>
</tbody>
</table>

Topics

PeerLock Job Settings Overview

2.1.1 PeerLock Job Settings Overview

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now be able to configure PeerLock directly from the PeerSync Profiler. The following options allow you to link the selected Job to PeerLock as well as append the PeerSync exceptions to PeerLock. The options in this window can be accessed from the PeerLock > PeerLock Job Settings window.

| Include this Job in PeerLock | Select this checkbox to automatically add the selected Job to PeerLock. This option can be enabled automatically when selecting the Bi-directional setting. In general PeerLock is used in a collaboration environment where PeerSync is configured for real-time bi-directional synchronization. |
Append Default File/Folder Exclusions from PeerLock

This option is enabled by default. When checked, the PeerSync Exception settings (Include Files, Exclude Files, and Exclude Folders) will be appended to the default/existing list of Exceptions in PeerLock.

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.

2.2 PeerLock Global Settings

PeerLock Global Settings

- Global Settings - Current Profile Linked with 1 Jobs

- Link this Profile to PeerLock

- Disable Jobs that are Not Configured from this Profile

Save Changes in PeerLock

Related Global Settings

- To view/edit Global Options in PeerLock, click here

Global Options

Show PeerLock - Version: 3.6.5.0

- To show the PeerLock application, click here

Show PeerLock

Topics

PeerLock Global Settings Overview

2.2.1 PeerLock Global Settings Overview

PeerLock Global Settings

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync, you will now be able to configure PeerLock directly from the PeerSync Profiler. The following options allow you to add the selected PeerSync Jobs to PeerLock and launch the PeerLock application or Global Options for configuration. The options in this window can be accessed from the PeerLock > PeerLock Global Settings window.

Link this Profiler to PeerLock

If this global setting is enabled, all the Jobs that have the "Include this Job in PeerLock" option selected will be added to PeerLock. These Jobs in PeerLock will be managed by PeerSync and cannot be edited/removed directly from the PeerLock interface. Un-checking this option will remove all PeerSync managed Jobs from the PeerLock interface.
### Disable Jobs that are Not Configured from this Profiler

Selecting this option then saving the PeerSync Profiler or clicking on the "Save Changes in PeerLock" link will remove/delete any existing Jobs from the PeerLock configuration. Only Jobs that are managed by PeerSync will be maintained.

### Save Changes in PeerLock

Click on this link to commit your PeerSync Job/Profile updates to PeerLock. This link becomes available when you make Job or Profile changes that need to be saved and applied to PeerLock (i.e. Source/Target path update, Exceptions, ...). This can be achieved also by clicking on the Save button from the Toolbar or File Menu. If there are no Profile updates to be saved, this link will be unavailable.

### Global Options

Selecting this link will open the PeerLock Global Options dialog that contains the configuration settings for all the Jobs in PeerLock. When the application is terminated/closed this link will become available.

### Show PeerLock

You can run PeerLock as an application or as a service. Clicking on this link will launch the PeerLock interface where you can start PeerLock to run as an application or as a service. You can also start/stop the PeerLock service directly from the PeerLock Run/View window in the PeerSync Profiler.

Through the PeerLock interface you will be able to view the files that are Locked or Released by PeerLock when it is running as an application. This status information is not available when PeerLock is running as a Service. The PeerLock Jobs that are managed by PeerSync will be un-editable. When the application is terminated/closed this link will become available.

Note: You will need the PSObserver product in order to view the PeerLock status while running as a service.

### Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to all of the Jobs in the current Profile.

2. PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.
3. Startup/Service

3.1 PeerSync Startup/Service

3.1.1 PeerSync Startup/Service Overview

### PeerSync Startup/Service Options

The options in this window can be accessed from the "Startup/Service" > PeerSync Startup/Service window. This screen allows the user to specify whether or not PeerSync will be run upon startup of the active PC, while also defining its interaction with the network (if applicable). This screen provides shortcuts for installing PeerSync as a service, adding it to the Windows StartUp list, or to the Windows registry for automatic loading upon startup.

<table>
<thead>
<tr>
<th>Disable all Startup Options</th>
<th>Check this feature to prevent PeerSync from automatically loading at Windows startup/logon.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Shortcut on Desktop</td>
<td>This button will place the current Profile into a shortcut on your desktop (See &quot;Scan at Start of Profile List,&quot; Options/Command ). A Profile Shortcut will need to be created through this feature in order to use PeerSync's Command Line Mode.</td>
</tr>
<tr>
<td>Add to Windows StartUp</td>
<td>This button opens the Windows StartUp folder, showing links to files and programs that open automatically upon user logon. This button is only accessible when &quot;Add to Windows Startup Folder&quot; is checked.</td>
</tr>
<tr>
<td>Add to Windows registry</td>
<td>Check this feature if you want PeerSync to run automatically when Windows boots through specification in the Windows registry.</td>
</tr>
<tr>
<td><strong>Run RegEdit</strong></td>
<td>This button opens the Windows Registry Editor. This button is only accessible when &quot;Add to Windows registry to run at boot&quot; is checked.</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Install as an NT Service** | Check this feature if you want PeerSync to run automatically as a service under Windows NT. Click here for a Tutorial on how to install PeerSync to run as an NT Service.  

To configure and run the service you must go to "Services" located in the "Control Panel" and select "PeerSync Professional Series Software." By default the service is installed with the "Local System account" selected for the service "Log on as:" option.  

Caution: If any of your Source or Target Folder Selections are not located on the local machine, then you will have to configure the service to "Log on as:" an alternate (Domain Admin) account on your domain so that the service has the rights to access the remote machines and/or devices. If you do not do this the service may not run properly. |
| **Notes:** |  
1. If PeerSync is running as a Service it is advised to use UNC paths or PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of using mapped drives do to the fact that mapped drives are not understood when a user is not logged on.  

2. You can add the argument /LSE (Log Service Events to NT Application Log) to the following entry in the registry (HKEY_LOCAL_MACHINE\Software\PeerSoftware\PeerSync\Service\Parameters). This will have PeerSync log all changes to be reported to application log in addition to the normal logging of the start, stop, pause and continue of the service.  

3. If PeerSync is running in Real-Time mode as a service, subsequent real-time Profiles will interfere with service operation and should not be employed. Both Scheduled Operations and Manual (non-persistent) operations should perform without interference to a service installation of PeerSync. |
| **Details** | This button is used to view the details of the currently installed PeerSync service. |
| **Remove** | This button is used to remove the currently installed PeerSync service. |
| **Create SNC extension association for Profiler** | Checking this feature causes any file with the extension .SNC to be associated with PeerSync: PeerSync Profiles bear this extension by default. Once this feature has been selected, double/clicking on any SNC file will open Profiler and load that particular file. |
| **Add Quick-Sync Folder option to Explorer menu** | Checking this feature adds or removes the Quick-Sync Folder selection from Windows Explorer. This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s) with the option to modify your Job settings at a later time. |
| **PeerSync Application Path** | This field is used to specify the location of the PeerSync executable file. You can use the open folder icon to browse drives in order to locate this executable file. |
Starting Profiles

The following describes ways in which PeerSync can be launched or started.

<table>
<thead>
<tr>
<th>From the Profiler</th>
<th>Externally without the Profiler</th>
</tr>
</thead>
<tbody>
<tr>
<td>By using the Launch Profile Menu Item in the Run Menu</td>
<td></td>
</tr>
<tr>
<td>By using the Launch Current Profile button on the Tool Buttons Toolbar</td>
<td></td>
</tr>
<tr>
<td>By using the Launch Current Profile button on the Run/View Current Profile Activity screen</td>
<td></td>
</tr>
<tr>
<td>Setup/run from a Shortcut on the Desktop</td>
<td></td>
</tr>
<tr>
<td>Setup/run from the Startup Folder</td>
<td></td>
</tr>
<tr>
<td>Setup/run at boot from the Registry</td>
<td></td>
</tr>
<tr>
<td>Setup/run as a NT Service</td>
<td></td>
</tr>
<tr>
<td>Setup/run using the Windows Task Scheduler</td>
<td></td>
</tr>
</tbody>
</table>

Notes:

1. Individual Jobs can be synchronized using the ‘Synchronize Selected Jobs’ feature, found in the Profile Job List Popup Menu.

2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from MS Windows Explorer.

3.2 PeerLock Startup/Service

Run/View PeerLock:

- Path: C:\Program Files\PeerLock\3.6.5\PeerLock.exe
- Status: Service Stopped
- Version: 3.6.5.0

- [Start] [Stop] [Pause] [Resume] [Run as a service]

Topics

PeerLock Startup/Service Overview
3.2.1 PeerLock Startup/Service Overview

PeerLock Startup/Services Options

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now be able to configure PeerLock directly from the PeerSync Profiler. This window provides a way in which you can install the PeerLock service directly from the PeerSync Profiler interface. The options can be accessed from the "Startup/Service" > PeerLock Startup/Service window.

| Install PeerLock Service | Check this feature if you want PeerLock to run automatically as a service under Windows NT. To configure and run the service you must go to the Services window by clicking on the "Details" > "Show Services" button and select "PeerLock Utility Software" item. By default the service is installed with the "Local System account". If your Source or Target folder is not located on the local machine, then you will have to configure the service to "Log on as:" an alternate (Domain Admin) account on your domain so that the service has the rights to access the remote machines and/or devices. Otherwise the service may not run properly.

Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock as a Service do to the fact that mapped drives are not understood when a user is not logged on. |
| Details | This button is used to view the details of the currently installed PeerLock service. |
| Remove | This button is used to remove the currently installed PeerLock service. |
| PeerLock Path | This field is used to specify the location of the PeerSyncPeerLock executable file. You can use the open folder icon to browse drives in order to locate this executable file. |

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.
4. Run/View

4.1 PeerSync Run/View

PeerSync can be run as an Application or as an NT Service, if available and installed from the Startup/Service screen.

This screen is used to launch the current Profile and to view current Profile activity. If the Display Status in Profiler option is turned on from the Options/Commands screen this screen will be shown upon execution of a Profile and will dynamically show the status of synchronization of the current Profile as the process occurs. This screen will also be shown upon using the Synchronize Selected Jobs feature, found in the Profile Job List Popup Menu to display the Current Activity of the Jobs sent to PeerSync as a temporary Profile.

- **Profile**: Displays the name of the Profile actively being processed. This label may not match the name of the Profile currently being configured through Profiler.
- **Job**: This indicator will dynamically display the name of whichever Job is presently being processed for the Active Profile.
- **Mode**: This indicator will dynamically display the name of whichever Job is presently being processed for the Active Profile.
- **Launch Current**: This button allows you to launch the current Profile. Once a
| **Profile/Terminate**  
<p>| <strong>Active Profile</strong> | Profile has been launched, its processing may also be terminated through this button (the label will change to read &quot;Terminate Active Profile&quot;). This button offers one of three ways to initiate an Automatic Operation. |
| <strong>View Active Profile</strong> | This button allows you to connect to and view the Active Profile. |
| <strong>Run as a service</strong> | If PeerSync is installed as a Service you have the option of running it as an Application or as a Service from this screen. |
| <strong>Start/View Service</strong> | This button allows you to start the current Profile as a Service or view the Active Profile. |
| <strong>Stop Service</strong> | This button allows you to stop the current Profile as a Service. |
| <strong>Pause Service</strong> | This button allows you to pause the current Profile as a Service. |
| <strong>Resume Service</strong> | This button allows you to resume the current Profile as a Service. |
| <strong>Source</strong> | Displays a file path for the Source Folder presently being synchronized. |
| <strong>Target</strong> | Displays a file path for the Target Folder presently being synchronized from the Source indicated above. |
| <strong>Folders</strong> | This indicator provides a count of all unsynchronized folders contained within the Source, and will decrease as each folder is synchronized. An additional &quot;thermometer&quot; indicator will also track the progress of folder synchronization. |
| <strong>Files</strong> | This indicator displays the total number of files contained within the Source while also providing a count of synchronized files. In addition, a &quot;thermometer&quot; indicator will show file synchronization progress by increasing according to the size of the current folder, with 100% representing the cumulative size of files contained within the Source Job set. |
| <strong>File</strong> | Indicates the name of the file currently being synchronized. |
| <strong>Large File or Compression Status</strong> | This caption will be displayed to the right of the file name that is currently synchronized for large files and during compression. The caption will show the size of the file that has been copied to the Target and/or compression status. |
| <strong>Skip File</strong> | This button will appear once the active Profile has been launched. This feature allows you to skip synchronization of the file currently displayed in the indicator described below. Skip Files enables you to avoid delays caused by large files on slow network or dial-up connections. |
| <strong>Size</strong> | Indicates the size (in bytes) of the file currently being synchronized. A related &quot;thermometer&quot; indicator tracks the progress of synchronization for that file. |</p>
<table>
<thead>
<tr>
<th>Checked</th>
<th>This indicator displays the total number of files contained in the selected Source Folders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded</td>
<td>Indicates the number of files that were excluded from synchronization (See Exceptions).</td>
</tr>
<tr>
<td>Messages</td>
<td>Indicates the number of error messages generated during Profile processing.</td>
</tr>
<tr>
<td>Updated</td>
<td>Indicates the number of Target Files that were updated during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td>Added</td>
<td>Indicates the number of new files added to Target Folders during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td>Deleted</td>
<td>Indicates the number of files deleted (or moved) during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td>Current Job Status</td>
<td>This indicator displays the status of the active Job. The indicator may display one of the following: Blackout, Source/Target disconnected (Job name), Connecting to Target Folder (Folder), or Normal.</td>
</tr>
<tr>
<td>Pending Event Status</td>
<td>This indicator displays the number of pending items. The indicator may display one of the following: Pending Items (Events: n) (Managed Files: x) or No Pending Items</td>
</tr>
<tr>
<td>Current Event Status</td>
<td>This indicator display the status of the events pertaining to Job/Copy thread information or Job automation (such as next scheduled interval, daily timer info etc.). The indicator may display one of the following: Running Items (Job Scans: x) (Copy Threads: y) (Failed Events: z)</td>
</tr>
<tr>
<td>Total Transferred</td>
<td>Indicates the the total amount of bytes transferred for the entire running Profile.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>Indicates the amount of time that has elapsed during the current Profile activity.</td>
</tr>
<tr>
<td>Show Advanced/Normal Display</td>
<td>Click on this link to toggle between the Normal and Advanced Run/View PeerSync panels.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click on this link to force a manual reload of the Run/View PeerSync panel and the statistics that are being displayed.</td>
</tr>
</tbody>
</table>

### 4.1.2 Advanced Display

**Jobs Stats**

To see this panel, click on the Show Advanced Display link at the bottom right corner of the Run/View PeerSync window. The Enable Advanced Display option must be checked in order for this link to be active. The Jobs Stats display is the top panel and contains runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update the bottom Advanced Run/View PeerSync panel. Click on the All Jobs entry to display all the Job statistics, cumulatively, in the bottom panel.

| # | Represents the automatically assigned Job number for each |
Job. An icon represents the state of the Job (Green, Yellow, or Red):

- **Green**: Running with no failed events
- **Yellow**: Warning state indicates the Job is running with failed events
- **Red**: Failed connection and/or offline/stopped

<table>
<thead>
<tr>
<th><strong>Job Name</strong></th>
<th>Lists the unique name for each Job.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Last Scan (Status: Duration)</strong></td>
<td>Displays the date and time of the last scan along with a description of the scan state and duration. For example: 11/17/2011 4:28:31 PM (Completed Successfully: 00:06:05)</td>
</tr>
<tr>
<td><strong>Xfer Rate</strong></td>
<td>Determines the transfer rate in megabits per second for each Job. Takes into account the Event Averages rate and Total Transferred and Total Saved bytes (bottom right corner of Run/View PeerSync) to determine the transfer rate for each Job. The more events and the larger the average file size calculated in the Event Averages the more accurate the transfer rate will be. This also shows a cumulative transfer rate for all Jobs.</td>
</tr>
<tr>
<td><strong>Bytes</strong></td>
<td>Displays the total number of bytes that were transferred for the specific Job or all the Jobs.</td>
</tr>
<tr>
<td><strong>Events</strong></td>
<td>Shows the total number of events detected for the Job or all the Jobs as well as number of active events currently being processed.</td>
</tr>
<tr>
<td><strong>Event Averages</strong></td>
<td>Displays the average number of events that occurred per minute. The average size of the events are also noted.</td>
</tr>
<tr>
<td><strong>Failed Events</strong></td>
<td>Total number of failed events for the selected Job or all the Jobs.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Shows the status of each Job or all Jobs.</td>
</tr>
<tr>
<td><strong>Added</strong></td>
<td>Counter indicating the total number of files that were added and their size in bytes.</td>
</tr>
<tr>
<td><strong>Daily Timer Scans</strong></td>
<td>Information when the next scheduled scan is to occur.</td>
</tr>
<tr>
<td><strong>Deleted</strong></td>
<td>Counter indicating the total number of files that were deleted and their size in bytes.</td>
</tr>
<tr>
<td><strong>Excluded</strong></td>
<td>Counter indicating the total number of files that were excluded and their size in bytes.</td>
</tr>
<tr>
<td><strong>Interval Scans</strong></td>
<td>Information when the next interval scan is to occur.</td>
</tr>
<tr>
<td><strong>Log File Path</strong></td>
<td>Displays the location of the log file. Used in pop-up menu.</td>
</tr>
<tr>
<td><strong>Messages</strong></td>
<td>Counter indicating the total number of messages.</td>
</tr>
<tr>
<td><strong>Next Scan (Run in)</strong></td>
<td>Count down to the next scan for scheduled or interval scans.</td>
</tr>
</tbody>
</table>
### Real-Time
Displays the state of Real-Time detection.

<table>
<thead>
<tr>
<th>Scan Needed</th>
<th>Lets you know if a scan is needed (Yes) or not (No) after a connection failure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Displays the source path.</td>
</tr>
<tr>
<td>Target</td>
<td>Displays the target path.</td>
</tr>
<tr>
<td>Updated</td>
<td>Counter indicating the total number of files that were updated and their size in bytes.</td>
</tr>
</tbody>
</table>

### Jobs Stats (Right-Click Pop-Up Menu)
To see this menu, right-click on the Job Stats panel.

<table>
<thead>
<tr>
<th>Select Columns....</th>
<th>Add or remove columns from the Jobs Stats display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Log File</td>
<td>View the log file for the selected Job.</td>
</tr>
<tr>
<td>View Source Folder: Path</td>
<td>Opens the source folder in a Windows Explorer window.</td>
</tr>
<tr>
<td>View Target Folder: Path</td>
<td>Opens the target folder in a Windows Explorer window.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the current Jobs Stats list into a CSV file format (i.e. PSJobStats.csv).</td>
</tr>
<tr>
<td>Reprocess Failed Events</td>
<td>If the Job is running in a Warning state (Yellow), the Job has failed events. Selecting this option will notify PeerSync to re-process any failed events. This option is also available in the Run menu.</td>
</tr>
</tbody>
</table>

### Advanced Run/View PeerSync
To see this panel, click on the Show Advanced Display link at the bottom right corner of the Run/View PeerSync window. The Enable Advanced Display option must be checked in order for this link to be active. The Advanced Run/View PeerSync display is the bottom screen. In addition to containing the same information as the Basic Display, the Advanced Display contains the following additional tabs:

<table>
<thead>
<tr>
<th>Status</th>
<th>Containing the same information as the Basic Display view/panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated</td>
<td>Lists the total number of files that were updated for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSUpdated.csv).</td>
</tr>
<tr>
<td>Added</td>
<td>Lists the total number of files that were added for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSAdded.csv).</td>
</tr>
<tr>
<td>Deletions</td>
<td>Lists the total number of files that were deleted for the selected</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Excluded</td>
<td>Lists the total number of files that were excluded for the selected Job or all the Jobs. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSExcluded.csv).</td>
</tr>
<tr>
<td>Messages</td>
<td>Lists the total number of messages for the selected Job or all the Jobs. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSMessages.csv).</td>
</tr>
<tr>
<td>Job Scans</td>
<td>Lists how many scans are running at a Job level either for the selected Job or for all the Jobs. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSJobScans.csv).</td>
</tr>
<tr>
<td>Managed Files List</td>
<td>Lists the total number of files that are in the Managed Files List for the selected Job or all the Jobs. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSManagedFilesList.csv).</td>
</tr>
<tr>
<td>Failed Events</td>
<td>Lists all the failed files for the selected Job or all the Jobs. You can right-click the list and select <strong>Reprocess Failed Events</strong> to notify PeerSync to re-process them for all the Jobs (not Job specific). To reprocess only a specific file, you can click the <strong>Reprocess Selected</strong> button from the Failed Events tab within the PeerSync Status Display (when running as an application only). Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSFailedEvents.csv).</td>
</tr>
<tr>
<td>File Copy Progress</td>
<td>Visually displays the file copy progress for each file for the selected Job or all the Jobs. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSFileCopyProgress.csv).</td>
</tr>
<tr>
<td>Historical Data</td>
<td>This panel displays a subset of the Job Stats table (Xfer Rate, Bytes and Event Averages) in an hourly, daily, weekly, and total format for all the Jobs or only the selected Job. Furthermore, it displays a Running Event Count, a Running Event Average and Peak Count, and a Running Job Count. Right-click and select <strong>Save As</strong> to export the list into a CSV file format (PSHistoricalData.csv).</td>
</tr>
</tbody>
</table>

**Notes:**

For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerSync panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary event files that will be loaded into the advanced display screens/tabs.
4.2 PeerLock Run/View

Run/View PeerLock

Path: C:\PROGRA~2\PeerLock\3.6.5\PeerLock.exe
Status: Service Stopped
Version: 3.6.5.0

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Launch PeerLock**: This button allows you to launch the PeerLock application and monitor the files that are Locked or Released by PeerLock. When the application is terminated, this button will become available.
- **Run as a service**: This option is available only if the PeerLock service has been installed and the **Run as a Service** option is enabled. Check this option to run PeerLock as a Service. When checked, you will have the options to Start, Stop, Pause and Resume the Service. Uncheck the "Run as a service" option to run PeerLock as an Application. When this option is uncheck, you will have a "Launch PeerLock" button available.
- **Start Service**: This button allows you to start PeerLock as a Service. This option is available if the PeerLock service has been installed, the **Run as a Service** option is enabled, and the PeerLock...
service is stopped or not running.

**Stop Service**
This button allows you to stop the PeerLock Service. This option is available if the PeerLock service has been installed, the Run as a Service option is enabled, and the PeerLock service is running.

**Pause Service**
This button allows you to pause the PeerLock Service. This option is available if the PeerLock service has been installed, the Run as a Service option is enabled, and the PeerLock service is running.

**Resume Service**
This button allows you to resume the PeerLock Service. This option is available if the PeerLock service has been installed, the Run as a Service option is enabled, and the PeerLock service is paused.

**Show Advanced/ Normal Display**
Click on this link to toggle between the Normal and Advanced Run/View PeerLock panels.

**Refresh**
Click on this link to force a manual reload of the Run/View PeerLock panel and the statistics that are being displayed.

### 4.2.2 Advanced Display

**Jobs Stats**
To see this panel, click on the Show Advanced Display link at the bottom right corner of the Run/View PeerLock window. The Enable Advanced Display option must be checked in order for this link to be active. The Jobs Stats display is the top panel and contains runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update the bottom Advanced Run/View PeerLock panel. Click on the All Jobs entry to display all the Job statistics, cumulatively, in the bottom panel.

| #          | Represents the automatically assigned Job number for each Job. An icon represents the state of the Job (Green, Yellow, or Red):
|           | Green Running with no failed locks
|           | Yellow Warning state indicates the Job is running with failed locks
|           | Red Failed connection and/or offline/stopped
| Job Name   | Lists the unique name for each Job.
| Locks (Active) | Represents the total number of locks created by the specific Job. The total number of locks that are actively being held are also shown.
| Releases   | Shows the total number of releases created by the specific Job.
| Lock Average | Represents the number of locks that are created on average ever minute for the specific Job.
<table>
<thead>
<tr>
<th><strong>Release Average</strong></th>
<th>Represents the number of locks that are released on average every minute for the specific Job.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Failed Locks</strong></td>
<td>Shows the total number of locks that failed to be created for the specific Job.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Displays the status of the Job (i.e. Stopped, Starting and Normal).</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>The folder which is monitored for open activity.</td>
</tr>
<tr>
<td><strong>Target</strong></td>
<td>The folder which is contains the files for PeerLock to lock.</td>
</tr>
</tbody>
</table>

**Jobs Stats (Right-Click Pop-Up Menu)**

<table>
<thead>
<tr>
<th><strong>Select Columns....</strong></th>
<th>Add or remove columns from the Jobs Stats display.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Log File: Path</strong></td>
<td>Open the log file in the default editor for the selected Job.</td>
</tr>
<tr>
<td><strong>Open Source Folder: Path</strong></td>
<td>Opens the source folder in a Windows Explorer window.</td>
</tr>
<tr>
<td><strong>Open Target Folder: Path</strong></td>
<td>Opens the target folder in a Windows Explorer window.</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Saves the current Jobs Stats list into a CSV file format (i.e. PLSelectionList.csv).</td>
</tr>
</tbody>
</table>

**Advanced Run/View PeerLock**

To see this panel, click on the **Show Advanced Display** link at the bottom right corner of the Run/View PeerLock window. The **Enable Advanced Display** option must be checked in order for this link to be active. The **Advanced Run/View PeerLock** display is the bottom screen. In addition to containing the same information as the **Basic Display**, the Advanced Display contains the following additional tabs:

<table>
<thead>
<tr>
<th><strong>Target File Path</strong></th>
<th>Shows the file name complete with folder path for a target file that is locked, if the file exists and/or can be locked.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Locked</strong></td>
<td>Display the date/time when the target file was locked.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Displays the amount of time that the source file has been opened.</td>
</tr>
<tr>
<td><strong>Accessed By</strong></td>
<td>The name of the user who has opened the file or accessed the resource.</td>
</tr>
<tr>
<td><strong>Target Access Allowed</strong></td>
<td>Displays the permissions that are allowed on the opened target file which are applied by PeerLock.</td>
</tr>
<tr>
<td><strong>Source File Path</strong></td>
<td>Displays the file name complete with folder path for the source file that has been detected as an open file.</td>
</tr>
<tr>
<td><strong>Job Number</strong></td>
<td>Represents the automatically assigned Job number for each Job.</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong># Locks</strong></td>
<td>Displays the number of locks on the source.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Displays the application that has been detected as opening the source file.</td>
</tr>
<tr>
<td><strong>Detection Type</strong></td>
<td>This column represents the PeerLock detection mode used to detect what source files are locked/opened. This will either be File Server Mode Detection or Local Detection. Note: Starting with version 3.0, PeerLock supports File Server Mode Detection only.</td>
</tr>
<tr>
<td><strong>Idle Time</strong></td>
<td>Shows the amount of time the target file will remain locked once the source file has been released. When the source file is closed PeerLock will wait the number of Idle Time seconds specified before releasing the target file. During the Idle Time period the file entry in the Locked list will be highlighted Yellow. The Idle Time value can be set in the Release Options dialog. This feature is intended to protect the releasing of files during file opens and saves. Certain applications may temporary release files during these procedures. With this feature enabled PeerLock will wait the set period of time to make sure the file is fully released before unlocking the corresponding target files.</td>
</tr>
<tr>
<td><strong>Lock File Handle</strong></td>
<td>Displays the handle value created that is being used to lock the temporary Lock File created by PeerLock to Interact with other Peer Software Products. If the Interact features are disabled then this will display 'None'.</td>
</tr>
<tr>
<td><strong>Release Detected</strong></td>
<td>Shows the date and time when PeerLock detected the source file was closed. This value will be cleared if the file is reopened within the Idle period and the target file handle is not released.</td>
</tr>
<tr>
<td><strong>Source Access Allowed</strong></td>
<td>Displays the permissions that are allowed on the opened source file.</td>
</tr>
<tr>
<td><strong>Source Attributes</strong></td>
<td>Shows the attributes of the source file.</td>
</tr>
<tr>
<td><strong>Source Handle</strong></td>
<td>Displays the handle value created when the source file was opened.</td>
</tr>
<tr>
<td><strong>Source Modified</strong></td>
<td>Shows the modified date/time of the source file when it was detected as being open.</td>
</tr>
<tr>
<td><strong>Source Open Mode</strong></td>
<td>Displays the permissions that were used to open the source file.</td>
</tr>
<tr>
<td><strong>Target Handle</strong></td>
<td>Display the handle value created that is being used to lock the target file by PeerLock.</td>
</tr>
<tr>
<td><strong>Target Open Mode</strong></td>
<td>Displays the permissions that were granted when the target file was locked by PeerLock.</td>
</tr>
<tr>
<td><strong>Temporary Releases</strong></td>
<td>Shows the number of times the source file was closed during</td>
</tr>
</tbody>
</table>
the Idle period.

Notes:
For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerLock panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary event files that will be loaded into the advanced display screens/tabs.

Command Line Arguments
PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off" installation, where operation and distribution occurs from within an easily manageable, administrative environment. This mode allows Profiles to be executed from logon scripts, system batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands -- while also providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler first in order to be further modified through the arguments described in this topic (See Profiler Overview and related Help Topics).

Command Line Arguments are entered into a Profile shortcut, created during build through the "Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:
1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the format outlined in the examples provided.
2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other arguments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.

Profiler Command Line Arguments
As noted above, Profile (.SNC) file names are the only variables associated with operation of Profiler. To change an .SNC file name through the command line:

1. Right click the Profile shortcut you created during build (see Startup/Service, "Add to Desktop" button).
2. Select the "Properties" item from the pop-up menu.
3. Select the "Shortcut" tab. As shown in the following sample, the "Target" field will contain a command line for the Profile, where "Profile One" represents a sample Profile name: "C:\Program Files\PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\Profile One.SNC" /USEPROFILEARG
4. Manually change the Profile Name to reflect that of the new .SNC file
5. Click the "OK" button

PeerSync Command Line Arguments
The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
1. Configuration Arguments

Configuration Arguments

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

/0:Profile
Set SNC File to Load (Profile = File): If the /0 argument is used in a shortcut or from the command line, PeerSync will load the Job information specified in the file.

Examples:
/0:"C:\My SNC\MyBackups.snc"
/0:MyBackups.snc

/1:source
Set Source Path (source = Folder): If the /1 argument is used in a shortcut or from the command line, PeerSync will use it in conjunction with /2 to define a Source and Target path for a Job.

Example:
/1:\source /2:c:\target

/2:target
Set Target Path (target = Folder): If the /1 argument is used in a shortcut or from the command line, PeerSync will use it in conjunction with /2 to define a Source and Target path for a Job.
Example:
/1:c:\source /2:c:\target
c:\source to c:\target

/C:cfile
Load Alternate Configuration File (cfile = File): If the /C argument is enabled, PeerSync will use the values specified in cfile for synchronization information instead of using the default configuration file: PSDef.cfg which is located in the install directory.

Example:
/C:C:
\PeerSync\configs\altconfig.cfg

/USEPROFILEARG
Use Arguments from Profile: If the /USEPROFILEARG argument is used in conjunction with a /0:Profile, PeerSync will use the arguments specified in Profile, for synchronization. By default, when you create a shortcut on the desktop or in the startup folder from the StartUp Options screen this argument is used.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx.

2. FTP Arguments

FTP Arguments
The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

/FTPPASSIVE
Force FTP passive mode on: The /FTPPASSIVE argument forces on the passive mode option for all Jobs using FTP in a Profile.

/GH:mm-dd-yy
Set FTP Short Date Format: The /GH argument sets the Short Date Format used in FTP transmission. This feature is necessary if an FTP Server uses a non-standard date format.

Example: /GH:dd-yy-mm

/GJ:x
Set FTP Failed Upload Retry Count: The /GJ argument sets the number of times PeerSync will attempt to upload a file after it has failed.
Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the FTP add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx

3. Performance Arguments

Performance Arguments

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A/M).

/GE:x
Set Shared Process Delay: The /GE argument is used to set the shared process delay to allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU) will use the most delay and 10 (more CPU) will use the least amount of delay.

/GK:x
Copy Thread Utilization: If the /GK argument is enabled, PeerSync will allow up to x threads to watch the queue that manages changes allowing for increased Copy Thread utilization.

/GP:x
Set Email Threads: If the /GP argument is enabled, PeerSync will allow up to x threads to be used for email tasks.

/LK:x
Set Multitasking Delay: The /LK argument is used to adjust the delay during multitasking. This value may be set between 1 and 10 where 10 is the highest amount of delay and 1 is the least amount of delay. The default value is 4.

/LN:x
Set Processor Affinity: If the /LN argument is enabled, PeerSync will allow you to limit which CPUs to use in a multi-processor environment, where each CPU is represented by 2 to the x value:

/LN:1 = Use CPU 1
/LN:2 = Use CPU 2
/LN:3 = Use CPU 1, CPU 2
/LN:4 = Use CPU 3
/LN:5 = Use CPU 1, CPU 3
/LN:6 = Use CPU 4
/LN:7 = Use CPU 1, CPU 4
/LN:8 = Use CPU 5
/LN:9 = Use CPU 1, CPU 5
/LN:10 = Use CPU 6
/LN:11 = Use CPU 1, CPU 6
/LN:12 = Use CPU 7
/LN:13 = Use CPU 1, CPU 7
/LN:14 = Use CPU 8
/LN:15 = Use CPU 1, CPU 8
/LN:16 = Use CPU 5

Examples:

/LN:1 = Use CPU 1
/LN:3 = Use CPU 1, CPU 2
/LN:4 = Use CPU 3
/LN:5 = Use CPU 1, CPU 3
/LN:1 + /LN:2 = /LN:3
/LN:1 + /LN:4 = /LN:5
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **/LN:15** | Use CPU 1, CPU 2, CPU 3, CPU 4 \((/LN:1 + /LN:2 + /LN:4 + /LN:8 = /LN:15)\)  
Note: By default all CPUs will be used. |
| **/MCT:** | Set Copy Threads: If the /MCT argument is enabled, PeerSync will allow up to \(x\) file copy threads to be spawned for file copy tasks. These copy threads will be shared by one or more Jobs during the synchronization process.  
Note: This item is selectable from the Profiler via the Options/Commands Screen. |
| **/MFT:** | Set Job Threads: If the /MFT argument is enabled, PeerSync will allow up to \(x\) Job threads to be spawned for managing Job tasks.  
Note: This item is selectable from the Profiler via the Options/Commands Screen. |
| **/OPTIMIZE** | Optimize Performance: If the /OPTIMIZE argument is enabled, PeerSync will disable status screen windows used for outputting status information. This will minimize memory allocation for the User Interface. |
| **/PERFORMANCE:** | Set Application Priority: If the /PERFORMANCE argument is enabled, PeerSync will set the application's priority based on the following value of \(x\)  
0: Lowest Priority  
1: Below Average Priority  
2: High Priority.  
Notes:  
1. This item is selectable from the Profiler via the Options/Commands Screen.  
2. If the /PERFORMANCE argument is not used, PeerSync will use a default priority.  
3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use the Set Processor Affinity argument in this scenario. |
| **/YK:** | Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to reserve for Real-Time events, where \(n\) can be set between the values of 1 and 99. The default value is 10. |
| **/YX:** | Set File Read/Write Buffer Delay: Used to set a delay in \(n\) milliseconds between each file read/write cycle to allow the limiting of CPU usage and system resources during file transfers. The higher the delay value, the less CPU used but the slower the performance or speed of PeerSync. |
| **/QR** | Exclude Common Job Exceptions in Event Processing: Checks the global exclusions before file hits such as before event processing and before adding the event to the visual list. |
Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx.

4. Reporting and Display Arguments

<table>
<thead>
<tr>
<th>Reporting and Display Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A/M).</td>
</tr>
</tbody>
</table>

| /AP | Run Pre-Sync Report: If the /AP argument is used a Pre-Sync Report will be generated and files/folders will not be synchronized. If you add an O to the /AP then the previous Pre-Sync report will be Over written, if you exclude the O then the file will be appended to an existing Pre-Sync report. If you add an S to the /AP then the Pre-Sync report will be Shown at the end of the run (i.e.: /AP, /APO, /APOS or /APS). |
| /GL[S] | Display status in Profiler: If the /GL argument is used, PeerSync will open the Profiler, if it is not already open, and send status messages to be displayed on the Run/View Current Profile Activity screen using mail slot messaging to communicate with the Profiler. By adding an S you can suppress the initial connection of PeerSync to the Profiler upon activation of PeerSync. |
| /GM:x | Enable MSMQ messaging: If the /GM argument is used, PeerSync will use x as the location to manage messages in the queue. |
| /GO[y][C:group] | Enable PSObserver Broadcasts: If the /GO argument is used, PeerSync will use mail slots to broadcast activity across the LAN to the PeerSync LAN Observer Utility for the centralized viewing of all PeerSync activity on the network. You can launch the PeerSync LAN Observer Utility, if it is installed/available from the View Menu. y: Identifies the number of seconds between each broadcast. The default is 3 seconds. group: Identifies a group for the current Profile. The default is the Profile Name. |

Example: /GM:DIRECT=TCP:209.51.171.142:PRIVATE$\MYQUEUE

Example: /GO:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/GQ:[file][maxsize]</td>
<td>Create and Append Summaries into One Report: If the /GQ argument is used, PeerSync will append summaries into one log file.</td>
</tr>
<tr>
<td>/GR</td>
<td>Report Non Standard Events: If the /GR argument is used, PeerSync will report non-add, update, and delete actions.</td>
</tr>
<tr>
<td>/GS:x</td>
<td>Enable Summary Statistics Collection: If the /GS argument is used, PeerSync will use x as the file location to save summary statistics.</td>
</tr>
<tr>
<td>/H</td>
<td>Hide Splash Screen: Available through all registered versions of PeerSync, this argument will suppress and hide the splash screen from the Taskbar for both the PeerSync and Profiler applications.</td>
</tr>
<tr>
<td>/H-</td>
<td>Only Hide the about screen: Available through all registered versions of PeerSync, this argument will suppress and hide the About screen for both the PeerSync and Profiler applications.</td>
</tr>
<tr>
<td>/H+</td>
<td>Skip setting of main form visible: Available through all registered versions of PeerSync, this argument will no set the main form visible and always hide the application from the Taskbar for both the PeerSync and Profiler applications.</td>
</tr>
<tr>
<td>/LQ:[file][maxsize]</td>
<td>Enable FTP Logging: If the /LQ argument is used, PeerSync will log FTP activity to the user defined file, or to PS_FTP.LOG by default.</td>
</tr>
<tr>
<td>/LSE</td>
<td>Log Service Events to the Event Viewer: If the /LSE argument is used, PeerSync will log events to the Event Viewer. The following options are available for this argument:</td>
</tr>
<tr>
<td>/LSEE</td>
<td>Log messages as errors</td>
</tr>
<tr>
<td>/LSEEW</td>
<td>Log messages as warnings</td>
</tr>
<tr>
<td>/LSEEM</td>
<td>Only log messages and log them as errors</td>
</tr>
<tr>
<td>/LSEEWWM</td>
<td>Only log messages and log them as warnings</td>
</tr>
<tr>
<td>/M</td>
<td>Show Tray Icon: If the /M argument is used, PeerSync will display an icon in the system tray for PeerSync.</td>
</tr>
<tr>
<td></td>
<td>Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
</tr>
<tr>
<td>/PROGRESS</td>
<td>Display status in PeerSync: This feature will show the PeerSync Status Display dialog box during synchronization so the user can see activity, status and other information while PeerSync is running.</td>
</tr>
<tr>
<td></td>
<td>Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
</tr>
<tr>
<td>/SNMP</td>
<td>Enable SNMP Error Reporting: If the /SNMP argument is used, PeerSync will use SNMP reporting to report any errors that occur during the synchronization process.</td>
</tr>
</tbody>
</table>
Display status in PeerSync upon completion: This feature will have PeerSync show
the PeerSync Status Display dialog box at the end of synchronization (only in non-
persistent modes) so the user can see activity, status and other information upon
completion.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

Log Messages Only to a Log File by Filter and/or by Profile: If the /YL argument
is used, PeerSync will log messages only to a log file based on the Filter and/or Profile.
The following options are available for this argument:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/YL</td>
<td>Log messages for Both</td>
</tr>
<tr>
<td>/YLH</td>
<td>Log messages by Filter Only</td>
</tr>
<tr>
<td>/YLP</td>
<td>Log messages by Profile Only</td>
</tr>
</tbody>
</table>

When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same
directory as the primary log file, with the same file name as the primary log file but with a "flt.log" file extension.

When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile but with a "snc.log" file extension.

Don't Display Job Stats: If the /QP argument is used, PeerSync will not display any Job
statistics in the Status Display window. Disabling this option reduces the amount of
overhead work PeerSync is doing.

XML File Creation Interval: By default PeerSync stores Profile and Job related
statistics into an easily readable XML files on an interval of every 60 seconds (if
applicable) as well as during the completion of a Job scan. This interval can be adjusted
using the /QY7:n command line argument where n represents the interval in seconds of
how often you want PeerSync to update the Profile related XML statistics.

/QY7:(T-)(C-)(A-))(n)

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>(Interval to write out statistics (60 is the default))</td>
</tr>
<tr>
<td>T-</td>
<td>(Suppress .tot file creation)</td>
</tr>
<tr>
<td>C-</td>
<td>( Suppress .cur file creation)</td>
</tr>
<tr>
<td>A-</td>
<td>(Suppress all XML file creation and new logic for tracking file extensions)</td>
</tr>
</tbody>
</table>

Disable Tray Icon Menu Items: If the /YB argument is enabled, PeerSync will allow
you to limit which Tray Icon menu items to be disabled, where each menu item is
represented by 2 to the x value.
Note: To disable multiple menu items simply add the /YB values together for the items you wish to disable.

EXAMPLES

/YB:512 Disables the Exit PeerSync menu option
/YB:24 Disables the Open Source Folder and Open Target Folder options
     8+16=24
/YB:767 Disables All Menu Options except About PeerSync
     1+2+4+8+16+32+64+128+512=767

/QP
Disable Job Stats: If the /QP argument is enabled, the Job Stats option will be unchecked, resulting in no Job statistics being shown in the PeerSync Advanced Display panel.

/Q8BJ+
Enable Job Scans Tab: If the /Q8BJ+ argument is set, a Job Scans tab will be created in the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/Expanded, and RT/Sub-folder scans with statistics and progress for all the Jobs or the selected Job.

/QQ
Enable the File Copy Progress Tab: If the /QQ argument is set the File Copy Progress tab will be created in the Advanced Run/View PeerSync panel to show the progress of a file transfer. This feature requires the Multi-Threading Option.

/Q8BH+
Enable the Historical Data Tab: If the /Q8BH+ argument is set, the Historical Data tab will be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the selected Job.
### Disabling Show Advanced Display

Disable the Show Advanced Display link at the bottom right corner of the Run/View PeerSync screen.

### Notes:

1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any). For more information on the latest features and how to implement specific scenarios please goto our support page at: [http://www.peersoftware.com/support/support.aspx](http://www.peersoftware.com/support/support.aspx)

### 5. Automation Arguments

#### Automation Arguments

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/A</td>
<td>Scan at Start: If the /A argument is appended to the command line, the Profile can be run through its associated shortcut. As non-persistent processes, Automatic Operations are run a single time upon manual initiation by the user. Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
</tr>
<tr>
<td>/D(H):x</td>
<td>Delay Start of Profiler: If this argument is used, PeerSync will delay the load/start of PeerSync by x seconds. With this option enabled synchronization can be canceled via a dialog box if done within the designated interval. For example, /D5 would provide you with a 5 second delay during which the operation can be canceled. If the /D argument includes an H, i.e. /DH60, then the delay timer dialog will be hidden. This argument is useful for allowing PeerSync to begin after other applications have been loaded if you are running PeerSync at Windows startup.</td>
</tr>
<tr>
<td>/R[OyCz]</td>
<td>Real-time Monitoring Argument: The /R argument activates Real-Time Mode. The Oy and Cz arguments are optional and specify the following retry values during Real-Time Mode: y = The retry count if the file is open or network is unavailable z = The retry count maximum Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
</tr>
<tr>
<td>/S</td>
<td>Run Scheduled Operation: The /S argument enables or disables Scheduled Operation Mode for the entire Profile. This feature must be selected in order for all Scheduled Operations set for individual Jobs to be recognized. Scheduled Mode does not</td>
</tr>
</tbody>
</table>
apply a global schedule to the entire Profile: rather, it enables those schedules set for all individual Jobs on to run at their specified intervals.

All Scheduled Operations set for individual Jobs will be ignored if this mode is not selected. If none of the Jobs within a Profile are set for Scheduled Operation and this mode is selected, all active Jobs within the Profile will be assigned a default synchronization schedule of five minutes.

/Sx
Synchronization Timer Argument: The /Sx option is used to run PeerSync automatically at regular intervals. This argument sets PeerSync to synchronize the selected Profile every x minutes. Through this feature PeerSync remains persistent and will not terminate upon completion.

Examples: /S10  Synchronization will be performed every 10 minutes

/SxKz
Synchronization Timer Argument with Keyboard Activity: The /SxKz option is used to run PeerSync automatically at regular intervals only when it senses keyboard activity. This argument sets PeerSync to synchronize the selected Profile every x minutes upon Keyboard activity and will always run every z cycles with/without keyboard activity. The z is optional and will be ignored if set to 0. Through this feature PeerSync remains persistent and will not terminate upon completion.

Note: This item is selectable from the Profiler via the Options Commands Screen.

/TIME
Daily Timer: This argument will allow for scheduling of PeerSync for specific times of the day down to the minute for selected days of the week and selected Jobs within a Profile. If you use a /TIMEF argument all selections at the Job level from the Automation screen will be used. You can also specify Global Daily Timer selections for the entire Profile from the Options/Commands Screen or by using the following format:

1. Select the time of day (by default all Jobs will be run all days)

/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:
Every Day at 12:00 am:  /TIME:00:00
Every Day at 1:00 am:  /TIME:01:00
Every Day at 8:00 am:  /TIME:08:00
Every Day at 8:00 pm:  /TIME:20:00
Every Day at 12:00 pm: /TIME:12:00

2. (Optional) - To select the days of week to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)

Examples:
Sunday:  D:1000000
Monday:   D:0100000
Tuesday:  D:0010000
<table>
<thead>
<tr>
<th>Day</th>
<th>Time</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wednesday</td>
<td>D:0001000</td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td>D:0001000</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>D:0000100</td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>D:0000010</td>
<td></td>
</tr>
</tbody>
</table>

Examples:
- M, W & F at 8:00 am: /TIME:08:00D:0101010
- Sat & Sun at 5:15 pm: /TIME:03:30D:0111110
- Mon - Fri at 3:30 am: /TIME:03:30D:0111110

3. (Optional) - To select the Jobs to run append F:f1;f2;f3

Where f1-fn are the Job numbers.

Examples:
- Job 1 Every day: /TIME:06:00F:1
- Jobs 1 - 5 Every day: /TIME:20:25F:1;2;3;4;5
- Jobs 1, 3 & 5 Mon - Fri at 3:30 am: /TIME:03:30D:0111110F:1;3;5

Note: Will accept multiple command lines.

Example:
- Jobs 1 Every day at 8:00 am, Jobs 1 - 5 Every day at 8:25 pm and Jobs 1, 3 & 5 Mon - Fri at 3:30 am: /TIME:08:00F:1 /TIME:20:25F:1;2;3;4;5 /TIME:03:30D:0111110F:1;3;5

Sample:
- Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon - Fri, minimized on the tray: "C:\Program Files\PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\test.snc" /TIME:3:00D:0111110 /M

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/UDD
Use Device Driver method: This argument uses the Windows NT device driver for real-time detection. When using this argument PeerSync can detect changes made to remote Source folders but only when the changes are made by the machine where PeerSync is installed.

/< Applications to Ignore: If using the Device Driver method for Real-Time detection you can select applications to ignore by appending application names (semicolon delimited) to the /< argument.

Example: /<Explorer.exe;Word. Will ignore any Real-Time changes made by Explorer.exe and Word.exe.

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions (ACLs) is ignored in Real-Time.

/X Disable Initial Synchronization During Startup: The /X command line argument disables initial synchronization during /A /M /R operations at PeerSync startup.
Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx

6. Synchronization Arguments

<table>
<thead>
<tr>
<th>Synchronization Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).</td>
</tr>
</tbody>
</table>

/\GC:x
Set File Comparison Value: If the /GC argument is used, PeerSync will add x seconds to the Target File date and time stamp to use during comparison.

/\GD:n,z:n,z
Set Job Comparison Delta: If the /GD argument is used, PeerSync will add or subtract z seconds from the Target File date and time stamp during a comparison for Job number n.

Example: /GD:1,+30;2,-60:

/\GF
Use Alternate Copy File Methods: The following copy file methods may be invoked:

/GFC Use CopyFile API method
/GFS Use File Stream method
/GFE Use CopyFileEX method
/GFA Transfer Alternate Data Streams - The same functionality can be used at a Job level by using the SETVAR INCLUDEALTFILESTREAMS switch in the Pre/Post paths.

/\GI(S)(D)
Ignore File Size and/or Date Comparison: If the /GI or /GIS argument is used, PeerSync will ignore file size during folder scans (if date matches then skip file). If the /GID argument is used, PeerSync will ignore file date comparison during folder scan (if size matches then skip file). If the /GISD argument is used, PeerSync will ignore file date and size comparison during folder scan (always replace Target file even if they are identical).

/\GT
Get Remote PC Time: If the /GT argument is used, PeerSync will attempt to get the time from the Target PC as well as the local PC and automatically compensate for time differences.

Note: /GT is only applicable in an NT/2K Environment.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/GX</td>
<td>Use Delete Path for Revisions: If the /GX argument is used, PeerSync will use the deletions path for all PSBAK revision files.</td>
</tr>
<tr>
<td>/I</td>
<td>Ignore Target Space During File Copy: The /I argument sets PeerSync to ignore Target space available during file copy.</td>
</tr>
<tr>
<td>/J</td>
<td>Move Files: If the /J argument is used, PeerSync will move files - deleting them from the Source after they have been successfully transferred.</td>
</tr>
<tr>
<td>/KA:x</td>
<td>Active Connection Interval: If the /KA argument is used, PeerSync will attempt to connect every x minutes to Target machine(s).</td>
</tr>
<tr>
<td>/LH:x</td>
<td>Set Deletion Move To Folder Cleanup Interval: If the /LH argument is used, PeerSync will check the Move To Folder (the folder where deleted files are move to), every x minutes to see if files needed to be deleted on the cycle specified by the Delete unmatched Target Files older than x days option.</td>
</tr>
<tr>
<td>/LR [ R</td>
<td>T</td>
</tr>
<tr>
<td></td>
<td>R     Force rename of open Target File</td>
</tr>
<tr>
<td></td>
<td>T     Force terminate of open Target File application</td>
</tr>
<tr>
<td></td>
<td>A     Force terminate of all open Target applications</td>
</tr>
<tr>
<td>/LM:xOvCz</td>
<td>Set Failed Connection Timer: If the /LM argument is used, PeerSync will use the following variables to determine retry frequency:</td>
</tr>
<tr>
<td></td>
<td>x     Approximate time, in minutes, for retry of failed connection (time may vary as much as a few minutes).</td>
</tr>
<tr>
<td></td>
<td>y     Frequency to retry files</td>
</tr>
<tr>
<td></td>
<td>z     Maximum Retry Count</td>
</tr>
<tr>
<td>Example: /LM5O25C100</td>
<td>Checks failed connections every 5 minutes, retries files every 25 seconds, to a maximum retry count of 100.</td>
</tr>
<tr>
<td>Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
<td></td>
</tr>
<tr>
<td>/LMD</td>
<td>Disable Failed Connection Timer: If the /LMD argument is used, PeerSync will not check for failed connections:</td>
</tr>
<tr>
<td></td>
<td>Example: /LMD</td>
</tr>
<tr>
<td>Note: This item is selectable from the Profiler via the Options/Commands Screen.</td>
<td></td>
</tr>
<tr>
<td>/LR:file</td>
<td>Run application at start of PeerSync: If the /LR argument is used, PeerSync will execute an application or shell script specified by file at the initialization of PeerSync.</td>
</tr>
</tbody>
</table>
Example: `/LR:C:\WINNT\notepad.exe`

/\L\W
Enable Last Access Compare: The /\L\W argument allows you to use the last access date/time instead of the modified date/time for comparisons to determine file updates.

/\N\O\D\E\L\F\L\D\R
Do not delete folders: If the /\N\O\D\E\L\F\L\D\R argument is used, PeerSync will not delete folders during synchronization.

/\O
Set Target File Overwrite: The /\O argument sets Target File overwrite on all Jobs.

/\Q\B
Use Full Access File Copy: If the /\Q\B argument is used, PeerSync will only copy files it can gain full access to during synchronization.

/\Q\F\n
Shadow Time Range: This argument will use an n second time range for file time stamps during comparison. If the Source and corresponding Target File time stamps fall in the range then the file time stamps will be seen as equal.

\n = Time in seconds

Note: /\Q\F:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used.

/\Q\F[++][+++][+++]
Precision Comparison: Use this argument to remove minutes, seconds, or milliseconds from files during comparison.

/\Q\F+
Removes/ignores the milliseconds from both the source and target file time stamps during comparison

/\Q\F++
Removes/ignores the milliseconds and seconds from both the source and target file time stamps during comparison

/\Q\F+++
Removes/ignores the milliseconds, seconds, and minutes from both the source and target file time stamps during comparison

/\Q\G
Always use the local machine time for the Last Run Time: If this argument is used, PeerSync will always use the local machine time for the Last Run Time, instead of using the minimum time of the Source and Target machines involved in the synchronization.

/\Q\H:n
Force Flush File Buffers: Forces the file data that has been written across the network to be fully committed to disk before continuing. The Interval n is the number of buffers worth of data to write before forcing a disk write of the data, if n is not used the default is 100 cycles.

Note: This is expected to naturally occur without this argument, but on some systems across slower networks it is necessary to force the commit of data to correctly gauge process of writing the file.

/\Q\H\D
Direct Disk Write: Forces the file data that has been written across the network to be fully committed to disk before continuing. This will occur for each buffer worth of data that is transferred.
Note: You may use this argument or the /GFC option to resolve Windows "Delayed Write Failed..." messages.

### /QI:ext

**Ignore Matching/Locked File Extensions**: This argument will ignore an add/update of a file, if a matching file with the same base name and the specified extension `ext` exists.

**Example**: `/QI:dwl`

Note: One instance of this example is if a file called MyFile.dwg is updated it will be excluded from synchronization while MyFile.dwl exists.

### /QJ:str

**Ignore Matching/Locked File Postfix Replacement**: This argument will ignore an add/update of a file, if a matching file with the same base name with the specified postfix replacement `str` exists.

**Example**: `/QJ:~$`

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from synchronization while ~$Document.doc exists.

### /T

**Terminate All Instances of PeerSync**: The `/T` argument terminates all running instances of PeerSync, including itself.

### /VRBn

**Verify User-Name**: If the `/V` argument is used, PeerSync will verify logged on User-Name defined in the local user file list, specified by the following options:

- **R** Require user to be in the user file list
- **B** Bypass the request to add to list dialog
- **n** Maximum number of user allowed

### /W:x

**Set Queue Directory Change Count**: If the `/W` argument is used, PeerSync will set queue directory change count, events to wait for action `x`.

### /WPFIX

**Disable application associated with active file synchronization**: When a file is being synchronized, this option searches all active windows on the desktop for a caption that contains the path/filename of the active file. PeerSync then disables the active application in one of two ways. The command lines "/WPFIX or /WPFIX2" disables the entire application and" /WPFIX1" disables the save toolbar and file menu save item. (This option also verifies that the word "WordPerfect" is in the caption before disabling). Both options will append "(Synchronizing)" to the existing caption and when the file is synchronized, the caption will be restored.

### /WPMOD

**WordPerfect Fixes for synchronization**: The /WPFIX and /WPMOD arguments are used to help in the synchronization of WordPerfect files.

DLL file to improve interaction with WordPerfect v8 and higher: Working with the Corel corporation, we developed a 3rd party utility that disabled the save function in WordPerfect when a document is "unmodified." This reduces the possible "File Access Denied" error that WordPerfect produces when PeerSync is synchronizing the active document. To run
this option, you must rerun the PeerSync installation program again. The file "PSWPMod.DLL" file will be installed in the windows System32 folder.

For WordPerfect 8, add "/WPMOD8" on the PeerSync command line, which will modify the registry as follows:

Key: HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\8\Third Party

String: DLL16

Value: C:\WinNT\System32\PSWPMod.DLL

For WordPerfect n, add "/WPMODn" on the PeerSync command line, which will modify the registry as follows:

Key: HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\n\Third Party

String: DLL16

Value: C:\WinNT\System32\PSWPMod.DLL

Note: The DLL16 string may vary based on the installation of other 3rd party add-ons to your WordPerfect installation. The value could be DLL15, DLL14, etc.

/YC:x
Folder Queue Watch Interval: Change the default timer interval for checking the folder queue to x seconds (the default is .5 seconds).

Example: /YC:3

/YD
Allow Replication During Dynamically Created Jobs: This argument will allow dynamically created Jobs (i.e. Job scans triggered by Folder Additions) to use the replicate option.

/YF:ext1;ext2;extn
Partial Locked File Extensions List: This argument is used for file types that are partial locked when open by other applications (i.e. Outlook PST files). If the /YF argument is used, and Volume Shadow Copy Service (VSS) is enabled PeerSync will always process files with the specified extensions as though they are open and locked files. If VSS is not enabled, then PeerSync will pre-scan the files to ensure complete access before file copy. PST files are included in this list by default and can be changed via this command line.

Example: /YF:.pst;.dba;

/YN
Use Network Password Dialog: If the /YN argument is used, PeerSync will display a network password dialog if you do not have right to access the Source or Target Folder.

/YR
Delete Empty Source Folders After Move: This argument will delete all empty Source Folders after a synchronization scan when using the Move Files - Delete Source File after successful copy to Target option.

/YV
Do Not Validate Connections Before Profile is Loaded: This argument will not try to validate Source and Target Folder connections during the load of a Profile. It will assume that the connections will be available upon start of each Job. This option is useful if
you are running a Pre Process that will establish a connection and/or create a Source or Target Folder. This argument should be used when using the /LJP (Always Run Post Process) argument or when needing to dynamically create the source and or target paths.

```
/Z:ext1;ext2;extn
```

Ignore Open File Extensions: If the /Z argument is used, PeerSync will ignore files with the specified extensions that are currently opened where the full name of the file is displayed in the caption of another window. This argument may be ignored if Multiple Job or multiple copy threads are enabled.

Example: `/Z:.wpd;.txt;`

```
/LJU:x
```

Exclude Folders that have a Reparse Point: By default PeerSync will exclude folders that have a Reparse Point object, which are common in Windows Vista. Use this argument to alter this behaviour:

```
/LJU:0 Don't exclude folders that have a Reparse Point object
/LJU:1 Exclude folders that have a Reparse Point object recursively pointing back to itself (Default)
/LJU:2 Exclude all folders that have a Reparse Point object
```

```
/LJP
```

Always Run Post Process: If the /LJP argument is used, PeerSync allows for the ability to process Post commands even if the Job fails. This argument is useful for non persistent Profiles that need to execute or start other processes regardless whether or not its Job was able to run. This argument should be used in conjunction with the /YV command which allows for the Profile to be loaded before the source and target folder(s) are validated.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx

7. Real-Time Arguments

```
/Real-Time Arguments
```

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

```
/GA:x
```

Set Empty File Delay: If the /GA argument is used, PeerSync will delay x milliseconds before synchronizing empty (zero size) files that are detected in Real-Time.
**/GB:**
Set Shadow Detection: If the /GB argument is used, PeerSync will delay $x$ milliseconds to synchronize subsequent updates of the same file during Real-Time.

**/LA:**
Real-time Attribute Change: If the /LA argument is used, PeerSync will monitor attribute changes to files in Real-Time and use these changes as triggers for file synchronization.

**/LF:**
Use Update Sensitivity: If the /LF argument is used, PeerSync will use the update section of PSChangeNotify to detect file changes during real-time.

Note: This feature is generally too sensitive, and will create multiple detections.

**/LG:**
Folder Change Detection: If the /LG argument is used, PeerSync will detect folder changes, and in Enhanced Real-Time will force the security description to be validated. Any change to the folder will trigger a scan of the folder including its sub folders, so that more CPU will be required. This option is not recommended for non-enhanced Real-Time.

**/LG1:**
Folder ACL Detection: If the /LG1 argument is used PeerSync will detect folder changes, and in Enhanced Real-Time will force only the ACLs and attributes to be validated. Any change to the folder (i.e. file/folder adds or deletes) will force a comparison of security descriptors and attributes. This argument is more efficient than the /LG option above because it will not perform a scan of the folder. Use this argument if you wish to detect and replicate ACLs in real-time for empty folders or folders that contain files for which inheritances has been disabled. Without the /LG1 argument PeerSync would need to perform a scan in order to replicate the permissions for such folders.

**/LL:**
Disable Real-time Security Change: If the /LL argument is used, PeerSync will not trigger updates in Real-Time when a file's security has changed.

**/LPC:**
Set Maximum Number of Events to Process within each Enhanced Real-Time Queue Check: If the /LPC argument is used, PeerSync will set the maximum number of events to process within each Enhanced Real-Time queue check to $x$ events. The default is 25 events and the minimum is 5 events.

**/LPC+:**
Set Maximum Number of Events to Process within each Enhanced Real-Time Queue Check: Adding the + argument PeerSync will process the events currently in the list at the time of queue checking set by LPQ.

Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following arguments: /LPQS1800 /LPC+

**/LPD:**
Set Delay between Enhanced Real-Time Deletions: If the /LPD argument is used, PeerSync will delay the deletion of files $x$ milliseconds during Enhanced Real-Time.

**/LPE:**
Set Delay between Enhanced Real-Time Event Processing: If the /LPE argument is used, PeerSync will delay the processing of each event $x$ milliseconds.
/LPM:x
Set Enhanced Real-Time Event Upper Limit: If the /LPM argument is used, PeerSync will set the maximum number of items $x$ to allow in the Enhanced Real-Time event queue before reverting to non-enhanced Real-Time. If this value is set to 0 then the option is disabled (the default is 20000 events). If and when the Upper Limit is reached PeerSync will clear all Enhanced Real-Time events that have not been processed and scan the directories for changes.

/LPW:x:y
Set Enhanced Real-Time Event Queue Delay: If the /LPW argument is used, PeerSync will set the number of items $x$ in the enhanced real-time event queue to wait for before processing, as well as, the maximum time to wait for to $y$ milliseconds.

/LPQ:x
Set Delay between Enhanced Real-Time Queue Checking: If the /LPQ argument is used, PeerSync will delay $x$ milliseconds before checking the Enhanced Real-Time queue for new events.

/LPX:x
Set Process Delay for Enhanced Real-Time Changes: The /LPX argument allows you to set the delay time for Enhanced Real-Time changes to be processed to $x$ milliseconds. This value will be applied directly for adds and updates and will be multiplied by 3 for deletions. The default is 1000 milliseconds for adds/updates and 3000 milliseconds for deletions.

/YK:n
Set Real-time Copy Thread Pool: Used to set the percentage of copy threads to reserve for Real-Time events, where $n$ can be set between the values of 1 and 99. The default value is 10 percent.

/QR
Real-Time Global Exclusions: Use this argument when you want to exclude real-time events earlier in the process and throw the events away. This argument will not log/report the exclusions. Improves performance when a high amount of events need to be excluded.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx.

8. Managed Files Arguments

Managed Files Arguments

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate
### Each additional argument (i.e. /A /M).

**/QD**
Always Use Partial Locked File Extensions List for VSS: If the /QD argument is used, any file that is in the Partial Locked File Extension List (default: .pst files) will always be synchronized using VSS without scanning the file for partial locks.

Note: Please refer to the /YF argument for more detail on the Partial Locked File Extensions List.

**/GY:**
VSS Interval: The /GY argument is used to set the interval to try open and locked files via E. The default is every 2 hours and the minimum value is every 30 minutes.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

**/YY:**
Set VSS Try Count: This argument is used to set the amount of times n to try and lock down a drive for full access via VSS during each cycle. The default is 5 times.

Note: If this argument and the Set VSS Base Timeout (/YZ:n) argument are not used then VSS will wait 120 seconds five times.

**/YZ:**
Set VSS Base Timeout: This argument is used to set how long to wait for VSS to lock the drive the first time in n seconds. Each subsequent try will have a timeout based on this value multiplied by the Set VSS Try Count (i.e. 30, 60, 90, 120, 150). The default timeout is 30 seconds.

Note: If this argument and the Set VSS Try Count (/YY:n) argument are not used then VSS will wait 120 seconds five times.

**Notes:**

1. Any arguments containing spaces must be enclosed by quotes.

2. All features described on this page require the VSS add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page at: [http://www.peersoftware.com/support/support.aspx](http://www.peersoftware.com/support/support.aspx).

### Bi-directional Arguments

**Bi-Directional Arguments**

The following arguments are appended to the end of the command line followed by a space and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

**/GV**
Always Create Superset during Bi-directional Synchronization: If the /GV argument is used, PeerSync will not use the TLR value, and therefore always create a
superset of data during a **bi-directional synchronization**.

Note: This item is selectable from the Profiler via the [Options/Commands Screen](#).

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/GW</td>
<td><strong>Enable Temp Files</strong>: If the /GW argument is used, PeerSync will enable the use of temporary files during file/folder renames and deletes. This is useful during 'Real-time Bi-Directional Synchronization' in order to prevent oscillation.</td>
</tr>
<tr>
<td>/LB</td>
<td><strong>Bi-directional Folder Deletion</strong>: If the /LB argument is used, PeerSync will delete folders that have been deleted from Target or Source during <strong>bi-directional scans</strong>.</td>
</tr>
<tr>
<td>/LC</td>
<td><strong>Use Last Access File Time</strong>: If the /LC argument is used, PeerSync will always use last access file time for <strong>bi-directional synchronization</strong>.</td>
</tr>
<tr>
<td>/LD [M A T R]</td>
<td><strong>Set Trigger Folder File Name</strong>: If the /LD argument is used, PeerSync will set enhanced <strong>bi-directional synchronization</strong> trigger folder filename extension to:</td>
</tr>
<tr>
<td></td>
<td>M: Use machine name as extension</td>
</tr>
<tr>
<td></td>
<td>A: Use LastAccessTime for TLR comparison</td>
</tr>
<tr>
<td></td>
<td>T: Use &quot;~FLDR&quot; extension in place of TLR</td>
</tr>
<tr>
<td></td>
<td>R: Reset/Delete all trigger folder-files</td>
</tr>
<tr>
<td>/LE</td>
<td><strong>Use Enhanced bi-directional synchronization mode</strong>: The /LE argument is equivalent to /LDMAT mode. This will alter the way the <strong>bi-directional synchronization</strong> option functions by using enhanced features to track all file and folder adds, updates, deletions, renames and moves between scan cycles. In this mode PeerSync will use a hidden system trigger file within each sub-folder to store information about the last scan cycle for that sub-folder. Using this trigger file PeerSync can determine if a Folder was added, deleted, renamed or moved since the last scan.</td>
</tr>
<tr>
<td></td>
<td>Note: This item is selectable from the Profiler via the <a href="#">Options/Commands Screen</a>.</td>
</tr>
<tr>
<td>/YO-</td>
<td><strong>Retain Last Access Time for Two Machine bi-directional synchronization</strong>: The /YO- argument will store the original Last Access time of the Source File before synchronization and then it will set the Source and Target files' Last Access Times with the stored time after a file add or update. This will allow bi-directional scans between two machines to properly track file adds then subsequent file deletes within the next scan cycle.</td>
</tr>
<tr>
<td></td>
<td>Notes:</td>
</tr>
<tr>
<td></td>
<td>1. When using standard or enhanced bi-directional synchronization we recommend adding /YO- as well as /QYD:0 to your list of <a href="#">command line arguments</a> to ensure deleted files from one side are not re-added by the other side.</td>
</tr>
<tr>
<td></td>
<td>2. The /YO- argument should NOT be used if there are more than two machines involved in a bi-directional synchronization due to the need of the Last Access Time to be used by the third, fourth etc. machine during comparison with either of the other two machines.</td>
</tr>
<tr>
<td>/QYD:n</td>
<td><strong>Set Safety Value for Last Run Time</strong>: By default PeerSync uses /QYD:5 during standard or enhanced bi-directional synchronization. With this option enabled deletion</td>
</tr>
</tbody>
</table>
events are programmatically delayed by approximately 10 seconds to account for any time differences between machines. This can be problematic when performing standard or enhanced bi-directional synchronization where a deleted file from one side can be re-added by the other. In this scenario we recommend using /QYD:0 which represents a safety value of 0 seconds for deletions.

\[
\begin{array}{ll}
n = 0 & \text{safety value} = 0 \text{ seconds} \\
n = 1 & \text{safety value} = \text{approximately} 2 \text{ seconds} \\
n = 2 & \text{safety value} = \text{approximately} 4 \text{ seconds} \\
... \\
n = 5 & \text{safety value} = \text{approximately} 10 \text{ seconds} \\
\end{array}
\]

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as well as /YO- to your list of command line arguments to ensure deleted files from one side are not re-added by the other side.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support page at: http://www.peersoftware.com/support/support.aspx.

Other Components

1. PeerSync Status Display

<table>
<thead>
<tr>
<th>Status Display Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>This screen is used to view Current Profile Activity within the PeerSync application. The Status Display window can only be viewed when PeerSync is running as an Application and not as a Service. Enable the &quot;Display status in PeerSync&quot; option available in the Options/Commands &gt; Display Options... dialog to have the Status Display show automatically at the start/launch of PeerSync or right-click on the Tray icon and select &quot;Show Status Display&quot;.</td>
</tr>
</tbody>
</table>

<p>| Profile | Displays the name of the Profile actively being processed. This label may not match the name of the Profile currently being configured through Profiler. |
| Job | This indicator will dynamically display the name of whichever Job is presently being processed for the Active Profile. |
| Mode | Displays the Operation Mode (Real-time Mode, Scheduled Operation, etc.) applied to synchronization of the Active Profile. |
| Source | Displays a file path for the Source Folder presently being synchronized. |</p>
<table>
<thead>
<tr>
<th><strong>Target</strong></th>
<th>Displays a file path for the Target Folder presently being synchronized from the Source indicated above.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Folders</strong></td>
<td>This indicator provides a count of all unsynchronized folders contained within the Source, and will decrease as each folder is synchronized. An additional &quot;thermometer&quot; indicator will also track the progress of folder synchronization.</td>
</tr>
<tr>
<td><strong>Files</strong></td>
<td>This indicator displays the total number of files contained within the Source while also providing a count of synchronized files. In addition, a &quot;thermometer&quot; indicator will show file synchronization progress by increasing according to the size of the current folder, with 100% representing the cumulative size of files contained within the Source Job set.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>Indicates the name of the file currently being synchronized.</td>
</tr>
<tr>
<td><strong>Large File or Compression Status</strong></td>
<td>This caption will be displayed to the right of the file name that is currently synchronized for large files and during compression. The caption will show the size of the file that has been copied to the Target and/or compression status.</td>
</tr>
<tr>
<td><strong>Skip File</strong></td>
<td>This button will appear once the active Profile has been launched. This feature allows you to skip synchronization of the file currently displayed in the indicator described below. Skip Files enables you to avoid delays caused by large files on slow network or dial-up connections.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Indicates the size (in bytes) of the file currently being synchronized. A related &quot;thermometer&quot; indicator tracks the progress of synchronization for that file.</td>
</tr>
<tr>
<td><strong>Checked</strong></td>
<td>This indicator displays the total number of files contained in the selected Source Folders.</td>
</tr>
<tr>
<td><strong>Excluded</strong></td>
<td>Indicates the number of files that were excluded from synchronization (See Exceptions).</td>
</tr>
<tr>
<td><strong>Messages</strong></td>
<td>Indicates the number of error messages generated during Profile processing.</td>
</tr>
<tr>
<td><strong>Updated</strong></td>
<td>Indicates the number of Target Files that were updated during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td><strong>Added</strong></td>
<td>Indicates the number of new files added to Target Folders during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td><strong>Deleted</strong></td>
<td>Indicates the number of files deleted (or moved) during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td><strong>Target Space</strong></td>
<td>Indicates the Target Folder space remaining during synchronization of Profile Jobs.</td>
</tr>
<tr>
<td><strong>Elapsed Time</strong></td>
<td>Indicates the amount of time that has elapsed during the current Profile activity.</td>
</tr>
<tr>
<td><strong>Hide</strong></td>
<td>Will hide this display, which can be re-accessed via the Tray Icon Men.</td>
</tr>
</tbody>
</table>
### Other Screen Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processed Lists</strong></td>
<td>The Updated, Added, Deletions and Excluded screens will display statistical information in the above format. Each screen will have statistical information (File Name, Size, Modified Date/Time, Path, Duration, etc.) about the changes that have occurred during the current PeerSync session.</td>
</tr>
<tr>
<td><strong>Item Count</strong></td>
<td>Display of the amount of changes that have occurred for the current screen.</td>
</tr>
<tr>
<td><strong>Maximum List Size</strong></td>
<td>Allows you to select the maximum amount of changes that you wish to store for the current screen. It is recommended to keep this value low because each entry requires memory to be used by PeerSync.</td>
</tr>
</tbody>
</table>

### Status Display Popup Menu

Activated by right clicking on the PeerSync Status Display. The Status Display window can only be viewed when PeerSync is running as an Application and not as a Service. Enable the "Display status in PeerSync" option available in the Options/Commands > Display Options... dialog to have the Status Display show automatically at the start/launch of PeerSync or right-click on the Tray Icon and select "Show Status Display".

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Log File</td>
<td>Allows you to access, launch and view Log files in the default text editor for the current Profile.</td>
</tr>
<tr>
<td>View Admin Folder</td>
<td>Allows you to access, launch and view Admin log file Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td>Open Source Folder</td>
<td>Allows you to access, launch and view Source Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td>View Target Folder</td>
<td>Allows you to access, launch and view Target Folders in Explorer for the current Profile.</td>
</tr>
<tr>
<td>Print</td>
<td>Allows you to print the current screen information.</td>
</tr>
<tr>
<td>Save As</td>
<td>Allows you to save the current screen information to file.</td>
</tr>
<tr>
<td>Clear List</td>
<td>Allows you to clear/reset the current screen information.</td>
</tr>
<tr>
<td>Re-Load Profile</td>
<td>Allows you to re-load the current Profile if any changes have occurred.</td>
</tr>
<tr>
<td>About PeerSync</td>
<td>Will display an about screen, that contains information about the current PeerSync you are running.</td>
</tr>
<tr>
<td>Quit</td>
<td>Allows you to close/exit the current session of PeerSync.</td>
</tr>
</tbody>
</table>
2. PeerSync Remote Control

PeerSync Remote Control Screen Features

This feature allows you to connect to and monitor any PeerSync currently running on your LAN. Including PeerSync running as an application or a service on the local machine and/or any instances of PeerSync running on any machine that is accessible from the local machine.

<table>
<thead>
<tr>
<th>Profile Selection</th>
<th>The field located to the left of the Add Button. This field is used to add a Profile to the Profile Selection List. The format for a Profile selection is: MACHINENAME:PROFILENAME (i.e. DELLSERVER:Profile.snc).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Selection List</td>
<td>The list located below the Profile Selection, which contains Profile Selections that can be connected to and monitored by selecting the item and using the Connect button.</td>
</tr>
<tr>
<td>Add</td>
<td>This button will add the current Profile Selection to the Profile Selection List.</td>
</tr>
<tr>
<td>Connect</td>
<td>This button will connect to the current Profile Selection and display its activity on the screen.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>This button will disconnect the current Profile Selection and stop the display of activity.</td>
</tr>
<tr>
<td>Refresh</td>
<td>This button will refresh the current Profile Selection activity.</td>
</tr>
<tr>
<td>Pause/Resume</td>
<td>This button will pause/resume the current Profile that is selected.</td>
</tr>
<tr>
<td>Query</td>
<td>This button will search for and add all Profiles that can be found to the Profile Selection List.</td>
</tr>
<tr>
<td>Clear List</td>
<td>This button will clear out all entries from the Profile Selection List.</td>
</tr>
<tr>
<td>Remote Connection Information</td>
<td>Displays the computer, user and last response for the current connection.</td>
</tr>
<tr>
<td>Close</td>
<td>This button will close this dialog.</td>
</tr>
</tbody>
</table>

Note: The features described on this page require the Enhanced Package.

3. Quick-Sync

This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s) with the option to modify your Job settings at a later time.

Simply right-click on any folder you wish to sync and select "Quick-Sync Folder...". This will launch the Wizard, which will ask you to select a Target Folder to sync to...and you're ready to run the Quick-Sync. You also have the options to edit and/or add the current sync Job to your Quick-Sync Profile or any other selected Profile. Then the next time you select a folder if it matches any Source or Target selection in the Quick-Sync Profile the Jobs will be listed to pick from or you have the option to add a new Job.
Index

- % -

%Desktop% 53  
%Favorites% 53  
%Fonts% 53  
%Personal% 53  
%Programs% 53  
%Recent% 53  
%SendTo% 53  
%Start Menu% 53  
%Startup% 53  
%Templates% 53

-/-

/< (Applications to Ignore) 135  
/0 (Set SNC File to Load) 127  
/1 (Set Source Path) 127  
/2 (Set Target Path) 127  
/A (Scan at Start) 135  
/AP (Run Pre-Sync Report) 131  
/C (Load Alternate Configuration File) 127  
/D (Delay Scan at Start) 135  
/FTPPASSIVE (Force FTP passive mode on) 128  
/GA (Set Empty File Delay) 143  
/GB (Set Shadow Detection) 143  
/GG (Set File Comparison Value) 138  
/GD (Set Job Comparison Delta) 138  
/GE (Set Shared Process Delay) 129  
/GF (Use Alternate Copy File Methods) 138  
/GH (Set FTP Short Date Format) 128  
/GI (Ignore File Size and/or Date Comparison) 138  
/GJ (Set FTP Failed Upload Retry Count) 128  
/GK (Copy Thread Utilization) 129  
/GL (Display status in Profiler) 131  
/GLS (Display status in Profiler - Supress Initial Connection) 131  
/GM (Enable MSMQ messaging) 131  
/GO (Enable PSObserver Broadcasts) 131  
/GP (Set Email Threads) 129  
/GQ (Create and Append Summaries into One Report) 131  
/GR (Report Non Standard Events) 131  
/GS (Enable Summary Statistics Collection) 131  
/GT (Get Remote PC Time) 138  
/GV (Always Create Superset during Bi-directional Sync) 146  
/GW (Enable Temp Files) 146  
/GX (Use Delete Path for Revisions) 138  
/GY (VSS Interval) 145  
/H (Hide Splash Screen) 131  
/H- (Only Hide the about screen) 131  
/I (Ignore Target Space During File Copy) 138  
/J (Move Files) 138  
/KA (Active Connection Interval) 138  
/LA (Real-time Attribute Change) 143  
/LB (Bi-directional Folder Deletion) 146  
/LC (Use Last Access File Time) 146  
/LD (Set Trigger Folder File Name) 146  
/LE (Use Enhanced bi-directional synchronization mode) 146  
/LF (Use Update Sensitivity) 143  
/LG (Folder Change Detection) 143  
/LG1 (Folder ACL Detection) 143  
/LH (Set Deletion Move To Folder Cleanup Interval) 138, 139  
/LI (Target In-Use Replacement) 138  
/LJP (Always Run Post Process) 138  
/LJU (Exclude Folders that have a Reparse Point) 138  
/LK (Set MultiTasking Delay) 129  
/LL (Disable real-time Security Change) 143  
/LM (Set Failed Connection Timer) 138  
/LMD (Disable Failed Connection Timer) 138  
/LN (Set Processor Affinity) 129  
/LPC (Set Maximum Number of Events to Process) 143  
/LPD (Set Delay between Enhanced Real-Time Deletions) 143  
/LPE (Set Delay between Enhanced Real-Time Event Processing) 143  
/LPM (Set Enhanced Real-Time Event Upper Limit) 143  
/LPQ (Set Delay between Enhanced Real-Time Queue Checking) 143  
/LPW (Set Enhanced Real-Time Event Queue Delay) 143  
/LPX (Set Process Delay for Enhanced Real-time Changes) 143  
/LQ (Enable FTP Logging) 131  
/LR (Run application at start of PeerSync) 138
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/LSE</td>
<td>(Log Service Events to the Event Viewer)</td>
</tr>
<tr>
<td>/LW</td>
<td>(Enable Last Access Compare)</td>
</tr>
<tr>
<td>/M</td>
<td>(Show Tray Icon)</td>
</tr>
<tr>
<td>/MCT</td>
<td>(Set Copy Threads)</td>
</tr>
<tr>
<td>/MFT</td>
<td>(Set Job Threads)</td>
</tr>
<tr>
<td>/NODELFLDR</td>
<td>(No not delete folders)</td>
</tr>
<tr>
<td>/O</td>
<td>(Set Target File Overwrite)</td>
</tr>
<tr>
<td>/OPTIMIZE</td>
<td>(Optimize Performance)</td>
</tr>
<tr>
<td>/PERFORMANCE</td>
<td>(Set Application Priority)</td>
</tr>
<tr>
<td>/PROGRESS</td>
<td>(Display status in PeerSync)</td>
</tr>
<tr>
<td>/Q8BH+</td>
<td>(Enable the Historical Data Tab)</td>
</tr>
<tr>
<td>/Q8BJ+</td>
<td>(Enable Job Scans Tab)</td>
</tr>
<tr>
<td>/Q9</td>
<td>(Use Full Access File Copy)</td>
</tr>
<tr>
<td>/QD</td>
<td>(Always Use Partial Locked File Extensions List For VSS)</td>
</tr>
<tr>
<td>/QF</td>
<td>(Shadow Time Range)</td>
</tr>
<tr>
<td>/QG</td>
<td>(Always use the local machine time for the Last Run Time)</td>
</tr>
<tr>
<td>/QH</td>
<td>(Force Flush File Buffers)</td>
</tr>
<tr>
<td>/QHD</td>
<td>(Direct Disk Write)</td>
</tr>
<tr>
<td>/QI</td>
<td>(Ignore Matching/Locked File Extensions)</td>
</tr>
<tr>
<td>/QJ</td>
<td>(Ignore Matching/Locked File Postfix Replacement)</td>
</tr>
<tr>
<td>/QP</td>
<td>(Disable Job Stats)</td>
</tr>
<tr>
<td>/QD</td>
<td>(Don't Display Job Stats)</td>
</tr>
<tr>
<td>/QQ</td>
<td>(Enable the File Copy Progress Tab)</td>
</tr>
<tr>
<td>/QQ&lt;&lt;</td>
<td>(Disable the Show Advanced Display link)</td>
</tr>
<tr>
<td>/QR</td>
<td>(Exclude Common Job Exceptions in Event Processing)</td>
</tr>
<tr>
<td>/QY7</td>
<td>(XML File Creation Interval)</td>
</tr>
<tr>
<td>/QYD</td>
<td>(Set Safety Value for Last Run Time)</td>
</tr>
<tr>
<td>/R</td>
<td>(Real time Monitoring Argument)</td>
</tr>
<tr>
<td>/S</td>
<td>(Run Scheduled Operation)</td>
</tr>
<tr>
<td>/SNMP</td>
<td>(Enable SNMP Error Reporting)</td>
</tr>
<tr>
<td>/Sx</td>
<td>(Synchronization Timer Argument)</td>
</tr>
<tr>
<td>/SxKz</td>
<td>(Synchronization Timer Argument with Keyboard Activity)</td>
</tr>
<tr>
<td>/T</td>
<td>(Terminate All Instances of PeerSync)</td>
</tr>
<tr>
<td>/TD</td>
<td>(Display status in PeerSync upon completion)</td>
</tr>
<tr>
<td>/TIME</td>
<td>(Daily Timer)</td>
</tr>
<tr>
<td>/UDD</td>
<td>(Use Device Driver method)</td>
</tr>
<tr>
<td>/USEPROFILEARG</td>
<td></td>
</tr>
<tr>
<td>/VRB</td>
<td>(Verify User-Name)</td>
</tr>
<tr>
<td>/W</td>
<td>(Set Queue Directory Change Count)</td>
</tr>
<tr>
<td>/WPFIX</td>
<td>(Disable application associated with sync)</td>
</tr>
<tr>
<td>/WPMOD</td>
<td>(WordPerfect Fixes for synchronization)</td>
</tr>
<tr>
<td>/X</td>
<td>(Disable Initial Synchronization During Startup)</td>
</tr>
<tr>
<td>/YF</td>
<td>(Partial Locked File Extensions List)</td>
</tr>
<tr>
<td>/YK</td>
<td>(Set Real-time Copy Thread Pool)</td>
</tr>
<tr>
<td>/YK:n</td>
<td>(Set Real-time Copy Thread Pool)</td>
</tr>
<tr>
<td>/YL</td>
<td>(Log Messages Only to a Log File by Filter and/or by Profile)</td>
</tr>
<tr>
<td>/YN</td>
<td>(Use Network Password Dialog)</td>
</tr>
<tr>
<td>/YO</td>
<td>(Retain Last Access Time for Two Machine bi-directional synchronization)</td>
</tr>
<tr>
<td>/YO-</td>
<td>(Retain Last Access Time)</td>
</tr>
<tr>
<td>/YR</td>
<td>(Delete Empty Source Folders After Move)</td>
</tr>
<tr>
<td>/YV</td>
<td>(Do Not Validate Connections Before Profile is Loaded)</td>
</tr>
<tr>
<td>/YX:n</td>
<td>(Set File Read/Write Buffer Delay)</td>
</tr>
<tr>
<td>/YY</td>
<td>(Set VSS Try Count)</td>
</tr>
<tr>
<td>/YZ</td>
<td>(Set VSS Base Timeout)</td>
</tr>
<tr>
<td>/Z</td>
<td>(Ignore Open File Extensions)</td>
</tr>
</tbody>
</table>

- **1** -

127.0.0.1 32, 44

- **A** -

About PeerSync 148
Accessing Open Files 64, 105, 107
ACL Options (Global) 104
Activate real-time monitoring 57
Active Connection Interval 138
Active Job 148
Active Profile List 148
Add Jobs with Wizard 14
Add - synchronize new files to target 64
Add Jobs 14
Add Quick-Sync Folder option to Explorer menu 112
Add Shares with the selected Prefix 100
Add Shares with the selected Suffix 100
Add Shares: Do Not Update or Delete 100
Add to Windows registry 112
Add to Windows StartUp 112
Add/Delete/Modify Jobs: Tool Buttons 14, 26
Added Files Reporting Feature 88
Added Indicator 148
Additional Configuration Entries 6
Additional Event Options 78, 80
Additional Features 80
Additional Features List 80
Additional Features Screen: 80
Additional Options 80, 81
Enable file recovery 80, 81
Perform binary comparison on all files (using CRC32) 81
Replace in-use files upon reboot 74, 81
Validation Options 81
Additional File Includes 69
Additional Folder Selection Features 53, 80
Additional Options 80
Additional/Alternate Target Paths 52
Admin Backup 101
Admin Report Cycle Options 91
Admin Reporting 90
Admin Reporting Features 91
Admin Reporting Screen: 90
Admin Reporting Overview 90
Report file name 91
Report File Path 91
Use error information only 91
Use standard report file content 91
Use Summary Information Only 91
Administrative report file storage manipulation and organization 53
Advanced Backup 101
Advanced Options 100, 101
Advanced View 29
Affinity 129
After each scan 95
After each scan (log all non-scan events on the cycle specified) 92
After each scan/cycle even if no events occurred 92, 95
After synchronization subtract/add x minute(s) from target 82
Allow for remote real-time configuration - NetApp fPolicy 36
Allow Replication During Dynamically Created Jobs 138
Alternate Configuration File 127
Alternate Data Stream (ADS) Backup 101
Alternate Target Path Selection Dialog 52
Alternate/Additional Target Paths 52
Always create a super-set during bi-directional synchronization 104
Always Create Superset during Bi-directional Sync 146
Always overwrite 64
Always Run Post Process 138
Always Use Partial Locked File Extensions List for VSS 145
Always use the local machine time for the Last Run Time 138
Append Default File/Folder Exclusions from PeerLock 109
Application Priority 129
Applications to Ignore 135
Argument Selection 106
Argument Selection from the Interface 107
Arguments 106
ASCII 41, 49
At the start of this Profile 92
At the stop of this Profile 92
Attach log file to messages 93
Attribute Exceptions 87
Automatically detect and use recommended NetApp configuration 37
Automatically use recommended settings based on Detection Method - Source Folder 36
Automation 57
Automation Command Line Arguments: 135
Applications to Ignore 135
Daily Timer 135
Delay Scan at Start 135
Device Driver method 135
Disable Initial Synchronization During Startup 135
Interval 135
Keyboard Activity 135
Real time Monitoring Argument 135
Run Scheduled Operation 135
Scan at Start 135
Synchronization Timer Argument 135
Synchronization Timer Argument with Keyboard Activity 135
Timer Argument 135
Use Device Driver method 135
Automation Features 57
Automation Screen: 57
Activate real-time monitoring 57
Automation Screen:  57
  Automation Screen Overview  57
Daily Timer Options  57
Run at specific times and selected days  57
Run on an interval every x minute(s)  57
Use enhanced real-time monitoring  57

- B -
Back Button  14
Back-Up  3
Bandwidth throttling  72
Basic View  29
Bi-directional Command Line Arguments:  146
  Always Create Superset during Bi-directional Sync  146
  Bi-directional Folder Deletion  146
  Enable Temp Files  146
  Retain Last Access Time  146
  Set Safety Value for Last Run Time  146
  Set Trigger Folder File Name  146
  Use enhanced bi-directional synchronization mode  146
  Use Last Access File Time  146
Bi-directional Folder Deletion  146
bi-directional synchronization  64
bi-directional synchronziation  78
Binary Comparison  81
Bi-Sync Options Button  106
blackout  61
Blackout Settings  61
Block Size Selection  74
Buffer Size - File Read/Write  72
Buffer Size Upper Limit  72
Buttons  14
ByteReplicator  74
  Block Size Selection  74
  Excluded File Types  74
  Exclusions  74
  Minimum File Size  74
  Port  74
  Time Out  74

- C -
Carbon Copies - Email Reporting  93
Change Password  98
Changing Profile Job List Window  26
Check for ACL changes during scans  104
Checked Indicator  148
Choose external applications/scripts to be run before and after the processing of a given Job  99
Clear List  148
Clear Log File  88
collect real-time events  61
Command Line Argument Selection  106
Command Line Argument Selection from the Interface  107
Command Line Arguments  107, 126
Compare Time Change  82
Compress target  97
Compressed File Extension  97
Compression  96
Compression - TCP Source  39
Compression - TCP Target  48
Compression Features  97
Compression Overview  96
Compression Screen:  96, 98
  Change Encryption Password  98
  Compress target  97
  Compressed File Extension  97
  Compression Speed  98
  Expand source  97
  Extraction  96
  Overview  96
  Password - Encryption  98
  Use file compression  97
  Use folder compression  97
Compression Speed  98
Compression Status  148
Computer Name Variable  53
Configuration Command Line Arguments:  127
  Alternate Configuration File  127
  Load Alternate Configuration File  127
  Set SNC File to Load  127
  Set Source Path  127
  SNC File  127
  Use Arguments from Profile  127
Configuration Entries  6
Configure FTP Source Folder  43
Configure FTP Target Folder  52
Configure Normal Source Folder  42
Configure Normal Target Folder  51
Configure TCP Source Folder  43
Configure TCP Target Folder  51
Connect As  38

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
Connect to and monitor any PeerSync currently running on your LAN 151
Connection Manager 36
Connection Manager for Failed Connections - Source Folder 36
Convert to GMT for comparison purposes 82
Copy Jobs 14
Copy Thread Utilization 129
Copy Threads 103, 129
Copyright 3
CRC32 81
Create a report for every event 91
Create a report on an interval 91
Create a report once a day 91
Create a report once a week 91
Create administrative Email messages 92
Create administrative report files 91
Create and Append Summaries into One Report 131
Create Auto FTP Job Name 52
Create Email messages 92
Create Normal Source Auto Job Name 42
Create Normal Target Auto Job Name 51
Create Pre Sync Report 26
Create Shortcut on Desktop 112
Create SNC extension association for Profiler 112
Create Source FTP Auto Job Name 43
Create Source Folder 32
Create Target Folder 44
Create Target TCP Auto Job Name 51
Create TCP Source Auto Job Name 43
Current Arguments 106
Current Arguments Button 106
Current Attributes 87
Current Command Line Argument Selection 101, 106
Customize Selection Tree 29
Customized View 29

Default inclusion 83
Default Read/Write Buffer Size 72
Delay between Enhanced Real-Time Deletions 143
Delay between Enhanced Real-Time Event Processing 143
Delay between Enhanced Real-Time Queue Checking 143
Delay Scan at Start 135
Delayed Write Failed 138
Delete Empty Source Folders After Move 138
Delete fPolicy on Close - NetApp Settings 37
Delete Jobs 14
Delete log file after successful send 93
Delete Unmatched Target Files 66
Delete unmatched target files older than x days 66
Deleted file storage manipulation and organization 53
Deleted Indicator 148
Deletion Folder 66
Deletion Options 65, 66
Deletion Options Button 66
Destination IP 90
Detection Method for Real-Time Monitoring 36
Detection Method Options 36
Device Driver method 135
Disable all Startup Options 112
Disable application associated with sync 138
Disable Failed Connection Timer 138
Disable Initial Synchronization During Startup 135
Disable Install Reboot 6
Disable Jobs that are Not Configured from this Profiler 110
Disable Real-time Security Change 143
Disabled - Connection Manager 36
Display status in PeerSync 131
Display status in PeerSync upon completion 131
Dissimilar time zone synchronization 82
Distribution 3
Do Not Validate Connections Before Profile is Loaded 138
Drag and Drop Source Folder Selection 32
Drag and Drop Target Folder Selection 44
Drive Mapping 56
During comparison subtract/add x minute(s) from target 82
Dynamic Network Drive Mapping and Un-mapping 56
Dynamic archives 53
Dynamic synchronization based on date 53
Dynamic synchronization based on logged on user or machine name 53
Dynamic synchronization based on personal folders or other variables read in from the registry 53

- E -

Easy way to synchronize folders on the fly 151
Edit Job Groups Dialog 28
Edit Menu 17
Edit Normal Source Variable File 42
Edit Normal Target Variable File 51
Elapsed Time Indicator 148
Email Report Cycle Options 94
Email reporting 92
Email Reporting Features 92
Email Reporting Overview 92
Email Reporting Screen: 92
  Attach log file to messages 93
  Create administrative Email messages 92
  Delete log file after successful send 93
  Report file name - Email Reporting 93
  Use error information only 93
  Use standard report file content 93
  Use summary information only 93
Email Threads 129
Embedded Open File Manager 64
Enable file recovery 80, 81
Enable FTP Logging 131
Enable intelligent network load balancing 72
Enable intelligent network load balancing (when applicable) 72
Enable Last Access Compare 138
Enable Passive Mode - FTP Source 40
Enable Passive Mode - FTP Target 49
Enable PSObserver Broadcasts 131
Enable SNMP Error Reporting 131
Enable Summary Statistics Collection 131
Enable Temp Files 146
Enabled for Source and Target Connections - Connection Manager 36
Enabled for Source Connections Only - Connection Manager 36
Enabled for Target Connections Only - Connection Manager 36
Encryption - TCP Source 39
Encryption - TCP Target 48
Enhanced real-time 57
Enhanced Real-Time Event Queue Delay 143
Enhanced Real-Time Event Upper Limit 143
Enhanced Scan Processing 58
Error Reporting 131
Evaluating a new version of PeerSync 10
Evaluation Menu 24
Event Options 65
Exception Screen Features 83
Exceptions 83
Exceptions Screen:
  Exceptions Screen Overview 83
  Exclude Files by Character/String/Extension 85
  Exclude Files from Sync by Size 87
  Exclude Files in Sync by Attribute 87
  Excluding Folders from Sync 86
  Include File Types (using wild cards) 83
  Include Files in Sync by Attribute 87
  Include Files in Sync by Date 87
Exclude all open files until closed 69
Exclude File Sizes 87
Exclude Files 85
Exclude Files Button 85
Exclude Folders 86
Exclude Folders Button 86
Exclude Folders drop down list 86
Exclude Folders that have a Reparse Point 138
Exclude open files 69
Exclude open files (allow read access to source file during transfer) 69
Exclude open files (deny all access to source file during transfer) 69
Exclude root folders 86
Exclude specific folders only 86
Exclude Users - NetApp fPolicy 36
Excluded Indicator 148
Exclusion drop down list 85
Exclusive Remedy 3
Executable Path (PeerLock) 115
Executable Path (PeerSync) 112
Expand source 97
Explore Source Folder 32
Explore Target Folder 44

- F -

Failed connection 102
Failed Registration 8
Features 80

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
File Date Reporting Feature 88
File Dates 87
File Deletion Options 66
File Exclusions 74
File Folder Path Variables 53
File Indicator 148
File Menu 16
File Options 64
File Options Features 64
File Options Screen: 64
   Add - synchronize new files to target 64
   Avoiding Permanent Deletion 66
   Delete Unmatched Target Files 66
   Delete Unmatched: Options 66
   Deletion Warning Message 66
   Mode Selection 64
   Replicate - Delete unmatched files/folders 64
   Update - synchronize existing files in target 64
   Use Windows Recycle Bin 66
File Path Variables 53
   File Path Variables: Folder Selection 53
File Read/Write Buffer Size 72
File Recovery 80, 81
File Size Reporting Feature 88
File Sizes 87
File Time Change Options 80
File Time Reporting Feature 88
File types to transfer as ASCII - FTP Source 40
File types to transfer as ASCII - FTP Target 49
File Versions 76
Files Indicator 148
Folder ACL Detection 143
Folder Change Detection 143
Folder Creation Reporting Feature 88
Folder Names Reporting Feature 88
Folder Queue Watch Interval 138
Folder Restoration feature in real-time 57
Folder Selection Features 32
Folder Selection Screen: 32
   File Path Variables 53
      Folder Selection Screen Overview 32
      Source Folder Selection 32
      Target Folder Selection 44
Folders Indicator 148
   For each individual error message as it occurs 92
   for each message/error as it occurs 95
Force Flush File Buffers 138
   Force FTP passive mode on 128

   Force Source Folder Root as Target FTP Folder Root 52
   Force Source Folder Root as Target TCP Folder Root 51
fPolicy Name - NetApp Settings 37
FTP Command Line Arguments: 128
   Force FTP passive mode on 128
   Set Failed Upload Retry Count 128
   Set Short Date Format 128
FTP Logging 131
FTP Source 34
FTP Source Configuration 40
FTP Source Mode Selection 40
FTP Source PopUp 43
FTP Source Settings Tab 40
FTP Target 45
FTP Target Configuration Tab 49
FTP Target Mode Selection 48
FTP Target PopUp 52
FTP Target Settings Tab 49

- G -
General 3
Get Remote PC Time 138
Global ACL Options 104
Global Advanced File Xfer Options 100, 101
Global bi-directional Options 101, 104
Global Display Options - Profiler Options 107
Global Managed Files Options 101
Global Migrate Shares Options 100, 101
Global Options 110
Global Recovery/Offline Options 101
Global Settings (PeerLock): 110
   Disable Jobs that are Not Configured from this Profiler 110
   Global Options 110
   Link this Profiler to PeerLock 110
   Save Changes in PeerLock 110
   Show PeerLock 110
Global Settings (PeerSync): 101, 102, 103, 104, 105, 106, 107
Global VSS Options 101
Greater Than File Size Exclusion 87

- H -
H+ (Skip setting of main form visible) 131
Help Button 14
Help Menu 21
Hide 148
Hide Splash Screen 131
Host is using GMT - FTP Source 40
Host is using GMT - FTP Target 49
Host Name 47
Host Name - FTP Source 40
Host Name - FTP Target 49
Host Name - TCP Source 38
Host Server Name - NetApp Settings 37
Hour variables for Folder Paths 53

- I -

Ignore File Size and/or Date Comparison 138
Ignore Matching/Locked File Extensions 138
Ignore Matching/Locked File Postfix Replacement 138
Ignore Open File Extensions 138
Ignore Target Space During File Copy 138
Improve Load Balancing 72
Include all open files 69
Include attribute change as synchronization criteria 80
Include Files 83
Include Files Button 83
Include open files 69
Include open files (allow read & write access to source file during transfer) 69
Include open files (allow read access to source file during transfer) 69
Include open files (if possible) 69
Include partially open files 69
Include Sub folders Folder Selection Screen:
  Include Source Sub-Folders 32
Include this Job in PeerLock 109
Inclusion drop down list 83
Information Required to Register software 8
initiate scan on trigger file change 63
Initiate Synchronization on Source or Target File/Folder Change 57
Install Options 6
Install Service (PeerLock) 115
Install Service (PeerSync) 112
INSTALL.LOG 6
Installation (Silent Install) 6
Installation Configuration Options 6
Installing PeerSync 6
Intelligent Network Load Balancing 72
Intermediate View 29
Interval 135
Intervals Button 102
Item Count 148

- J -

job data import 56
Job Indicator 148
Job Menu 20
Job Settings (PeerSync): 31, 32, 57, 61, 62, 64, 69, 71, 72, 74, 76, 78, 80, 83, 88, 90, 92, 96, 99
Job Settings PeerLock: 109
  Append Default File/Folder Exclusions from PeerLock 109
  Include this Job in PeerLock 109
Job Threads 103, 129
Jobs 12, 151

- K -

Keep backup files of overwritten Target Files 76
Keep files in Alternate Folder 76
Keep files in Deletion Folder 76
Keep files in Target Folder 76
Keep multiple versions of files 76
Keyboard Activity 135

- L -

Large File or Compression Status 148
Last Run On 53
Last Run On - Reset 26
Last Run On Feature 26
Last Save 53
Last Scan 53
Launch (PeerLock) 122, 123
Launch (PeerSync) 116, 118
Launch Current Profile 14
Left side Panel - Selection Tree 29
Less Than File Size Exclusion 87
License 3
License File 6
Limit CPU usage during file transfers 129
Limit number of processors to use 129
Limit system resources during file transfers 129
Limitations of Liability 3
Limited Warranty 3
Link this Profiler to PeerLock 110
List of Exclude Files (using sub strings) 26, 85
List of Exclude Folders 86
List of Include File Types (using wild cards) 83
List of Job Selections - Daily Timer 57
Load Alternate Configuration File 127
Load Balancing 72
Log File - Clear 26
Log File - View 26
Log file storage/manipulation/organization 53
Log Files: Administrative 90
Log Messages by Filter 131
Log Messages by Profile 131
Log Messages Only to a Log File by Filter 131
Log Messages Only to a Log File by Filter and/or by Profile 131
Log Messages Only to a Log File by Profile 131
Log Service Events to the Event Viewer 131
loopback 32, 44

- M -
Managed Files 71
Managed Files Arguments: 145
Always Use Partial Locked File Extensions List For VSS 145
Set VSS Base Timeout 145
Set VSS Try Count 145
VSS Interval 145
Match Shares: Add, Update and Delete 100
Maximize Speed 72
Maximum compression 98
maximum duration of scans 62
Maximum List Size 148
Maximum Log File Size 89
Maximum Number of Events to Process 143
Maximum speed - compression option 98
Menu (PeerSync):
  Edit 17
  Evaluation 24
  File 16
  Help 21
  Job 20
  Options 18
  PeerSync Tray Icon PopUp Menu 25
  Run 19
  View 17
  View Popup Menu 25
Messages Indicator 148
Messages Reporting Feature 88
Migrate Shares 100
Minute variables for Folder Paths 53
Miscellaneous 78
Mode Indicator 148
Mode Selection 64
Monitor ACL changes during real-time 104
Monitor PeerSync activity across the LAN 151
Monitor Remote Instances of PeerSync 151
Month variables for Folder Paths 53
Move Files 79, 138
Move Job Down 14
Move Job Up 14
MS Windows Explorer Add On - Quick-Sync 151
MSMQ messaging 131
Multiple Copy Threads 103
Multiple Job Threads 103

- N -
Naming and Renaming Jobs 26
NetApp fPolicy 36
NetApp Settings 37
Network Drive Mapping 56
Network License 3
Network Load Balancing 72
Network Logon Settings - Connect As 38
Network Logon Settings - Password 38
New Profile 14
Next Button 14
No not delete folders 138
Non Persistent Processes 26
Normal 36
Normal Source 32
Normal Source Mode Selection 35
Normal Source PopUp 42
Normal Target 44
Normal Target Mode Selection 47
Normal Target PopUp 51
Number of backup files to keep 76
- O -

Only Hide the about screen 131
Only include connections that are set for real-time monitoring 36
Only use Advanced Settings 91, 94
Open File Manager Options 64
Open File Options 64
Open Files 69, 107
Open Profile 14
Open Source Folder 32, 148
Open Target Folder 44
Open/Locked Files 69
Optimize Performance 129
Optimize speed 72
Options 31
Options Menu 18
Options/Commands 107, 148
Options/Commands Features 107
Options/Commands Overview 107
Options/Commands Screen: 107
  Current Arguments 106
  Current Arguments Button 106
  Overview 107
  Set Access Password 107
  Show tray icon 107
Other Global Options/Command 101
Overview 12, 151
Overwrite Existing Log File 88
Overwrite existing Pre-Sync report file 106

- P -

Path to Host - FTP Source 40
Path to Host - FTP Target 49
Path to Host - TCP Source 38
Path to Host - TCP Target 47
pause scan during specific times 61
Pause Service (PeerLock) 122, 123
Pause Service (PeerSync) 116, 118
PeerLock Selection Tree Category 29
PeerLock Service: 122, 123
  Launch PeerLock 122, 123
  Pause Service 122, 123
  Resume Service 122, 123
  Run as a service 122, 123
  Start Service/Application 122, 123
  Stop Service/Application 122, 123
PeerSync Command Line Arguments 126
PeerSync Installation 6
PeerSync Remote Control 151
PeerSync Selection Tree Category 29
PeerSync Service: 116, 118
  Launch PeerSync 116, 118
  Pause Service 116, 118
  Resume Service 116, 118
  Run as a service 116, 118
  Start Service/Application 116, 118
  Stop Service/Application 116, 118
PeerSync Status Display 148
PeerSync Status Display Popup Menu 148
PeerSync Temp Folder 6
PeerSync90.lic file 6
Perform binary comparison on all files (using CRC32) 81
Performance 72
Performance - Threads 103
Performance Command Line Options: 129
  Affinity 129
  Application Priority 129
  Copy Thread Utilization 129
  Copy Threads 129
  Email Threads 129
  Job Threads 129
  Limit CPU usage during file transfers 129
  Limit number of processors to use 129
  Limit system resources during file transfers 129
  Optimize Performance 129
  Priority 129
  Processor Affinity 129
  Set Application Priority 129
Performance Command Line Options: 129  
  Set Copy Threads 129  
  Set Email Threads 129  
  Set File Read/Write Buffer Delay 129  
  Set Multitasking Delay 129  
  Set Processor Affinity 129  
  Set Real-time Copy Thread Pool 129  
  Set Shared Process Delay 129  
  Set the percentage of copy threads to reserve for real-time events 129  
  Shared Process Delay 129  
  Thread Utilization 129  
  Threads 129  
  Performance Features 72  
  Performance Options All Jobs 107  
  Performance Package 103, 107  
  Performance Priority Selection 103  
  Performance Screen: 72  
    Enable intelligent network load balancing (when applicable) 72  
    File Read/Write Buffer Size 72  
    Set maximum number of copy threads to x 72  
    Throttle bandwidth - Use x percent of available bandwidth 72  
  Pop Up Menu: Profile Job List 26, 29  
  Pop Up Menu: Selection Tree 29  
  Port - Email Reporting 93  
  Port - FTP Source 40  
  Port - FTP Target 49  
  Port - TCP Source 39  
  Port - TCP Target 48  
  Port Configuration 74  
  Post Installation Configuration Options 6  
  Post process application 99  
  Pre Installation Configuration Options 6  
  Pre process application 99  
  Pre/Post Features 99  
  Pre/Post Overview 99  
  Pre/Post Process 99  
  Pre/Post Process Overview 99  
  Pre/Post Process Screen: 99  
    Select Application/Script to Run After 99  
    Select Application/Script to Run Before 99  
    Use maximum wait time of x seconds 99  
    Wait for application to end before continuing 99  
  Preserve Paths 66  
  Pre-Sync Report Options 106  
  Print 148  
  Priority 129  
  Priority Selection 103  
  Process Delay for Enhanced Real-time Changes 143  
  Process Migrate Shares after each scan 101  
  Process Migrate Shares every x minute(s) 101  
  Processed Lists 148  
  Processor Affinity 129  
  Product Definitions 12, 151  
  Product Support 12, 151  
  Product Updates 8  
  Profile Description: 16  
    Default Description 16  
    Hiding Profile Description Toolbar 16  
    Moving Profile Description Toolbar 16  
  Profile Indicator 148  
  Profile Job List Pop Up Menu 26  
  Profile Job List: 26  
    Add/Delete/Modify Jobs 26  
    Changing Size of Window 26  
    Naming and Renaming Jobs 26  
    Selecting Jobs and Multiple Jobs 26  
  Profile Options: Customize 29  
  Profile Options: Show All 29  
  Profile Selection 151  
  Profile Selection List 151  
  Profiler 12, 151  
  Profiler Command Line Arguments 126  
  Profiles 12, 151  
  ps90.exe 6  
  PSDef.CFG 6  
  PSError.log 88, 89  
  PSObserver Broadcasts 131  

- Q -  
  Quantity Discounts 8  
  Quick-Sync 151  
  Quick-Sync Folder 151  
  Quick-Sync Profile 151  
  Quit 148  

- R -  
  Real time File Folder Change Detection 57  
  Real Time Mode 12, 151
Real time Monitoring Argument 135
Real Time Options 59
Real-time Attribute Change 143
Real-Time Command Line Arguments: 143
  Disable Real-time Security Change 143
  Folder ACL Detection 143
  Folder Change Detection 143
  Real-time Attribute Change 143
  Set Delay between Enhanced Real-Time Deletions 143
  Set Delay between Enhanced Real-Time Event Processing 143
  Set Delay between Enhanced Real-Time Queue Checking 143
  Set Empty File Delay 143
  Set Enhanced Real-Time Event Queue Delay 143
  Set Enhanced Real-Time Event Upper Limit 143
  Set Maximum Number of Events to Process 143
  Set Process Delay for Enhanced Real-time Changes 143
  Set Real-time Copy Thread Pool 143
  Set Shadow Detection 143
  Use Update Sensitivity 143
Real-time Copy Thread Pool 143
Real-Time Event Detection Options 57
Real-time Monitoring 57
Real-time Options Button 57
Reboot Options Button 81
receive an e-mail at start of profile 95
receive an e-mail at stop of profile 95
Recovery Intervals Button 102
Register by FAX 8
Register by mail 8
Register by phone 8
Register online 8
Registering Evaluation Copy of PeerSync 9
Registering Unregistered Copy of PeerSync 9
Registration and Passwords: 8
  Entering User ID/Password (Evaluation Copy) 8
  Register By Mail 8
Registry variables to use in Folder Paths 53
Related Global Settings 69
Relative Paths 66
Re-load Profile 148
Remote Connection Information 151
Remote Connection Licenses 151
Remote Control 151
Remove Service (PeerLock) 115
Remove Service (PeerSync) 112
Rename Job 14
Replace In use Files Options 81
Replace in use files upon reboot 80, 81
Replace Shares: Add and Overwrite 100
Replicate - Delete unmatched files/folders 66
Replication 12, 151
Report file name 91, 93
Report file path 91
Report Non Standard Events 131
Reporting 88
Reporting Command Line Arguments: 131
  Create and Append Summaries into One Report 131
  Display status in PeerSync 131
  Display status in PeerSync upon completion 131
  Enable FTP Logging 131
  Enable PSObserver Broadcasts 131
  Enable SNMP Error Reporting 131
  Enable Summary Statistics Collection 131
  Error Reporting 131
  FTP Logging 131
  Hide Splash Screen 131
  Log Messages by Filter 131
  Log Messages by Profile 131
  Log Messages Only to a Log File by Filter 131
  Log Messages Only to a Log File by Filter and/or by Profile 131
  Log Messages Only to a Log File by Profile 131
  Log Service Events to the Event Viewer 131
  MSMQ messaging 131
  Only Hide the about screen 131
  PSObserver Broadcasts 131
  Report Non Standard Events 131
  Run Pre-Sync Report 131
  Show Tray Icon 131
  Skip setting of main form visible 131
  SNMP Error Reporting 131
  Summary Report 131
  Summary Statistics Collection 131
  Suppress connection of PeerSync to the Profiler 131
  Tray Icon 131
Reporting Features 88
Reporting Screen: 88
  Clear Log File 88
  Include Options 88

Copyright © 1993-2012 Peer Software Inc. All Rights Reserved
Index

- R -

Run a Pre-Sync Report (do not sync files/folders) 106
run a scan on reconnect 102
Run application at start of PeerSync 138
Run as a service (PeerLock) 122, 123
Run as a service (PeerSync) 116, 118
Run at specific times and selected days 57
Run External applications/scripts before and after the processing of a given Job 99
Run Menu 19
Run Pre-Sync Report 131
Run RegEdit 112
Run Scheduled Operation 135
Run selected Jobs at a specific time of day 57
Run VSS every x minutes 105
Run/View 29
Run/View (PeerLock): 122, 123
  Launch PeerLock 122, 123
  Pause Service 122, 123
  Resume Service 122, 123
  Run as a service 122, 123
  Start Service/Application 122, 123
  Stop Service/Application 122, 123
Run/View (PeerSync): 116, 118
  Launch PeerSync 116, 118
  Pause Service 116, 118
  Resume Service 116, 118
Run as a service 116, 118
Start Service/Application 116, 118
Stop Service/Application 116, 118
Run/View Current Profile Activity Screen: 148
  Added Indicator 148
  Checked Indicator 148
  Deleted Indicator 148
  Elapsed Time Indicator 148
  Excluded Indicator 148
  File Indicator 148
  Files Indicator 148
  Folders Indicator 148
  Job Indicator 148
  Messages Indicator 148
  Mode 148
  Profile Indicator 148
  Size Indicator 148
  Skip Files Button 148
  Source Indicator 148
  Target Indicator 148
  Target Space Indicator 148
  Updated Indicator 148
Running Jobs vs. Running Profiles (Run a Quick Sync) 26

- S -

Sample Exclusions 85
Save As 148
Save Changes in PeerLock 110
Save Profile 14
Saving Profiles 14
Scan at Start 135
Scan limitations 62
Scan real-time Jobs on reconnect if "Scan Job once at start" is enabled 36
Scanning Options 57
Scheduled Mode 12, 151
Scheduling Options 57
Select a folder for deleted files to be placed 66
Select Application/Script to Run After 99
Select Application/Script to Run Before 99
Select days of the week to run Jobs 57
Select Source Folder 32
Select Source Folder Button 32
Select Target Folder 44
Select Target Folder Button 44
Selected File Dates 87
Selecting Jobs 26
Selecting Multiple Jobs 26
Selecting Source Folders 32
Selecting Target Folders 44
Selection Tree 29
Selection Tree: Customize Options 29
Send an email for every event 94
Send an email on an interval 94
Send an email once a day 94
Send an email once a week 94
Service (PeerLock) 122, 123
Service (PeerSync) 116, 118
Service Details (PeerLock) 116
Service Details (PeerSync) 112
Set Access Password 107
Set Alternate/Additional Normal Targets 51
Set Application Priority 129
Set Copy Threads 129
Set Deletion Move To Folder Cleanup Interval 138
Set Email Threads 129
Set Empty File Delay 143
Set Failed Connection Timer 138
Set File Comparison Value 138
Set File Read/Write Buffer Delay 129
Set FTP Failed Upload Retry Count 128
Set FTP Short Date Format 128
Set Job Comparison Delta 138
Set maximum number of copy threads to x 72
Set maximum number of retries to x 102
Set Multitasking Delay 129
Set Processor Affinity 129
Set Queue Directory Change Count 138
Set Real-time Copy Thread Pool 129
Set Safety Value for Last Run Time 146
Set Shadow Detection 143
Set Shared Process Delay 129
Set SNC File to Load 127
Set Source Path 127
Set Target File Overwrite 138
Set the maximum log file size to x bytes 89
Set the percentage of copy threads to reserve for real-time events 129
Set Today’s Date Button 87
Set Trigger Folder File Name 146
Set VSS Base Timeout 145
Set VSS Try Count 145
Settings 31
Shadow Time Range 138
Shared Process Delay 129
Show Advanced/Normal Display 118
Show Advanced/Normal Display PeerLock 123
Show All Profile Options 29
Show PeerLock 110
Show Pre-Sync report file at end of run 106
Show Tray Icon 107, 131
Show/hide Selection Tree 14
Show/hide the Selection Tree 29
Silent Installation 6
Simple Network Management Protocol reporting 89
Size Indicator 148
Skip File Button 148
Skip setting of main form visible 131
SMTP Host - Email Reporting 93
SNC File 127
SNMP Error Reporting 131
SNMP Options Button 89
SNMP reporting 89
Source and Target Selections 32
Source File/Folder Alterations 78, 79
Source Folder Connection Manager 36
Source Folder Detection - NetApp fPolicy 36
Source Folder Detection - Normal 36
Source Folder Detection Method 36
Source Folder Field 32
Source Folder NetApp Settings 37
Source Folder Network Logon Settings 38
Source Folder Popup Menu 42
Source Folder Selection 32
Source Indicator 148
Source to Target Combination Settings 31
Source-target backup/synchronization scenario 31
Specific time scheduling 57
Standard synchronization 64
Start Service/Application (PeerLock) 122, 123
Start Service/Application (PeerSync) 116, 118
Startup/Service 29
Startup/Service (PeerLock): 115
Executable Path (PeerLock) 115
Install Service (PeerLock) 115
Path (PeerLock) 115
Remove Service (PeerLock) 115
Service Details (PeerLock) 115
Startup/Service (PeerSync): 112
Index

Startup/Service (PeerSync): 112
  Add to Windows registry 112
  Add to Windows StartUp 112
  Create Shortcut on Desktop 112
  Create SNC extension 112
  Disable all Startup Options 112
  Executable Path 112
  Install Service 112
  Quick-Sync Folder Option 112
  Remove Service 112
  Run RegEdit 112
  Service Details 112
Status Display 148
Status Screen 148
Stop Service/Application (PeerLock) 122, 123
Stop Service/Application (PeerSync) 116, 118
store events while connection is down 102
store missed events and process on reconnect 102
Summary Report 131
Summary Reporting Feature 88
Summary Statistics Collection 131
Suppress connection of PeerSync to the Profiler 131
Suppress Reboot during Install 6
suspend file transfer 61
Swap Source and Target Folders 53
Sync Selected Jobs 26
Synchronization 12, 151
Synchronization Command Line Arguments: 138
  Allow Replication During Dynamically Created Jobs 138
  Always Run Post Process 138
  Always use the local machine time for the Last Run Time 138
  Delete Empty Source Folders After Move 138
  Disable application associated with sync 138
  Disable Failed Connection Timer 138
  Do Not Validate Connections Before Profile is Loaded 138
  Enable Last Access Compare 138
  Exclude Folders that have a Reparse Point 138
  Folder Queue Watch Interval 138
  Force Flush File Buffers 138
  Get Remote PC Time 138
  Ignore File Size and/or Date Comparison 138
  Ignore Matching/Locked File Extensions 138
  Ignore Matching/Locked File Postfix Replacement 138
Ignore Open File Extensions 138
Ignore Target Space During File Copy 138
Move Files 138
No not delete folders 138
Partial Locked File Extensions List 138
Run application at start of PeerSync 138
Set Deletion Move To Folder Cleanup Interval 138
Set Failed Connection Timer 138
Set File Comparison Value 138
Set Job Comparison Delta 138
Set Queue Directory Change Count 138
Set Target File Overwrite 138
Shadow Time Range 138
Target In-Use Replacement 138
Terminate All Instances of PeerSync 138
Use Alternate Copy File Methods 138
Use Delete Path for Revisions 138
Use Full Access File Copy 138
Use Network Password Dialog 138
Verify User-Name 138
WordPerfect Fixes for synchronization 138
Synchronization of files between dissimilar time zones 82
Synchronization Timer Argument 135
Synchronization Timer Argument with Keyboard Activity 135
Synchronize ALL files via Managed Files 71
Synchronize open/locked files via Managed Files 71
Synchronize Selected Jobs Option 26

- T -

Target File Time Change Option 82
Target File/Folder Alterations 78
Target Folder Field 44
Target Folder Popup Menu 51
Target Folder Selection 44
Target Indicator 148
Target In-Use Replacement 138
Target Space Indicator 148
TCP Source 33
TCP Source Configuration Tab 38
TCP Source Mode Selection 38
TCP Source PopUp 43
TCP Source Port Configuration Tab 39
TCP Target 45
TCP Target Configuration Tab 47
TCP Target Mode Selection 47
TCP Target PopUp 51
TCP Target Port Configuration Tab 48
TCP Wan Connector Option 33, 38, 45, 47
Temp Files 78
Temp Folder Selection 6
Term and Trial Period 3
Terminate Active Profile 14
Terminate All Instances of PeerSync 138
Thread Utilization 129
Threads 103, 129
Throttle bandwidth 72
Throttle bandwidth - Use x percent of available bandwidth 72
Time Change After Sync 82
Time Delta Selection 82
Time Out - FTP Source 40
Time Out - FTP Target 49
Time Out - TCP Source 39
Time Out - TCP Target 48
Time variables for Folder Paths 53
Time Zone Option 82
Timer Argument 135
Tool Buttons 14
Tool Buttons: 14
  Add Job 14
  Back 14
  Copy Job 14
  Delete Job 14
  Help 14
  Hiding/Moving Toolbar 14
  Launch Current Profile 14
  Move Job Down 14
  Move Job Up 14
  New Profile 14
  Next 14
  Open Profile 14
  Overview 14
  Rename Job 14
  Save Profile 14
  Settings Screens Drop-Down List 14
  Show Selection Tree 14
  Terminate Active Profile 14
Toolbars: Profile Description 16
Transfer Time Reporting Feature 88
Trap Prefix 90
Tray Icon 107, 131
Tray Icon Popup Menu 25

Tree 29
trigger file 63
Turn file archive attribute off after synchronization 79

- U -

Uninstall 6
Uninstall previous versions of PeerSync 10
Update - synchronize existing files in target 64
Updated Files Reporting Feature 88
Updated Indicator 148
Updates: Product 8
Upgrade 10
Upgrade Information 10
Upgrade PSListener 10
Use Alternate Copy File Methods 138
Use Arguments from Profile 127
Use Block Byte Level Synchronization 74
Use block/byte level synchronization 74
Use daily timer scheduling 57
Use Delete Path for Revisions 138
Use Device Driver method 135
Use Enhanced bi-directional synchronization mode 146
Use enhanced bi-directional synchronization mode options 104
Use enhanced real-time monitoring 57
Use error information only 91, 93
Use file compression 97
Use folder compression 97
Use Full Access File Copy 138
Use intermediate file during copy: 78
Use Last Access File Time 146
Use Log File 88
Use maximum wait time of x seconds 99
Use Network Password Dialog 138
Use Proxy - Firewall - FTP Source 40
Use Proxy - Firewall - FTP Target 49
Use SNMP reporting 89
Use standard report file content 91, 93
Use summary information only 91, 93
Use Update Sensitivity 143
Use Variables for folder paths stored in registry 53
Use VSS 64
User ID - Email Reporting 93
User Name - FTP Source 40
User Name - FTP Target 49
User Name - TCP Sourc 39
Index 168

User Name - TCP Target 48
User Name and Password 9
User Name variable 53
Using # in Excluding Folders 86
Using Variable Paths 53
Using Wild Cards for files to Include 83

- V -

Validate target file (using CRC32) 81
Validation Options 80, 81
variable data import 55
Variables 53
Variables: File Path 53
Verify User-Name 138
version of files 76
View Admin Folder 148
View Alternate Target Path Selection 52
View Log File 26, 88, 148
View Menu 17
View PeerSync activity across the LAN 151
View Popup Menu 25
View Target Folder 148
Volume Shadow Copy Service (VSS) 71, 105, 145
VSS 64, 71, 105, 145
VSS Interval 105, 145

- W -

Wait for application to end before continuing 99
Web Farms 107
What email address to send from 93
Who to send emails to 93
Window: Changing Height of Profile Job List 26
Windows Explorer Add On - Quick-Sync 151
Windows Platforms 12
Windows Variables for Folder Paths 53
WordPerfect Fixes for synchronization 138
Working With Jobs 12, 151
Working with Profiles 12, 151

- Y -

Year variables for Folder Paths 53